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RIJEČ AUTORA

Draga učenice, dragi učeniče, 
Udžbenik Softverski alati za modelovanje i dizajniranje objekata i prostora napisan je prema 
Nastavnom planu i programu za drugi razred srednje stručne škole, za obrazovni program 
Tehničar za arhitekturu i dizajn enterijera kao i Tehničar za dekorisanje i aranžiranje prostora, 
nivo IV1. Udžbenik se može preporučiti za korišćenje u modulu Kompjutersko tehničko crtanje 
koji je dio obrazovnih programa Građevinski tehničar za visokogradnju i Građevinski tehničar 
za niskogradnju i hidrogradnju, nivo IV1. Naša vizija bila je da ti na što jasniji način prika-
žemo sve osnovne mogućnosti ArchiCAD-a kako bi i samostalno mogla/mogao da istražuješ 
dodatne opcije koje ti on nudi. Ovaj udžbenik u potpunosti prati nastavni plan istoimenog 
modula ali ga mogu koristiti i učenice/učenici u okviru drugih modula koji u određenim 
ishodima zahtijevaju rad na programima CAD (Projektovanje arhitektonskih objekata I i 
II, Projektovanje enterijera, Urbanističko projektovanje i planiranje i dr.). Takođe, može 
koristiti i svima onima koji samostalno žele naučiti osnove korišćenja programa ArchiCAD. 
Udžbenik obuhvata osam poglavlja. Ona odgovaraju ishodima učenja koji su definisani u 
modulu Softverski alati za modelovanje i dizajniranje objekata i prostora:

Uvod u ArchiCAD
Ishod 1 – Podesi radni prostor kompjuterskog programa za izradu grafičkih djelova 
projektne dokumentacije.
Ishod 6 – Podesi radno okruženje softverskog programa za 3D modelovanje.

Alati za 2D crtanje 
Ishod 2 – Primijeni softver za kompjutersko modelovanje za kreiranje 2D modela 
elemenata objekata.

Komande za uređivanje objekata
Ishod 3 – Modifikuje objekte na tehničkom crtežu primjenom odgovarajućeg alata.

Elementi virtuelne zgrade 
Ishod 7 – Primijeni softver za kompjutersko modelovanje za kreiranje 3D modela.

Grafička dokumentacija
Ishod 5 – Tehnički obradi nacrtane djelove grafičke dokumentacije primjenom odgo-
varajućeg softvera.

Tekstualna dokumentacija
Ishod 5 – Tehnički obradi nacrtane djelove grafičke dokumentacije primjenom odgo-
varajućeg softvera.

Vizualizacija
Ishod 8 – Primijeni softver za kompjutersko modelovanje za izradu digitalnih prikaza 
(rendera) objekta.

Štampanje
Ishod 9 – Izvrši tehničku obradu crteža i 3D prikaza objekta.



Ishod 4: Organizuje crtež u slojeve i blokove primjenom odgovarajućeg softvera, nije obra-
đen u ovom udžbeniku s obzirom na to da su „Blokovi“ specifičnost AutoCAD softvera i ne 
koriste se u ArchiCAD-u. Takođe, i po pitanju slojeva, u ArchiCAD-u nije potrebno izučavati 
slojeve u mjeri u kojoj je predviđeno ishodom. 
Na kraju svakog poglavlja dat je njegov rezime, u kome su jasno definisani najvažniji sadr-
žaji iz poglavlja. Specifičnost ovog udžbenika jeste jedan projektni zadatak koji obuhvata 
sve tematske cjeline. Na kraju svakog poglavlja nalaze se pitanja i zadaci koji su manjeg 
obima i tiču se konkretne oblasti, dok projektni zadatak, kao i u svakodnevnoj inženjerskoj 
praksi, obuhvata cjelokupnu izradu projekta zadatog objekta – od tekstualne do grafičke 
dokumentacije, izrade 3D prikaza i štampanja projekta.
Na kraju udžbenika dat je rječnik stranih i stručnoteorijskih pojmova kao i spisak kori-
šćene literature.

L E G E N D A

Dodatni sadržaj

Nalog

Projektni zadatakPodsjetimo se

Uputstvo Napomena
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1Uvod u  
ArchiCAD

Tokom istorije tehničko crtanje se razvijalo od ručno izrađenih crteža do korišćenja raču-
narskih programa za dizajniranje i modelovanje. S razvojem računarske tehnologije počeli 
su se razvijati i programi CAD (Computer Aided Design) koji su omogućavali korisnicima da 
svoje projekte predstavljaju u digitalnom okruženju, umjesto korišćenja pribora za ručno 
crtanje. ArchiCAD je jedan od CAD softvera koji se fokusira na arhitekturu i građevinarstvo 
i pruža mogućnost bržeg, detaljnijeg i preciznijeg tehničkog crtanja. Takođe, omogućava 
inženjerima da izrađuju 2D crteže i 3D modele objekata.
U ovom poglavlju saznaćete: 

	y Šta je BIM tehnologija i zašto je ona važna za razvoj projektovanja
	y Kako se pokreće softver ArchiCAD 
	y U kojim se tipovima datoteka (fajlovima) može sačuvati projekat za dalju doradu
	y Kako konfigurisati podešavanja projekta 
	y Na koji se način koriste 2D i 3D prozori ArchiCAD-a
	y Kako se izvršava selekcija željenih elemenata
	y Kako koristiti pomagala za unos na ekranu.

1.1. Od nacrta do CAD-a i BIM-a

Računari su postali neizostavan alat u inženjerstvu jer pružaju mogućnost preciznog 
crtanja, modelovanja i vizualizacije objekata, čime se ubrzava proces razvoja i poboljšava 
kvalitet konačnog projekta. Specijalizovani softveri imaju ključnu ulogu u projektovanju 
zbog načina na koji se stvaraju, analiziraju i komuniciraju ideje.
Kompjutersko dizajniranje prošlo je kroz značajnu evoluciju od svog nastanka 1957. godine 
do danas. Početni CAD softveri bili su ograničeni na osnovne funkcije poput crtanja geo-
metrijskih oblika i linija, a koristili su se uglavnom za tehničko crtanje u industriji. Tokom 
70-ih godina prošlog vijeka, funkcija softvera CAD intenzivno se razvijala. Tako su softveri 
postali dostupni za širu upotrebu i na taj način mogli da podrže složenije projekte.
Ranih 80-ih godina došlo je do još bržeg razvoja računara, što je omogućilo i širenje softvera 
CAD izvan velikih institucija. To je dovelo do pojave prvih softvera CAD za PC (Personal 
Computer), a samim tim i do veće dostupnosti i šire upotrebe.
Sredinom 80-ih godina softveri CAD su napredovali uključujući mogućnosti 3D modelovanja 
i izrade trodimenzionalnih prikaza. Ova tehnološka unapređenja omogućila su inženjerima 
da stvaraju realistične prikaze svojih projekata i da bolje razumiju prostorne odnose.
U 90-im godinama XX vijeka CAD je postao standardni alat u mnogim industrijama, uključu-
jući arhitekturu, građevinarstvo, proizvodnju i animaciju. Tokom tog perioda CAD softveri 



8 Uvod u ArchiCAD

nastavili su evoluciju dodajući nove mogućnosti, poput parametarskog modelovanja, pove-
zanost sa drugim softverskim alatima i mogućnost simulacije.
U XXI vijeku, CAD tehnologija i dalje se razvija, i danas podrazumijeva cloud-based1 CAD, 
virtuelnu realnost, kao i AI (Artificial Inteligence) alate integrisane u softverima. Danas su 
softveri CAD postali veoma intuitivni2 i pristupačni, tako da inženjeri, dizajneri i umjetnici 
mogu brzo da stvaraju kompleksne digitalne modele i projekte. 
Jedan od najznačajnijih preokreta u cjelokupnoj istoriji razvoja CAD-a jeste nastanak 
tehnologije BIM. Ona predstavlja sljedeći stepenik povezanosti svih strana uključenih u 
projektovanje i izradu jednog objekta. Ključni dio BIM-a jesu informacije. Sve informacije 
prikupljene od početka do kraja projekta ne samo da se čuvaju, već se mogu i dijeliti i 
mijenjati u realnom vremenu. 
Uz pomoć ovakvih specijalizovanih softvera moguće je kreiranje digitalnih modela obje-
kata, lakše i jednostavnije otkrivanje grešaka i poboljšanje dizajna prije izvođenja. Softveri 
koji se koriste u današnje vrijeme obuhvataju širok spektar alata za crtanje, modelovanje, 
izradu trodimenzionalnih prikaza i animaciju projekta. 

Šta je AutoCAD? 
To je softver za crtanje koji je razvila kompanija Autodesk. Ovaj alat koristi se uglavnom 
za kreiranje 2D tehničkih crteža. AutoCAD je postao standard u inženjerstvu zbog svoje 
preciznosti i funkcija koje pružaju brzu i jednostavnu realizaciju ideja.

Šta je CorelCAD? 
Softver koji je razvila kompanija Corel. Koristi se za kreiranje preciznih tehničkih crteža i 
modela. CorelCAD je kompatibilan sa AutoCAD-om, i time pruža mogućnost izrade i dorade 
projekata bez potrebe za prilagođavanjem za rad. U okviru ovog softvera nalaze se alati 
za crtanje, modelovanje i dimenzionisanje, pružajući sve potrebne funkcije za preciznu 
realizaciju tehničkih projekata.

Šta je LibreCAD? 
Ovaj alat se koristi uglavnom za kreiranje tehničkih crteža, planova i specifikacija. S intuitiv-
nim korisničkim interfejsom i alatima za crtanje, LibreCAD omogućava precizno i efikasno 
kreiranje tehničkih crteža.

Šta su Illustrator i Photoshop? 
Kompanija Adobe razvila je niz softvera za različite namjene. Photoshop je rasterski softver 
za obradu slike, dok se Illustrator koristi za kreiranje vektorskih crteža i grafički dizajn. 
Mogu se koristiti za stvaranje prezentacija i vizualizacija projekata.

Vektorska i rasterska grafika – dva su osnovna formata za obradu digitalnih 
fotografija. Koriste se u različite svrhe i imaju različite karakteristike.

Vektorska grafika koristi matematičke formule (vektore3) i pravila za opisivanje 
slika. Osnovni elementi vektorske grafike jesu tačke, linije, krive i oblici kojima se 
može manipulisati bez gubitka kvaliteta. Ona je idealna za izradu logoa, simbola i 

1	 Pristup aplikacijama i softverima preko interneta, bez potrebe instalacije na računaru.
2	 Lako razumljiv.
3	 Matematičke veličine koja imaju svoj pravac, smjer i intenzitet.
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ilustracija koje zahtijevaju visok nivo preciznosti i mogućnost promjene veličine bez 
gubitka kvaliteta.
Rasterska (ili bitmap) grafika koristi mrežu piksela4 kako bi formirala sliku. Osnovne 
karakteristike rasterske grafike jesu rezolucija i broj piksela po inču ili centime-
tru. Ona se koristi za fotografije, teksture i sve što zahtijeva kompleksne detalje i 
nijanse boja.
Razlika između ova dva formata bitna je kada se radi o skaliranju slika. Vektorska 
grafika može biti proširena ili smanjena bez gubitka kvaliteta, dok rasterska grafika 
može postati mutna ili pikselizovana kada se povećava izvan svojih originalnih 
dimenzija.

Šta je ArchiCAD? 
To je softver koji integriše 2D i 3D dizajn, omogućava saradnju između članova koji učestvuju 
u izradi projekta i pruža alate za detaljno modelovanje konstruktivnih i drugih elemenata 
objekta. Značajno je to što podržava BIM tehnologiju, uz pomoć koje se lako upravlja infor-
macijama, od razrade ideje pa sve do održavanja izvedenog objekta. Takođe, ArchiCAD se 
ističe po svojoj prilagodljivosti, što ga čini popularnim izborom među inženjerima širom 
svijeta.

ArchiCAD je softver koji je razvila kompanija GRAPHISOFT. Prva verzija pojavila 
se 1982. godine, a aktuelna je verzija 28. Prije nego što instaliraš softver na 

svom kompjuteru, posjeti sajt kompanije na kom ćeš naći preporuke za minimalne 
hardverske parametre koji su potrebni kako bi ArchiCAD mogao nesmetano da se 
koristi.

PROVJERI SVOJE ZNANJE

1.	 Koje su prednosti korišćenja softvera CAD u odnosu na tradicionalne metode crtanja?
2.	 Opiši razvoj softvera CAD od nastanka do danas.
3.	 Nabroj softvere koji se koriste u tehničkom crtanju.
4.	 Izaberi jedan od softvera za crtanje i opiši ga.

1.2. BIM tehnologija

BIM (Building Information Modeling) tehnologija omogućava inženjerima da kreiraju 
digitalne simulacije dizajna i upravljanje svim informacijama koje su povezane sa 
projektom.
Dok CAD kreira 2D ili 3D crteže, BIM uključuje 4D (vrijeme) i 5D (troškovi).

4	 Piksel – najmanja osnovna tačka na ekranu koja nosi informaciju o boji i osvjetljenju.
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Slika 1.1. Mogućnosti BIM-a

BIM tehnologija čini sve korake izrade projekata lakšim jer se informacije uredno orga-
nizuju i mnogi zadaci se automatizuju. To uključuje procese poput kreiranja početnog diza-
jna, detaljnog planiranja, analize, izrade dokumentacije, praćenja izgradnje, održavanja, 
renoviranja i čak rušenja.
Važno je razjasniti razliku između BIM-a i programa kao što su Revit, ArchiCAD i drugi: 
BIM je radni sistem, dok su Revit i ArchiCAD softveri sa kojima je BIM kompatibilan. Oni se 
međusobno nadopunjuju i omogućavaju da se posao inženjera izvede efikasno.
Projekti modelovani u BIM-u mogu uključivati stvarne proizvode i materijale koji će se 
koristiti za izgradnju, uključujući njihove karakteristike, cijenu i model, kao i kontakt 
informacije za nabavku. 

Šta su BIM nivoi?
Za različite vrste projekata mogu se primijeniti različiti nivoi BIM-a. Svaki nivo predstavlja 
drugačiji skup kriterijuma koji pokazuje određenu ‘zrelost’ informacija u okviru projekta. 
Svrha ovih nivoa jeste da procijene na koji se način informacije dijele tokom cijelog procesa 
izrade. 
Postoje tri nivoa u primjeni BIM-a:

	y Nivo 0 koristi tradicionalni CAD crtež u 2D formatu, kao što su papirni ili digitalni 
crteži. Kod ovog nivoa nema saradnje u okviru tima (kolaboracije).

	y Nivo 1 je kombinacija 2D CAD crteža i 3D CAD modela za konceptualni rad. Kod 
ovog nivoa postoji djelimična saradnja u okviru tima. Svaki član tima može imati 
svoje 2D crteže i 3D modele ali oni nijesu međusobno standardizovani i povezani 
u jednu cjelinu.

	y Nivo 2 predstavlja kolaborativni rad kroz korišćenje standarda i formata za raz-
mjenu podataka. Razmjena podataka, kako bi oni bili standardizovani kroz sve 
faze projekta, vrši se putem čuvanja podataka u zajedničkom formatu (npr. IFC 
– Industry Foundation Classes).

	y Nivo 3 je apsolutna saradnja u okviru tima kroz upotrebu jedinstvenog, dijeljenog 
BIM modela. Svi učesnici koriste isti model u realnom vremenu, omogućavajući 
potpunu koordinaciju u svim fazama izrade projekta. Ovaj nivo takođe uključuje 
cloud tehnologiju za dijeljenje modela i podataka.
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Slika 1.2. Veza između BIM nivoa i modela

Šta su BIM modeli?
BIM modeli odnose se na različite vrste informacija koje se dodaju objektu kako bi se posti-
gao određeni nivo funkcionalnosti i omogućila sveobuhvatna analiza i upravljanje tokom 
cijelog životnog ciklusa objekta. Svaki model BIM-a predstavlja dodatnu složenost i količinu 
informacija koje proširuju osnovne trodimenzionalne geometrijske podatke. 
2D i 3D BIM predstavljaju grafičke crteže: dvodimenzionalni prikazi (kao što su osnove, 
presjeci i fasade) i trodimenzionalni prikaz modela objekta (koji uključuje geometriju i 
vizuelne aspekte). Svaki sljedeći model BIM-a predstavlja skup crteža i određenih kompo-
nenti koje su u funkciji informacija o tim crtežima.
4D BIM predstavlja uključivanje vremenske dinamike u izradi projekta (planiranje i ras-
pored faza u izgradnji). U ovom modelu moguće je uraditi simulaciju izgradnje objekta 
tokom vremena.
5D BIM predstavlja proračun troškova u izgradnji (procjena i kontrola) omogućavajući 
tačnije budžetiranje.
6D BIM obuhvata dodavanje informacija o održivosti i energetskoj efikasnosti, pružajući 
analizu energetske potrošnje i održivosti tokom životnog ciklusa objekta.
7D BIM obuhvata dodavanje informacija za upravljanje objektom tokom njegove eksploa-
tacije, i uključuje informacije potrebne za održavanje objekta.
Kao i sve tehnologije u današnje vrijeme, i BIM se svakodnevno razvija i uključuje nove 
modele sa sve većim brojem informacija koje je moguće obrađivati u okviru specijalizo-
vanih softvera u arhitekturi i građevinarstvu. Tako je, na primjer, aktuelan model 8D, koji 
obuhvata cjelokupan „životni ciklus“ jednog objekta, od njegove izgradnje, preko održava-
nja pa sve do rušenja. Ovakav vid pristupa projektovanju obuhvata prikupljanje, obradu i 
čuvanje svih informacija u vezi sa nekim objektom.

PROVJERI SVOJE ZNANJE

1.	 Šta predstavlja tehnologija BIM?
2.	 Opiši vezu između BIM-a i ArchiCAD-a.
3.	 Koja je razlika između BIM nivoa i BIM modela?
4.	 Opiši modele BIM-a.
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1.3. Pokretanje programa

Nakon što je ArchiCAD instaliran na kompjuteru, program se pokreće dvostrukim klikom 
lijevog tastera miša na ikonicu ArchiCAD na radnoj površini (desktop) ili preko menija Start.
Kada se program pokrene, otvara se prozor (slika 1.3) u kome treba izabrati jednu od 
ponuđenih opcija:

	y započinjanje novog projekta (New)
	y otvaranje postojećeg projekta (Browse)
	y prijavljivanje na timski rad (Teamwork).

Slika 1.3. Startni prozor ArchiCAD-a

Opcijom započinjanja novog projekta 
otvara se dijaloški okvir sa podešava-
njima šablona (template) (slika 1.4).
U ovoj fazi poznavanja softvera uvijek 
ćete koristiti ArchiCAD šablon, dok se 
za Work Environment Profile mogu 
koristiti unaprijed definisani profili 
ArchiCAD-a ili neki lični profil. Kako 
napraviti profil, objašnjeno je kroz 
poglavlje 1.4.2 Konfiguracija radnog 
okruženja. 

Pokreni program Archi-
CAD. Otvori novi crtež. 

Istražuj opcije: New, Browse, Open 
Sample Project. Slika 1.4. Dijaloški okvir podešavanja novog projekta
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1.4 ArchiCAD tipovi datoteka (ekstenzije)

Šta su datoteke?
Datoteke su digitalni dokumenti koji sadrže različite vrste informacija, poput teksta, slika, 
zvuka ili podataka projekta kada su u pitanju specijalizovani softveri za projektovanje. 
Tipovi datoteka određuju se na osnovu njihovih ekstenzija, odnosno skraćenica koje se 
nalaze na kraju imena datoteke. Odranije su vam poznate ekstenzije .docx (Word doku-
ment), .mp3 (muzika i drugi audio-zapisi), .mp4 (video-zapisi). Po završetku crtanja pro-
jekta potrebno je sačuvati urađeno kako bi projekat bio spreman za kasnije dorađivanje 
ili dijeljenje. U ArchiCAD-u projekat se može sačuvati u nekoliko ekstenzija na različite 
načine (slika 1.5).

Slika 1.5. Izgled ikonica na ekranu 

Iz osnovnog menija File > Save daće mogućnost čuvanja u ekstenziji .pln (slika 1.6).

Slika 1.6. Prikaz čuvanja projekta opcijom Save

ArchiCAD Solo Project (.pln) izvorni je format ArchiCAD-a i sadrži sve informacije o 
projektu sa najmanjom mogućom veličinom datoteke. Ovaj tip datoteke koristi se kada 
se projekat radi samo na jednom kompjuteru. U ovoj vrsti datoteke biće sačuvane sve 
osnove, izgledi, presjeci i priprema za štampu projekta sa svim pratećim elementima.
Ukoliko se iz osnovnog menija izabere opcija File > Save As, biće ponuđen velik broj eksten-
zija u kojima se može sačuvati projekat (slika 1.7).
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Slika 1.7. Prikaz čuvanja projekta opcijom Save As

ArchiCAD Archive Project (.pla) čuva samo osnovne elemente projekta, bez biblioteka 
odnosno objekata. Ovaj tip datoteke koristi se kada treba raditi isti projekat na više kom-
pjutera ili da se arhivira završeni projekat.
ArchiCAD Backup file (.bpn) omogućava da se „oporavi“ posljednja sačuvana verzija oštećenog 
projekta pod uslovom da je to omogućeno u osnovnom meniju: Options > Work Environ-
ment > Data Safety & Integrity > Make Backup Copy checkbox (Napravi sigurnosnu kopiju).
Osim osnovnih ArchiCAD tipova datoteka, projekat se može sačuvati i u drugim ekstenzijama 
sa kojima je moguće dorađivati projekat u nekom od specijalizovanih softvera. Ukoliko su 
na kompjuteru instalirani takvi softveri, npr. za izradu trodimenzionalnih prikaza, poput 
3Ds Max, Lumion, Artlantis i dr., u meniju File > Save As biće ponuđeno čuvanje projekata 
u njihovim ekstenzijama (.3ds, .dae, .atl). Kao podrazumijevana za čuvanje u ArchiCAD-u 
postoji ekstenzija .dwg koju koristi softver AutoCad. Čuvanje projekta ArchiCAD-a u tipu 
datoteke AutoCad koristi se kada je potrebno projekat podijeliti sa drugim inženjerima 
uključenim u proces projektovanja (građevinski, elektro i dr.).

Otvori novi crtež u ArchiCAD-u, a zatim ga, prateći uputstva sa slika 1.6 i 1.7, 
sačuvaj pod nazivom Crtež 1.

Uvijek treba kreirati arhivsku datoteku (.pla) projekta ukoliko će se na projektu raditi u 
starijim verzijama ArchiCAD-a.

PROVJERI SVOJE ZNANJE

1.	 U kojim tipovima datoteka možeš sačuvati svoj projekat iz ArchiCAD-a?
2.	 Opiši primjenu tipova datoteka.
3.	 Šta je čuvanje crteža?
4.	 Opiši postupak čuvanja crteža.

Kreiraj novi ArchiCAD fajl i sačuvaj ga pod nazivom Projektni zadatak_Stam-
beni objekat.
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1.5. Konfiguracija (Configuration)

U ovom poglavlju upoznaćete se sa radnim prostorom ArchiCAD-a. Saznaćete koja je funk-
cija određenih prozora i razumjeti ulogu svakog od njih. Radni prostor ArchiCAD-a prati 
logiku izrade grafičkih priloga onako kako bismo ih izrađivali i uz pomoć pribora za ručno 
crtanje. Na samom početku ArchiCAD otvara osnovu prizemlja (slika 1.8).

Slika 1.8. Izgled radnog prostora ArchiCAD-a

1.5.1. Radni prostor

U Tab bar-u se istovremeno otvaraju i dva dodatna prozora (Izgled i 3D) koji zajedno čine 
povezane radne prostore u izradi svih vrsta objekata. Radno okruženje ArchiCAD-a omo-
gućava interaktivan proces crtanja između osnova, presjeka/izgleda i 3D prikaza. Svaka 
izmjena u jednom od ovih prozora ažurira se i u svim ostalim prozorima kako bi se održala 
jasnoća procesa izrade.
Na lijevoj strani nalazi se ToolBox koji sadrži sve potrebne alate za kreiranje 3D modela 
alata za 2D crtanje i dokumentovanje. Podijeljen je u tri logičke cjeline (palete alata).5 Paleta 
alata Design sadrži alate za modelovanje objekta. Paleta Viewpoint služi za postavljanje 
vertikalnih prikaza objekta. U paleti Document nalaze se alati za grafičku i tekstualnu 
doradu crteža. Svaka od navedenih paleta objašnjena je detaljno kroz naredna poglavlja 
u ovom udžbeniku.
Na desnoj strani nalazi se Navigator koji sadrži listu svih djelova projekta – od trodimen-
zionalnih modela objekta do grafičke dokumentacije i izgleda virtuelnog lista koji će služiti 
za štampanje crteža. Preko navigatora se može lako prelaziti kroz osnove, izglede, presjeke, 
detalje i 3D izgled objekta.

5	  Skup alata za crtanje ili modelovanje u okviru softvera.
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Na samom vrhu nalazi se Osnovni meni. U njemu se nalaze sve komande grupisane u 
logički slijed. 
Padajući meni za podešavanje dokumenta (File), izmjene (Edit) i izgled (View) aktiviraju 
se odabirom željene komande. Komande u meniju Options regulišu osnovna podešavanja 
i radno okruženje (Work Environment). U meniju Prozor (Window) podešava se vidljivost 
željenih paleta.

Slika 1.9. Prikaz osnovnog menija sa opcijama 

Standardna paleta alata (Standard toolbar) sadrži neke od komandi i funkcija dostupnih 
iz osnovnog menija. Nalazi se ispod osnovnog menija i može se u potpunosti prilagoditi 
potrebama korisnika.
InfoBox je paleta koja prikazuje trenutne postavke odabranog alata ili karakteristike 
odabranog elementa. (Odaberi neki alat iz ToolBox-a i pogledaj promjene u InfoBox-u.) 
Promjene u InfoBox-u odmah se odražavaju na trenutne postavke ili svojstva elemenata. 

Otvori novi crtež i istraži svaku od prethodnih opcija. Bilježi svoja zapažanja.
Sačuvaj crtež pod nazivom Vježba 1 u ekstenziji .pla i zatvori dokument.

Pomoćni toolbox Coordinate box
Upotreba ove pomoćne palete alata značajna je prilikom crtanja projekta radi jednostavnijeg 
i bržeg postavljanja elemenata crteža. Svaka od ponuđenih opcija detaljnije je objašnjena 
kroz poglavlja koja se tiču crtanja konkretnih elemenata. Coordinate box prikazuje tačan 
položaj ArchiCAD-ovog kursora na crtežu u okviru koordinatnog sistema i sadrži sljedeće 
parametre:
1. Korisnički koordinatni početak (User origin): Kao što i samo ime kaže, ova komanda 
postavlja nultu tačku na lokaciju koju definiše korisnik. Klikom na ovo dugme može se 
postaviti koordinatni početak bilo gdje na osnovi.

Slika 1.10. Prikaz opcija Coordinate box pomoćne palete alata
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2. i 3. Rotirana mreža: Klikom na ikonicu Rotated grid pojavljuje se vektor na osnovi kojim 
se određuje ugao rotacije mreže. O pozadinskoj mreži biće više riječi u poglavlju 1.5.6. 
Konfiguracija modularne mreže i pozadine (Grids and background).

4. Grid Snap: Moguće je izabrati jednu od tri opcije za kontrolu postavljanja elemenata na 
mrežu (Grid Snapping): Grid Snapping OFF (ova opcija označava da je isključena mogućnost 
da se elementi postave duž mreže), Snapping to Snap Grid (postavljanje elemenata duž 
unaprijed definisanih tačaka na ekranu) i Snapping to the Construction Grid (postavljanje 
elemenata na zadatoj konstruktivnoj mreži).

5. Apsolutne i relativne koordinate: Za prikaz i unos relativnih koordinata X i Y (za 
kartezijanske koordinate) i radijalnih/ugaonih koordinata (za polarne koordinate). Klikni 
na ikonicu Delta u meniju. Relativne vrijednosti pokazuju poziciju kursora u odnosu na 
projektni početak (Project Origin – naznačen sa „x“ na prikazima osnove) ili korisnički 
početak (User origin) koji se prikazuje kao drugi „x“ na ekranu (slika 1.11). Relativne koor-
dinate definišete prije početka crtanja ili prilikom promjene početka (Edit Origin), kada je 
proces izrade ili uređivanja u toku.

Apsolutne koordinate su one koordinate koje određuju tačnu poziciju objekta 
u odnosu na referentni sistem (npr. koordinatni početak). 

Relativne koordinate, za razliku od apsolutnih, određuju poziciju objekta u odnosu na 
neki drugi objekat. Na primjer, kada radite sa bibliotekama u ArchiCAD-u, relativne 
koordinate mogu se koristiti da se postavi tačna udaljenost jednog prozora u odnosu 
na već nacrtan prozor.

Slika 1.11. Prikaz kursora Project Origin (lijevo) i kursora User Origin (desno)

6. Gravitacija: Ova komanda je opciona, i koristi se za postavljanje elemenata na ploče, 
mreže, omotače i krovove.
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1.5.2. Konfiguracija radnog okruženja (Work Environment)

Kako se s vremenom navikavate na rad sa ArchiCAD-om, razvijaćete lične preference za 
korišćenje funkcija i uređenje različitih paleta alata i menija na ekranu. Izmjene radnog 
okruženja podešavaju se u dijaloškom okviru „Radno okruženje“: Options > Work Envi-
ronment > Work Environment. Prilagođavanje bilo koje od ovih postavki može se izvršiti 
i u toku rada tako što se na spisku pronađe potreban alat, promijene postavke i sačuvaju 
izmjene klikom na dugme OK (slika 1.12).

Slika 1.12. Dijaloški okvir podešavanja radnog okruženja

Ukoliko se izvrši prilagođavanje nekoliko podešavanja, one se mogu sačuvati kao šeme 
novog radnog okruženja i koristiti u budućim projektima (slika 1.13). 
Primjer: Za kreiranje i prilagođavanje palete alata koristi se komanda Options > Work 
Environment > Toolbars.

Slika 1.13. Postupak stvaranja novog profila za radno okruženje



191.5. Konfiguracija (Configuration)

Profili koji se mogu izabrati ne sadrže postavke; oni su skup šema radnog okruženja. Šeme 
predstavljaju unaprijed definisane rasporede i izglede svih informacija koje se prikazuju 
na ekranu u okviru projekta. Na primjer, redosljed prikazivanja elemenata u ToolBox-u se 
može podesiti u ovom prozoru. 
Obratite pažnju na paletu alata Design; ona ima sljedeći unaprijed postavljeni raspored 
alata: prvo su na spisku zidovi, zatim stubovi, pa grede i ploče. U podešavanjima šeme 
radnog okruženja redosljed im se može zamijeniti onako kako odgovara korisniku. Kao što 
smo već pomenuli, kada se sačuvaju izmjene u okviru šeme radnog okruženja, nova šema 
biće sačuvana u lokalnom folderu na računaru i samim tim uvijek će se – kako bi mogla 
biti izabrana za rad – naći na spisku šema prilikom otvaranja novog fajla (slika 1.14). U 
poglavlju 1.2 objasnili smo na koji se način pokreće program i kako se biraju profili.

Slika 1.14. Način odabira profila prilikom otvaranja ArchiCAD projekta

U potpunosti je moguće uspješno koristiti ArchiCAD bez podešavanja šema i profila. 
Međutim, ukoliko se tokom rada primijeti da se neke prikazane opcije ne koriste često ili 
da pojedine funkcije za izmjene na objektima nijesu uopšte prikazane u osnovnom profilu 
ArchiCAD-a, čuvanje profila značajno olakšava proces rada. Podešavanje profila može 
takođe znatno ubrzati proces pripreme za rad na projektu. 
U okviru podešavanja profila 
može se definisati način pri-
kazivanja i upisivanja jedinica 
mjere. Ovaj korak značajan je 
kako se prilikom otvaranja sva-
kog novog projekta ne bi prvo 
morale podesiti postavke pro-
jekta, već bi one bile definisane 
izabranim profilom.

Slika 1.15. Postupak podešavanja izgleda paleta
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Dodatno, u podešavanjima profila može se definisati grafički prikaz elemenata projekta 
(boje, debljine i vrste linija i dr.). 
Podešavanje izgleda paleta vrši se preko komande: Options > Work Environment > Work 
Environment (slika 1.15).
Za svaki alat postoji mnoštvo parametara i podešavanja koji se definišu na istom principu, 
pa ćemo kroz primjer ToolBox-a pojasniti korake kojima se vrše izmjene. Oni važe i za svaki 
drugi alat (slika 1.16).

Slika 1.16. Prikaz podešavanja alata u dijaloškom okviru radnog okruženja

1.	 Lista svih alata i funkcija koje se koriste u ArchiCAD-u
2.	 Lista alata dostupnih u okviru izabrane palete
3.	 Lista akcija/informacija/parametara koje se trenutno nalaze u selektovanoj paleti

	y za izmjenu redosljeda prikazivanja paleta alata koriste se ikonice sa strelicama;
	y za prikazivanje ili uklanjanje palete alata ikonica oka. 

Kada se izvrše izmjene, klikom na dugme OK sačuvaju se izmjene, i tada se može zatvoriti 
dijaloški okvir. 

1.5.3. Konfiguracija postavki projekta (Project Preferences)

Jedan od početnih koraka prilikom izrade svakog crteža u ArchiCAD-u jeste konfiguracija 
postavki projekta (slika 1.17) osim ukoliko nije već definisano profilom, o čemu je bilo riječi 
u prethodnom poglavlju. Postavke projekta podrazumijevaju, između ostalog, definisanje 
mjernih jedinica za dužinu, površinu, zapreminu, kao i ugao u kojem će se crtati. Prilikom 
izrade projekta najčešće se koriste dužina i ugao, jer se njima određuju veličine, rastojanja 
i položaj svih djelova jednog objekta, od konstruktivnih elemenata do namještaja. 
Pored samog crtanja objekta, potrebno ga je i iskotirati. U okviru opcije Project Preferences 
određuje se i način prikazivanja dimenzija na kotama.
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U opciji Working Units definišemo jedinice mjere i način 
na koji se unose u projekat (slika 1.18). Na primjer, treba 
nacrtati zid dužine 10 m. Ukoliko je Lenght Unit podešen 
na metre, onda će se za dužinu unijeti numerička vrijed-
nost 10, a ukoliko su podešeni centimetri biće vrijednost 
1000. Postavke dimenzija ne utiču na izračunate vrijed-
nosti, već samo na način unosa.

Slika 1.18. Dijaloški okvir podešavanja 
jedinica mjere za crtanje

U procesu definisanja jedinica 
koristite polje Uzorak (Sam-
ple) koje prikazuje kako će ta 
vrsta dimenzije biti prikazana 
u projektu. Dostupne opcije 
dimenzija razlikovaće se u 
zavisnosti od jedinice koja je 
izabrana i od tipa dimenzije 
čije se karakteristike podeša-
vaju (slika 1.19).

Slika 1.17. Padajući meni  
postavki projekta

Slika 1.19. Dijaloški okvir  
podešavanja kota

1.	 Linearne
2.	 Ugaone
3.	 Radijalne
4.	 Nivo
5.	 Elevacija
6.	 Vrata/prozor
7.	 Parapet
8.	 Izračunavanje  

površine 
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Za tip mjernih jedinica za linearne 
dimenzije izabrani su metri sa dvije 
decimale (slika 1.20). Ovdje je broj deci-
malnih mjesta postavljen na dva; ali 
Extra Accuracy6 omogućena je na 25. 
Stoga se sljedeća decimalna vrijednost 
takođe prikazuje, kao nadtekst (supers-
cript), zaokružena na povećanje od 25.
Za svaku od navedenih dimenzija 
potrebno je podesiti sljedeće parame-
tre (slika 1.21): 

	y Jedinica (Unit) – definiše se 
jedinica mjere za svaku od 
tipova dimenzija 

	y Decimale (Decimals) – definiše 
se broj decimala koje se prika-
zuju u svakoj vrijednosti

	y Dodatna preciznost (Extra 
Accuracy) – vrijednosti deci-
malnog zapisa prikazuju se kao 
nadtekst (superscript)

Slika 1.21. Način podešavanja proračuna površine

	y Zaokruživanje na (Rounding to):7 – dostupno je za izračunavanje površine (označeno 
crvenom bojom na slici 1.21)

	y Najbliže (Nearest) – vrijednost je zaokružena na broj podešenih decimala 
	y Ostalo – vrijednost je zaokružena na broj podešenih decimala, ali konačne brojke 

predstavljene su sa razlikom od 5 ili 25.

6	  Dodatna preciznost.
7	  Zaokruživanje na najbližu zadatu decimalu.

Slika 1.20. Dijaloški okvir  
podešavanja linearnih kota
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Opcija Extra Accuracy u ArchiCAD-u alat je koji omogućava dodatnu preciznost 
prilikom crtanja. Kada je uključena, ova opcija omogućava da se detalji crteža 

prikažu sa većom tačnošću, što je naročito značajno kod složenih detalja ili specifičnih 
geometrijskih formi. Kada će se ova opcija koristiti, zavisi od vrste projekta. Ukoliko 
se radi glavni ili izvođački projekat, onda je korisno uključiti Extra Accuracy. Međutim, 
kod koncepta ili idejnog projekta ova opcija bila bi suvišna s obzirom na nivo preci-
znosti koji je u njima potreban i brzine rada.

1.5.4. Konfiguracija svojstava elementa (Element Attributes)

Svojstva elemenata su grupe definisanih načina prikazivanja različitih elemenata. Na pri-
mjer, vrste linija, ispuna, boje i olovke – elementi su koji se najčešće koriste prilikom crtanja 
projekta u ArchiCAD-u. Njihova svojstva primjenjuju se na sve elemente projekta (zidove, 
ploče, grede, otvore, namještaj i dr.). Svaki nacrtani zid kao trodimenzionalni model, u 
osnovi je prikazan linijama i ispunama. Način prikazivanja tih linija i ispuna podešava se 
u osnovnom meniju: Options > Element Attributes (slika 1.22).

Slika 1.22. Padajući meni podešavanja  
svojstava elemenata

Slika 1.23. Prikaz vrsta linija

Podešavanje svojstava linija dostupno je u meniju: Options > Element Attributes > Line 
Types. Postoje unaprijed definisani tipovi linija kojima se mogu mijenjati parametri u 
zavisnosti od potreba prilikom crtanja (slika 1.23). Ispune (Fills) geometrijski su 2D ele-
menti za šrafiranje koji pomažu da se napravi razlika ili da se ukrase djelovi projekta 
(slika 1.24). U okviru ArchiCAD-a već postoji velik broj unaprijed definisanih šrafura 
koje se mogu primijeniti u projektu. Komanda za podešavanja je Options > Element 
Atributes > Fill Types.
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Slika 1.24. Vrsta ispuna

Podešavanja olovaka i boja razlikuju se u zavisnosti od vrste dokumentacije za koju su 
namijenjene, pa tako se mogu podesiti za prikaz modela (dio ArchiCAD-a u kojem se mode-
luje objekat) i prikaz rasporeda – Layout (dio ArchiCAD-a u kojem se projekat priprema 
za štampu).
Podešavanja svojstava olovaka i boja dostupna su iz osnovnog menija:

	y Document > Pen Sets > Pens & Colors ili 
	y Options > Element Attributes > Pens & Colors.

Isto kao što se kod ručnog crtanja prvo bira vrsta olovke, njena debljina i boja koja će se 
koristiti za crtanje, tako i prilikom crtanja na računaru prvo treba podesiti ove parametre. 
Kako i kod ručnog, tako i kod crtanja u ArchiCAD-u, ovaj korak značajan je radi jasnog 
razlikovanja elemenata u projektu. Na primjer, trodimenzionalni model zida (iz palete alata 
Design) u osnovi je prikazan korišćenjem linija i ispuna. Te linije su nacrtane određenom 
olovkom (koja ima svoju boju, debljinu i vrstu). U ovom dijaloškom okviru podešavate svoj-
stva tih linija, a u podešavanjima alata za crtanje zidova dodjeljujete ih zidu. Na taj način 
olakšava se razumijevanje projekta koji je pred vama. Ako je prozor za prikaz modela8 
aktivan, ime dijaloškog okvira je Pens & Colors (Model Views) (slika 1.25); set olovaka koji 
ovdje odaberete, primijeniće se automatski na prikaze modela.
Ako je Layout Book9 aktivan, naziv dijaloškog okvira mijenja se u Pens & Colors (Layout 
Book) i ovdje odabrani set olovaka primjenjuje se na Layout Book.

8	  Prikaz modela – folder u softveru u kom se modeluje objekat.
9	  Folder u softveru u kom se projekat priprema za štampu.
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Slika 1.25. Izgled dijaloškog okvira Pens and Colours

ArchiCAD nudi unaprijed definisane setove olovaka. Svaki naziv seta olovaka (npr. Archi-
tectural 100 ili Structural) označava da su debljine i boje olovke optimizovane za njegovu 
posebnu svrhu (npr. arhitektonski ili konstruktivni planovi).
Ukoliko se izvrši bilo koja izmjena odabranog seta, aktivni set pojavljuje se kao novi pod 
nazivom Custom. Potrebno je sačuvati izmjene preko ikonice Store As. 
Za svaku olovku postoji podrazumijevana dodjela boja, ali se ona može izmijeniti tako što 
se izabere okvir boje i dugme Edit colour.
Težine (debljine) olovke mogu se mijenjati numerički, koristeći polja u dijaloškom okviru 
Pens and Colors > Pen Weight.

1.5.5. Konfiguracija etaže (Story Settings)

Opcija Story Settings koristi se kako bi se definisale etaže10 i spratovi11 u okviru projekta. 
Postupak konfiguracije (podešavanja) etaža značajan je za kreiranje treće dimenzije. 
Objekti uvijek imaju više etaža (temelji, sprat, krov) kojima je potrebno definisati nivo na 

10	  Horizontalni nivoi unutar zgrade (mogu biti temelji, podrum, krov).
11	  Vertikalni nivoi unutar zgrade (prizemlje, prvi sprat itd.).
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kom se nalaze kako bi se na pravilan način formirao trodimenzionalni prikaz. U okviru 
ArchiCAD-a opcija Story Settings omogućava modelovanje i organizaciju projekta na 
svakoj etaži zasebno. 
Ukoliko je u Story Settings formirana etaža „Prizemlje“ u tom prozoru biće prikazani kon-
struktivni elementi prizemlja kao i namještaj. Ako postoji formirana etaža „Krov“, na njoj 
će biti prikazana krovna konstrukcija. 
U prozoru za podešavanje etaže ponuđena su podešavanja naziva, elevacije12 i visine do 
sljedeće etaže (slika 1.26).

Slika 1.26. Prikaz dijaloškog okvira za podešavanje spratne visine

Slika 1.27. Primjer podešavanja visine podruma i prizemlja

Ukoliko se prizemlju zada visina (Height to Next) 4 m, a prvom spratu 2,8 m, prvi sprat naći 
će se na visini, tj. biće mu definisana elevacija na 4 m, a drugom spratu +6,80 m.

12	  Visina u odnosu na tlo (na kotu 0,00).
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1.5.6. �Konfiguracija modularne mreže i pozadine  
(Grids and background)

Sistem modularne koordinacije u arhitekton-
skom projektovanju temelji se na određivanju 
projektantskog modula. Projektantski modul 
je osnovna mjerna jedinica koja se koristi u 
projektovanju kako bi se postigla preciznost i 
efikasnost u dizajnu. Predstavlja standardizo-
vanu mjeru koja se koristi za dimenzionisanje 
i raspoređivanje elemenata unutar projekta. 
Najčešće se definiše kao višestruki osnovni 
modul, koji može biti određen u milimetrima, 
centimetrima ili metrima, u zavisnosti od 
specifičnih zahtjeva projekta ili standarda 
koji se primjenjuje.
Upotreba projektantskog modula takođe olak-
šava saradnju između različitih učesnika u 
izradi projekta (projektanti, inženjeri i izvo-
đači radova) jer svi rade u skladu s istom 
standardizovanom mjerom. 
Modularna mreža u ArchiCAD-u se podešava u meniju View > Construction Grid Display, 
odvojeno za osnovu ili za bilo koji pojedinačni presjek/izgled, detalj – radni list (slika 1.28).

Definiši pomoćnu modularnu mrežu kao na slici 1.29.

Slika 1.29. Način podešavanja mreže

Slika 1.28. Padajući meni za podešavanje 
pozadinske mreže
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1.5.7. Opcije pregleda na ekranu (On screen view options)

Komanda View > On-Screen View Options (slika 1.30) sadrži listu svojstava elemenata koji 
se mogu prikazati ili sakriti na ekranu, zavisno od potreba projekta. Podešavanja u ovom 
meniju ne određuju da li će neki objekat biti prikazan na radnoj površini, već definišu 
načine grafičkog prikazivanja na ekranu. 
Na primjeru opcije True Line Weight objasnićemo ulogu ovih podešavanja.
Jedna od najznačajnijih opcija iz On screen view options menija jeste True Line Weight 
(Prava debljina linija). Koristi se kako bi se prikazale ili sakrile prave debljine linija nacrtanih 
u projektu. Ukoliko je isključena, sve linije u projektu prikazuju se istom debljinom (Hair-
lines) kako bi projekat bio pregledniji i lakši za rad. Međutim, kada dođe do faze čuvanja i 
štampanja projekta, tada je od velikog značaja da se prije same štampe priloga uključi ova 
opcija kako bi se vidjelo kako će linije zaista biti odštampane. O linijama i debljinama linija 
detaljno smo govorili u poglavlju 1.4.4. Konfiguracija svojstava elementa (Element Attributes).

Slika 1.30. Padajući meni za podešavanje prikaza elemenata na ekranu 

Slika 1.31. Razlika u prikazu bez uključene opcije True Line Weight i sa njom



291.6. Navigacija

PROVJERI SVOJE ZNANJE

1.	 Opiši radni prostor ArchiCAD-a.
2.	 Nabroj padajuće menije.
3.	 Ocijeni značaj definisanja profila radnog okruženja.
4.	 Koje postavke projekta moraš podesiti prije početka crtanja? Zašto?
5.	 Nabroj mjerne jedinice koje se koriste prilikom crtanja u ArchiCAD-u.
6.	 Izaberi jedan od elemenata i opiši podešavanje njegovih svojstava.
7.	 Opiši značaj palete On Screen View Options.
8.	 Čemu služi opcija Grids & Backround?

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta definiši:

	f Način prikazivanja linearnih kota tako da se prikazuju u metrima sa jednom 
decimalom (postupak ćeš naći u poglavlju Konfiguracija postavki projekta 
(Project Preferences)) 

	f Način prikazivanja markera za vrata i prozore (postupak ćeš naći u poglavlju 
Prikaz dimenzija/kotiranje (Dimensions))

	f Podesi spratnu visinu na 280 cm (postupak ćeš naći u poglavlju Konfiguracija 
etaže (Story Settings))

	f Preimenuj osnove tako što ćeš umjesto Ground Floor napisati Prizemlje itd. 
(postupak ćeš naći u poglavlju Konfiguracija etaže (Story Settings))

	f Preko osnovnog menija View, selektuj Grids and Background i definiši modu-
larnu mrežu dimenzija 1 m po x-osi i 1 m po y-osi (postupak ćeš naći u poglavlju 
Konfiguracija modularne mreže i pozadine (Grids and background)).

1.6. Navigacija

Kao što smo već pomenuli prilikom 
konfiguracije projekta, Navigator se 
nalazi sa lijeve strane radne površine 
ArchiCAD-a. U okviru menija nalaze 
se četiri ikonice (foldera), i to:
1. Project Map: Struktura padajućih 
menija koja dozvoljava lako kretanje kroz 2D i 3D prikaze objekta. Kao što i sam naziv kaže, 
u ovom folderu nalazi se projekat sa svim pogledima na objekat, i u njemu se modeluje.
2. View Map je folder u kom se čuvaju pojedinačni izgledi objekta sa posebnim parame-
trima nezavisno od samog projekta u kom radite (Project Map). Na primjer, kao zaseban 
pogled (View) može se sačuvati osnova prizemlja prikazana u razmjeri 1 : 100; zatim istu 
tu osnovu sačuvati kao drugi pogled (View) u razmjeri 1 : 50 sa materijalizacijom; kao treći 
pogled sačuvati samo konstruktivne elemente iscrtane crnom olovkom.

Slika 1.32. Izgled palete Navigatora
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3. Layout Book predstavlja virtuelni izgled papira, odnosno prikaz priloga sa svim dodat-
nim elementima kao što su naslovi, okvir, pečat i druge informacije.
4. Publisher omogućava da se svaki virtuelni list papira (Layout) sačuva kao jedan PDF fajl 
koji je spreman za dalje dijeljenje ili štampu.

1. Project Map: Korišćenje prozora za 2D navigaciju
U poglavlju 1.4. pomenuta je svrha navigatora i njegove mogućnosti. Folder Project Map 
u okviru njega treba posmatrati kao bazu13 svih djelova projekta. U potpunosti se može 
napraviti poređenje sa geografskom mapom područja na kojoj bi tražili neku adresu. Isto 
tako u Project Map-u nalaze se svi djelovi projekta organizovani u foldere kako bi se lako 
mogli pronaći. 

�Svaki folder/prozor (osnove, presjeci, fasade i dr.) predstavlja model objekta koji se 
projektuje, pa će i svaka izmjena u jednom od ovih foldera/prozora po automatizmu biti 
izmijenjena u svakom drugom prozoru.

Na primjer, ukoliko u prozoru „Presjek 1–1“ u prizemlju objekta izbrišete neki zid ili dio 
namještaja, kada se otvori prozor „Osnova prizemlja“ element će takođe biti izbrisan sa osnove.
Svaki dio projekta organizovan je u različite foldere i kategorije. Neke od njih pomenućemo, 
a ostale možete istražiti samostalno. U prethodnom poglavlju vidjeli smo kako se formiraju 
etaže objekta. Svaka etaža naći će se u folderu Stories u Project Map-u. Svaki postavljeni 
presjek biće prikazan u folderu Sections a fasade u Elevations ili Interior Elevations za 
izglede zidova enterijera.

1. Project Map: Korišćenje prozora za 3D navigaciju
Svaki dio projekta organizovan je u foldere, pa tako i prikaz 3D modela ima svoj folder pod 
nazivom „3D“. Model objekta može se vidjeti u aksonometrijskom (slika 1.33) ili perspek-
tivnom prikazu. 

Slika 1.33. Trodimenzionalni aksonometrijski prikaz

13	 Organizovan skup podataka za lakši pristup informacijama.
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Unutar 3D prikaza nalaze se alati za navigaciju u realnom vremenu (Zoom-In, Zoom-Out, 
Pan). U quick options bar-u14 (slika 1.34) nalazi se ikonica Zumiraj (Increase zoom). Oda-
birom ove ikonice kursor se mijenja u lupu. Potrebno je nacrtati dva ugla pravougaonika 
oko dijela objekta koji se želi uvećati. Nakon drugog klika, prikazaće se uvećan odabrani 
dio osnove u radnom prozoru. Pored increase zoom ponuđene su: ikonica za pomicanje 
(panning), smanjenje zuma (decrease zoom), uklapanje sadržaja osnove u prozor (fit in 
window) ili prebacivanje između prethodnog i sljedećeg prikaza.

Slika 1.34. Grafički prikaz bara quick options

Ovi alati dostupni su i za pregled projekta u osnovi. Postoje dva različita načina navigacije 
u 3D modelu ArchiCAD-a: Orbit i Walk. U donjoj alatnoj traci klikom na ikonicu Orbit kursor 
se mijenja u znak orbite i označava režim rada u kom je moguće rotirati objekat u svim 
pravcima. Da biste sagledali objekat sa svih strana, kliknite i držite pritisnut lijevi taster 
miša, a zatim pomjerajte kursor u bilo kom pravcu. Dok ste u režimu Orbit, i dalje se može 
koristiti zumiranje i pomjeranje u realnom vremenu. Za izlazak iz ovog režima koristi se 
dugme ESC na tastaturi.

Slika 1.35. Trodimenzionalni perspektivni prikaz

Još jedan od načina trodimenzionalnog prikaza objekta jeste Istraživanje objekta (Explore 
Model). Njemu se pristupa preko osnovnog menija: View > Explore Model. 

14	 Alatna traka za brz pristup navigaciji kroz prikaz.
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Slika 1.36. Prozor Explore Model

Dijaloški okvir koji se pojavljuje (slika 1.36), objašnjava način kontrole kretanja kroz objekat 
(vrlo slično kompjuterskim igrama). Kada ste upamtili sve kontrole, klikom na 3D Explore 
počinje se istraživati objekat. Za izlazak iz ovog režima koristi se dugme ESC na tastaturi.

Otvori novi crtež. 
Istraži foldere u Navigatoru i zabilježi svoja zapažanja.

Pan (pomjeranje cjelokupne osnove) možeš aktivirati i pritiskom skrola na 
mišu i njegovim pomjeranjem.

Fit to window (uklapanje cijele osnove u radni prostor vidljiv na ekranu) dobijaš 
dvostrukim klikom dugmeta Scroll.
Zoom aktiviraš pomjeranjem skrola gore-dolje.

PROVJERI SVOJE ZNANJE

1.	 Navedi foldere koji se nalaze u Navigatoru.
2.	 Izaberi jedan folder u Navigatoru i objasni njegovu ulogu i sadržaj.
3.	 Koje mogućnosti kretanja kroz crtež postoje u ArchiCAD-u?
4.	 Navedi neke od opcija Zoom i način na koji utiču na prikaz projekta u radnom prostoru.
5.	 Objasni kada koristiš opciju Orbit i na koji se način aktivira.
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1.7. Odabir (Selection)

Odabir elementa na crtežu preduslov je svih izmjena koje se 
izvršavaju. U softveru postoje mnoga intuitivna pomagala 
kako bi se olakšao odabir (selekcija) tačno onih elemenata 
koje treba izmijeniti. 
Odabir se vrši aktivnim alatom Strelica (Arrow) tako što 
se kursor postavi na željeni objekat i klikne na lijevi taster 
miša; ili se prevuče mišem tako da se nacrta zasjenjeni pra-
vougaonik oko objekta.
Kada je aktivan bilo koji drugi alat iz palete ToolBox, moguće 
je samo postavljati taj element na ekranu. S bilo kojim dru-
gim aktivnim alatom potrebno je pritisnuti dugme Shift na 
tastaturi a zatim preći mišem preko željenog objekta (objekat 
će biti osjenčen plavom bojom. Odabir se izvršava klikom na 
lijevi taster miša.

Inteligentni kursor (Inteligent cursor) 
Kursor mijenja oblik u toku rada, u zavisnosti od alata koji se 
koristi, kao i da li je operacija uređivanja (unosa elemenata) 
u toku. Različite varijante izgleda kursora omogućavaju lakšu 
identifikaciju čvorova15 i ivica na objektu, kao pomoć pri ure-
đivanju. Neki od tipova kursora koji se često srijeću tokom 
crtanja prikazani su i objašnjeni na slici 1.37. 

Selekciona površina (Marquee Area)
Alat Marquee koristi se za definisanje područja za odabir, uređivanje ili vizualizaciju.

POSTAVLJANJE SELEKCIONE POVRŠINE (slika 1.38)
Korak 1: Odaberi Marquee iz ToolBox-a.

Korak 2: Klikni lijevi taster miša za početnu tačku na dijelu projekta koji želiš da 
izmijeniš.
Korak 3: Prevuci mišem tako da zahvatiš željeno područje projekta.
Korak 4: Klikni lijevi taster miša da završiš definisanje Marquee Area.

Slika 1.38. Koraci za postavljanje Marquee Tool-a

15	 Čvor objekta (Node) – tačka ili definisano mjesto na objektu s kojeg je moguće vršiti izmjene. 

Slika 1.37. Izgledi kursora  
i opisi funkcija
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Označeno područje prikazano je isprekidanom linijom. Uklanjanje postojeće selekcione 
površine može se izvršiti na nekoliko načina. Najbrži način jeste klikom na dugme Esc 
na tastaturi. Takođe, može se izabrati funkcija Remove Marquee iz kontekstnog menija,16 
započeti crtanje nove selekcione površine ili dvostrukim klikom lijevog tastera miša na 
prostor izvan oblasti okvira.

�Odabirom nekog drugog alata, područje Marquee neće se samostalno ukloniti. Uvijek 
je potrebno uraditi neki od navedenih koraka za uklanjanje.

Alat Marquee ima višestruku primjenu u procesu projektovanja. Može se koristiti kako bi 
se definisala manja oblast u okviru koje je potrebno izvršiti izmjene na svim elementima 
neke vrste. Selekciona površina može se koristiti i ukoliko je potrebno da se sagleda samo 
određeni dio projekta u 3D ili da se sačuva samo dio projekta u .pdf ili .dwg formatu.
Geometrija selekcione površine bira se iz InfoBox-a, i može biti pravougaona ili proizvoljnog 
oblika. (Prisjeti se funkcije InfoBox-a u poglavlju 1.4.1)

Odaberi sve elemente (Select All)
Za odabir svih elemenata na ekranu (bilo u cijelom prozoru ili unutar prethodno definisane 
oblasti Marquee) sa aktivnom strelicom (alatom za označavanje) koristi se prečica Ctrl + A 
ili naredba Edit > Select All.

Odaberi sve elemente jedne vrste (Find and Select)
Funkcija Find and Select omogućava brzo pronalaženje određenih elemenata ili komponenti 
u projektu i njihov odabir radi efikasnijeg uređivanja. Posebno je korisna kod izrade pro-
jekata velikog obima, sa mnoštvom elemenata, jer omogućava automatsko pronalaženje 
umjesto pojedinačnog ručnog pretraživanja cijelog projekta. U okviru funkcije Find & Select, 
za odabir elemenata može se definisati širok spektar kriterijuma. Ovoj opciji pristupa se 
preko komande Edit > Find & Select; prečicom na tastaturi Ctrl + F ili preko standardne 
palete alata na kojoj postoji ikonica Find & Select (slika 1.39). 

Slika 1.39. Ikonica Find and Select u standardnoj paleti alata

Za odabir svih elemenata jedne vrste (npr. svih zidova ili prozora) klikom na ikonicu strelice 
aktivira se željeni alat. Odabir se završava klikom na dugme „+“ (slika 1.40).

16	� Meni s podešavanjima i funkcijama kojem se pristupa tako što se pritisne desni taster miša bilo gdje 
na radnoj površini ArchiCAD-a.
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Slika 1.40. Prikaz dijaloškog okvira za pronalazak elemenata

Mogu se izabrati unaprijed definisani kriterijumi za odabir ili se mogu ručno postaviti 
prema željenom ishodu potrage. 

Postavi kriterijume, klikni na dugme „+“ (svi elementi koji odgovaraju tvojim 
definisanim kriterijumima biće odabrani).

Klikni na dugme „–“ da poništiš izbor svih elemenata koji odgovaraju trenutnim 
kriterijumima. 
Pritisni dugme Esc na tastaturi ili klikni lijevi taster miša na prazan dio projekta da 
poništiš odabir jednog ili više elemenata.
Klikni na odabrani element držeći pritisnuto dugme Shift na tastaturi da eliminišeš 
ili dodaš u selekciju pojedinačne elemente.

PROVJERI SVOJE ZNANJE

1.	 Koje ti mogućnosti odabira nudi ArchiCAD?
2.	 Objasni svrhu označavanja objekata na crtežu.
3.	 Čemu služe komande Select All i Marquee Area? Kako se aktiviraju?
4.	 Navedi prednosti korišćenja opcije Find and Select. 

1.8. �Pomoćni alati za unos na ekranu

Pomoćni alati za unos imaju značajnu ulogu u procesu precizne izrade projekta, od crtanja 
osnovnih geometrijskih oblika, kao što su linije, do naprednih mogućnosti kao što je prila-
gođavanje tekstura i detalja na 3D modelima objekata.
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Koordinate za praćenje (Tracker)
Vrijednosti koordinata prikazane su u Tracker-u koji prati pokrete miša i dostupan je u bilo 
kojem tipu prozora koji se uređuje.
Traker daje dinamičke povratne informacije o vrijednostima kao što su dužine i uglovi, a 
koristi se i za unos numeričkih vrijednosti elemenata.

Unos elementa pomoću koordinata za praćenje
Kada se postavlja novi element, tokom unosa se mogu definisati njegove koordinate ili 
veličine. 

CRTANJE LINIJE POMOĆU TRAKERA 

Korak 1: Aktiviraj alat Line iz palete alata.
Korak 2: Započni crtanje linije klikom na lijevi taster miša bilo gdje na radnoj površini.
Korak 3: Pritisni dugme Tab na tastaturi onoliko puta koliko je potrebno da aktiviraš 
željeno polje, a zatim unesi vrijednost. Takođe, možeš i otkucati prečicu na tastaturi 
(x, y, z ili d/r ili a) da aktiviraš odgovarajuće polje, nakon čega unosiš vrijednost. Na 
primjer: dugme „D“ za distancu, i nakon toga vrijednost 300 (slika 1.41).

Slika 1.41. Izgled trakera na radnoj površini

�Ovaj metod unosa radi ako je polje „Omogući direktan unos u polja za praćenje“ označeno 
u Options > Work Environment > Tracker and Coordinate Input. Prefiks + nije obavezan 
za pozitivne vrijednosti.

Alat za mjerenje (Measure tool)
Funkcija alata za mjerenje, koji se nalazi na standardnoj paleti alata (slika 1.42), jeste mje-
renje udaljenosti i površine u projektu, u realnom vremenu. 

Slika 1.42. Ikonica Measure Tool-a na standardnoj paleti alata

Na slici 1.43 prikazan je postupak primjene alatke Measure Tool. S odabranim alatom, prvi 
korak je kliknuti lijevim tasterom miša na željenu početnu tačku za mjerenje. U slučaju 
kao na slici, nakon što je definisana početna tačka, mišem se prelazi do sljedeće tačke, 
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prateći zid. Traker prikazuje horizontalnu, vertikalnu i radijalnu udaljenost mjerenu od 
početne tačke. 

Slika 1.43. Način primjene Measure Tool-a

�Razlika između trakera i Measure Tool-a u tome je što traker služi za unos veličina i 
zadavanje pozicije dok se crta neki element, a Measure Tool se koristi kada treba pro-
vjeriti neku udaljenost ili površinu.

Moguće je izmjeriti bilo koji broj segmenata u nizu: svaki 
klik lijevog tastera miša predstavlja novu početnu tačku 
od koje će se mjeriti sljedeća udaljenost. Nakon dva klika 
prikazuje se privremena siva zona na ekranu koja pred-
stavlja kumulativnu udaljenost. Na slici 1.44 prikazana je 
povratna informacija alata za mjerenje nakon pet klikova, 
dok se približava posljednjem uglu prostorije.

Linije vodilje (Guide Lines)
Linije vodilje su pomoćna sredstva za crtanje koja služe za 
pronalazak neke posebne tačke na elementu ili projekcije 
tako da je osiguran precizan unos u 2D i 3D prozorima. 
Opciji Guide Lines pristupa se na dva načina: 

	y odabirom ikonice na standardnoj paleti alata 
(slika 1.45)

	y iz osnovnog menija View > Guide Lines.

Slika 1.45. Izgled ikonice Guide Lines na standardnoj paleti alata

Privremene tačke (Snap Points)
Snap Points su privremene tačke koje se pojavljuju u određenim intervalima (koji se ručno 
definišu) na elementima kako bi se preciznije postavili i nacrtali novi elementi. Opciji Snap 
Points pristupa se na dva načina:

Slika 1.44. Način upotrebe  
alata za mjerenje
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	y odabirom ikonice Snap Guides and Points na standardnoj paleti alata (slika 1.46)
	y iz osnovnog menija View > Snap Points.

Slika 1.46. Izgled ikonice Snap Points na standardnoj paleti alata

Sa aktiviranim alatom treba postaviti kursor na element na kojem je potrebno vidjeti pri-
vremene tačke. Njihov broj i položaj zavise od opcije koja je zadata u podešavanjima. Za 
definisanje prikaza podjele elementa na segmente bira se padajući meni Snap Guides and 
Points na standardnoj paleti alata. Iste komande dostupne su iz osnovnog menija View > 
Snap Point Options (slika 1.47).

	y Half: dijeli element na dva jednaka 
dijela

	y Divisions: dijeli element na 
postavljeni broj segmenata, 
raspona 3–100

	y Percent: dijeli element na dva 
dijela prema zadatom procentu

	y Distance: dijeli element na 
segmente prema zadatoj 
udaljenosti

	y Best Division by Distance: tačke 
za spajanje podijeliće ivicu 
na jednake djelove koji su što 
je moguće bliže definisanoj 
udaljenosti

Slika 1.47. Opcije u padajućem meniju Snap Points

Snap Points se može koristiti na svim elementima i objektima u okviru ArchiCAD-a. 

Čarobni štapić (Magic Wand)
Čarobni štapić (prečica: dugme Space na tastaturi) pronalazi i prati zatvoreni oblik u 
postojećim elementima. Zatvorenim oblikom smatra se svaka površina koja je oivičena 
linijski, bilo da je u pitanju prost geometrijski oblik ili 3D model objekta (ploče, zidovi, 
namještaj i dr.). 
Ako se izabere ivica ili čvor objekta Magic Wand, označiće se taj objekat.
Ako se izabere prazan prostor ili površina, Magic Wand prati zatvoreni geometrijski oblik 
koji čine najbliži elementi. 
Čarobni štapić može se koristiti da se doda ili oduzme određeni dio postojećeg poligona.
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ODUZIMANJE POLIGONA OD PLOČE

Korak 1: Odaberi poligon od kojeg treba oduzeti drugi oblik. U ovom primjeru 
želimo oduzeti poligon od ploče. 
Korak 2: Odaberi ikonicu Subtract from Polygon u paleti Pet (slika 1.48). 
Korak 3: Pomjeri kursor na poligon koji želiš da oduzmeš i aktiviraj magični štapić – 
pritisni Space na tastaturi (slika 1.49).
Korak 4: Klikni lijevi taster miša da završiš akciju (slika 1.50). 

Slika 1.48. Prikaz ikonice  
za oduzimanje od poligona

Slika 1.49. Korak 3

Slika 1.50. Konačni izgled ploče

Pet Palette je kolekcija ikonica koje predstavljaju komande za izmjenu izabranih elemenata. 
U nekim slučajevima Pet Palette pojavljuje se tokom unosa (kao pri unosu polilinije), ali u 
većini slučajeva Pet Palette se pojavljuje nakon što izaberete postavljeni element ili njegov 
čvor (slika 1.51). Da pristupite kolekciji Pet Palette, postavite kursor na čvor i kliknite lijevi 
taster miša.
Sadržaj Pet Palette zavisi od sljedećeg:

	y odabrani element
	y dio elementa na koji je izabran (ivica, čvor ili površina).
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Slika 1.51. Izgled Pet Palette u osnovi i u 3D

Prelaskom kursora preko ikonica u paleti biće prikazano objašnjenje svake od njih.

Prikaži redosljed (Display order)
Prilikom crtanja projekta u ArchiCAD-u, elementi koji se preklapaju crtaće se prema određe-
nom redosljedu slaganja. Elementi su podrazumijevano složeni redosljedom koji se koristi 
u arhitektonskim crtežima.
Prema zadatim postavkama, slaganje se vrši prema definisanim klasama elemenata, kojih 
ima šest. Bez obzira na redosljed postavljanja elemenata, oni iz prve klase biće uvijek 
postavljeni u prvi plan, druga klasa u nivo iza itd.

Slika 1.52. Opcije prikaza redosljeda

Klase elemenata su:
1.	 Tekst, oznake, sve vrste dimenzija, oznake zona17

2.	 Linije, elipse i kružnice
3.	 Djelovi biblioteka (namještaj, lampe, stepenice)
4.	 2D ispune (Fills)
5.	 3D strukture (zidovi, grede, ploče itd.)
6.	 Zone
7.	 Figure

Na elementima komande rade na sljedeći način:
	y Staviti u prvi plan (Bring to front) (slika 1.53)

Zamislite da imate nacrtan velik broj različitih oblika na papiru. Ispred sebe 
imate nepregledan crtež sa nejasnim rasporedom i u pozadini se nalazi krug koji 
je prekriven drugim oblicima, a želite ga istaći. Opcija Bring to front u stvarnosti 

17	 �Označene prostorne oblasti u projektu sadrže informacije o nazivu prostorije, površini, oblogama i dr.
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bi značila da uzmete taj krug i postavite ga ispred svih tih nacrtanih oblika da 
postane jasno vidljiv.

Slika 1.53. Način upotrebe opcije Display Order

	y Prenijeti naprijed (Bring forward): odabrani element (elementi) naći će se ispred 
elemenata za jednu klasu više. 

	y Poslati unazad (Send backward): odabrani element (elementi) naći će se ispod svih 
elemenata.

	y Poslati iza (Send to back): odabrani element (elementi) preklapaće se (poslati iza) 
svih elemenata viših klasa, ali će biti iznad elemenata nižih klasa.

Virtuelni trag (Trace)
Opcija „Virtuelni trag“ može se povezati sa situacijom koja se često dešava u stvarnosti 
prilikom ručnog crtanja – kada želite nacrtati nov crtež ili skicu a želite da koristite 
postojeći crtež kao referencu. U tom slučaju postavićete prozirni (paus) papir preko 
već nacrtanog priloga kako bi konture i detalji bili vidljivi za preslikavanje. Paus papir 
omogućuje praćenje linija i oblika postojećeg crteža prilikom stvaranja novog. Upravo 
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takvu ulogu ima i Trace. Kao virtuelni trag mogu se postaviti bilo koji pogledi na objekat 
uporedo (slika 1.54).

Slika 1.54. Ikonica Trace na standardnoj paleti alata

U ArchiCAD-u će se sa aktivnom opcijom Trace prikazivati dva segmenta na ekranu:
	y aktivni sadržaj – stvarni model ili crtež na kojem se trenutno radi (Active);
	y referenca traga (Refference), opciono postavljena pored, na vrhu ili ispod aktivnog 

sadržaja. Trace ima ulogu podloge, što olakšava upoređivanje više prikaza/crteža 
modela na istom ekranu.

Kao referenca mogu se odabrati tri tipa (slika 1.55):

Slika 1.55. Podešavanja opcija virtuelnog traga

	y gledišta (Views)
	y presjeci (Sections) 
	y izgledi (Elevations).

Na primjer, prilikom crtanja presjeka objekta (aktivni sadržaj) može se postaviti relevantna 
fasada kao referenca (slika 1.56).

Slika 1.56. Primjena virtuelnog traga na prikazu presjeka
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Takođe, Trace je veoma koristan alat u situaciji kada već postoji nacrtana osnova prizemlja 
a treba nacrtati osnovu sprata. S aktivnim alatom svi elementi prizemlja postaju vidljivi 
na prikazu sprata.

Grupe elemenata (Groups)
Na svakom radnom stolu postoji velik broj raznih predmeta od olovaka, papira, pribora za 
crtanje, knjiga i dr. Kada sređujete radni sto, sve olovke stavićete u jednu posudu, papire 
i knjige nasložiti u jedan ugao, a pribor za crtanje u posebnu kutiju. Ovakav raspored na 
stolu olakšava pronalaženje stvari i čini sto preglednijim. Slično tome, opcija Groups u 
ArchiCAD-u omogućava grupisanje više elemenata ili objekata u jednu cjelinu radi lakše 
manipulacije ili organizacije crteža. 
Za kreiranje grupe potrebno je izabrati željene elemente i uraditi jedno od sljedećeg:

	y koristiti komandu Edit > Grouping > Group (slika 1.57)

Slika 1.57. Opcije prikaza grupa

	y koristiti prečicu: Ctrl + G na tastaturi
	y izabrati ikonicu Groups na paleti alata. 

Kod organizacije radnog stola, papire možemo postaviti na jedno mjesto a knjige na drugo, a 
možemo ih staviti na jedno zajedničko mjesto, zbog prirode sadržaja koji se u njima nalaze. 
Isto tako, u ArchiCAD-u nekoliko grupa može se objediniti u jednu grupu višeg nivoa. Gru-
pisani elementi zatim se mogu odabrati i modifikovati. Grupisani elementi razlikuju se od 
pojedinačnih elemenata po udaljenim krajnjim tačkama za odabir (slika 1.58).

Slika 1.58. Izgled grupisanih elemenata u osnovi i u 3D

Kote, zone, presjeci/fasade/kamere ne mogu se grupisati, dok se vrata i prozori mogu 
grupisati samo zajedno sa zidom u koji su postavljeni.
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U situacijama kada je potrebno izvršiti izmjene na samo jednom određenom elementu u 
okviru grupe, njihovo razgrupisavanje je opterećujuće, jer bi trebalo ponovo izabrati sve 
elemente i opet kreirati grupu nakon što se urade izmjene u pojedinačnim elementima. 
Jednostavnije rješenje jeste da se privremeno obustave grupe u projektu. Ova akcija omo-
gućava da se jednostavno izvrše izmjene na pojedinačnim elementima, s obzirom na to da 
privremeno nijesu dio grupe. Obustava grupa vrši se odabirom ikonice za uključivanje/
isključivanje grupe na standardnoj paleti alata (slika 1.59) ili preko komande Edit > Gro-
uping > Suspend Groups.

Slika 1.59. Izgled ikonice Suspend Groups na standardnoj paleti alata

Rasformiranje grupa, odnosno vraćanje djelova grupe u pojedinačne elemente, vrši se preko 
komande Edit > Grouping > Ungroup.
Ako je naredba uključena Autogroup, povezani poligonalni i pravougli elementi (npr. 
polilinije ili prostorija nacrtana kao pravougli zidovi) automatski će se kreirati kao grupa.
Automatska grupa je podrazumijevano aktivna.
Sljedeće operacije mogu se izvoditi istovremeno na svim elementima koji čine grupu:

	y odabir (Select, Select All)
	y izmjene (Move, Rotate, Mirror, Multiply)
	y brisanje (Delete).

PROVJERI SVOJE ZNANJE

1.	 Objasni ulogu Tracker-a.
2.	 Koje ti mogućnosti nudi Measure Tool?
3.	 Nabroj opcije koje ti nudi alat za postavljanje privremenih tačaka.
4.	 Šta je Magic Wand, i u kojim ga situacijama koristiš?
5.	 Ukoliko na nekom objektu izvršiš komandu Bring to Front, kako će se on prikazati 

na radnoj površini?
6.	 Opiši način korišćenja virtuelnog traga.
7.	 Koje izmjene možeš izvršiti u okviru grupisanih elemenata?
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SAŽETAK POGLAVLJA

	f Projekat se može sačuvati u više tipova datoteka. Na taj način omogućena je dorada 
projekta u drugim softverima kao i dijeljenje sa drugim učesnicima u procesu pro-
jektovanja.

	f Prije samog početka rada na projektu potrebno je izvršiti konfiguraciju svih elemenata 
i parametara koji su potrebni za rad. U ovom poglavlju je korak po korak objašnjeno na 
koji način podešavate svoj radni prostor (Work Environment), jedinice mjere i njihov 
prikaz na ekranu (Project Preferences). Opcija podešavanja svojstava elemenata (Element 
Attributes) značajna je u procesu prilagođavanja izgleda projekta i načina na koji su 
prikazane linije, boje, materijalizacija kao i spratna visina.

	f ArchiCAD ima jednostavnu navigaciju u svakoj fazi projektovanja. Za to je zaslužan 
Navigator koji se nalazi sa desne strane radne površine. U okviru ovog padajućeg menija 
nalaze se četiri moguća načina prikaza: 2D (osnove, presjeci, fasade i detalji), 3D (akso-
nometrijski i perspektivni prikazi objekta, kao i 3D presjeci), Layout (virtuelni izgled 
papira) i Publish (podešavanje pripreme za čuvanje i dijeljenje priloga gotovog projekta).

	f Za precizan odabir elemenata u okviru programa definisane su različite metode odabira 
i filtriranja (Marquee Tool, Find and Select). ArchiCAD ima integrisane izglede kursora 
koji navode na dalje korake prilikom iscrtavanja u zavisnosti od alata koji se trenutno 
koristi (Intelligent cursor).

	f Osim za odabir elemenata u ArchCAD-u, postoji i niz pomagala za unos podataka koji 
će ubrzati proces crtanja projekta i omogućiti preciznost prilikom rada. Tracker daje 
dinamičke povratne informacije o vrijednostima. Pomagala za koordinaciju i pronalaže-
nje elemenata, poput Guide Lines i Snap points, definišu se na osnovu potreba prilikom 
crtanja. Ukoliko se projekat sastoji iz više etaža i potrebno je istovremeno sagledati 
presjek i fasadu nekog objekta, koristi se alat Trace. Na taj će se način u toku crtanja 
gornje etaže prikazivati obrisi etaže ispod i tako eliminisati mogućnost da se pogrešno 
pozicionira neki od konstruktivnih zidova ili drugih elemenata.

	f BIM (Building Information Modeling) metodologija je koja omogućava inženjerima da 
kreiraju digitalne simulacije projekta i upravljaju svim informacijama koje su sa njim 
povezane. Važno je razjasniti razliku između BIM-a i programa kao što su ArchiCAD i 
drugi: BIM je radni sistem, dok je ArchiCAD softver sa kojim je BIM kompatibilan. 
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Alati za  
2D crtanje2

Dvodimenzionalni elementi su osnova svakog tehničkog crteža. Uz pomoć geometrijskih 
oblika (linija, kvadrata, pravougaonika, kružnica i lukova i dr.) kreiraju se skice, planovi i 
sva tehnička dokumentacija koja čini jedan projekat.
Kroz module Tehničko crtanje i Nacrtna geometrija upoznali ste se sa načinom tehničkog 
izražavanja na crtežima i grafičkim predstavljanjem tijela u dvodimenzionaloj ravni. 
Savladali ste ručno crtanje geometrijskih oblika kroz osnovne geometrijske konstrukcije 
koristeći pribor za crtanje (trougao, lenjir, šestar i dr.). 
U ovom poglavlju saznaćete na koji način se geometrijski oblici crtaju u ArchiCAD-u i koja 
je njihova uloga u grafičkoj prezentaciji projekata. Kroz naloge koji objašnjavaju proces 
crtanja oblika i zadatke koji služe razvijanju vještina crtanja na računaru, razvijaćete pre-
ciznost i brzinu u korišćenju tih alata.
U ovom poglavlju saznaćete:

	y Kako da koristite alate za 2D crtanje
	y Na koji način podešavate njihove parametre
	y Koji su načini uređivanja dostupni za nacrtane geometrijske oblike
	y Koja je uloga ispuna/šrafura u tehničkom crtanju i kako se primjenjuju u ArchiCAD-u
	y Kako da postavite fotografiju bilo kog formata u projektu.

2.1. Crtanje linija 

U tehničkom crtanju svaka linija ima svoju ulogu i značenje, od linija koje definišu spoljaš-
nje konture objekta do preciznih linija koje označavaju unutrašnje elemente. One su poput 
niti koje povezuju projekat u cjelinu.
Primjena linija proteže se kroz sve faze arhitektonskog procesa tako što počinje sa konceptu-
alnim skicama i nastavlja se kroz različite faze dizajna, detalja i dokumentacije. Crtanje 
linija u ArchiCAD-u omogućava prenošenje ideje sa papira na ekran.
Alat za crtanje linija nalazi se sa lijeve strane radne površine u paleti alata ToolBox u 
odjeljku Document. Nakon odabira alata, crtanje linije započinje se zadavanjem početne 
tačke klikom na lijevi taster miša na željenu lokaciju na ekranu. S prvim klikom pojav-
ljuje se i traker (njegovu funkciju definisali smo u poglavlju 1.8. Pomoćni alati za unos 
na ekranu). Nakon unosa parametara dužine i ugla linije, akcija se završava pritiskom 
Entera na tastaturi.
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Slika 2.1. Prikaz trakera

Prije crtanja linije potrebno je podesiti njene parametre koji se nude u InfoBox-u (slika 2.2). 
(Ulogu InfoBox-a definisali smo u poglavlju 1.5.1. Radni prostor.)

Slika 2.2. InfoBox za podešavanje svojstava linije

Prvi ponuđeni parametar jeste odabir geometrije 
linije (Geometry Method). Linija može biti duž, 
izlomljena (lančana) linija ili se može nacrtati 
pravougaonik.
Duž je najosnovnija linija, čiji je način crtanja 
objašnjen na početku.
Izlomljena (lančana) linija (Chained) predstavlja 
liniju kod koje je krajnja tačka jedne linije početna 
tačka sljedeće. Završetak crtanja ove linije izvršava se dvostrukim klikom lijevog tastera 
miša. Odabirom bilo kojeg njenog dijela ovakva linije biće izabrana u cjelini, s obzirom na 
to da su svi njeni djelovi grupisani. (O ulozi grupa i načinu izmjene elemenata u okviru njih 
govorili smo u poglavlju 1.8. Pomoćni alati za unos na ekranu.)

Slika 2.4. Izgled lančane linije

Pravougaoni metod (Rectangular) predstavlja 
metod crtanja pravougaonika. 
Nakon što je izabran ovaj metod crtanja linije, 
pritiskom na lijevi taster miša definiše se početna 
tačka pravougaonika. Drugi korak je povlačenje 
zamišljene dijagonale kursorom miša ili zada-
vanje dimenzija preko trakera. Nakon unosa 
veličina, akcija se završava pritiskom na lijevi 
taster miša.

Slika 2.3. Geometrijska metoda linije

Slika 2.5. Pravougaona metoda
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Drugi parametar koji je potrebno podesiti u InfoBox-u jeste vrsta linije (Line Type) (slika 
2.6). I sljedeći korak je olovka (Pen), čijim se podešavanjem definiše boja i debljina linije. 
(O parametrima olovaka bilo je riječi u poglavlju 1.5.4. Konfiguracija svojstava elementa 
(Element Attributes).)

Slika 2.6. Spisak vrsta linija

Kada su svi parametri podešeni, pristupa se crtanju linije kako je prethodno objašnjeno. 
Nacrtana linija može se izabrati lijevim tasterom miša, a Pet Pallete prikazuje se ponovnim 
klikom bilo gdje na liniji. U zavisnosti od pozicije odabira linije (da li je izabrana neka njena 
krajnja tačka ili sredina), Pet Palette nudi različite mogućnosti (slika 2.7). 

1.	 Pomjeranje
2.	 Rotacija
3.	 Osno-simetrično 

preslikavanje
4.	 Multiplikacija
5.	 Promjena  

dužine linije 
Slika 2.7. Prikaz Pet Palette za izmjene na linijama
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Za promjenu dužine linije koristi se komanda Edit > Reshape > Stretch.
Nakon što je linija izabrana, potrebno je definisati jednu od krajnjih tačaka od koje će biti 
izmijenjena njena dužina. Pomjeranjem kursora ili upisivanjem vrijednosti u traker, defi-
niše se nova krajnja tačka. 

Slika 2.8. Izgled ikonice za promjenu dužine linije

Kada je izabrana neka tačka duž linije, u Pet Palette će se pojaviti opcije izmjene oblika linije.
	y Dodavanje nove tačke (slika 2.9) 

Slika 2.9. Prikaz postupka dodavanja nove tačke

Nova tačka preloma na liniji može se pomjerati u bilo kom pravcu kako bi se stvorio novi oblik.
	y Zakrivljena ivica (slika 2.10)

Slika 2.10. Prikaz postupka zakrivljenja ivica

Ova opcija nudi mogućnost da se od ravne linije napravi luk sa zadatim poluprečnikom.
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	y Zakrivljena ivica po tangenti (slika 2.11)

Slika 2.11. Prikaz postupka zakrivljenja ivica po tangenti

Umjesto definisanja poluprečnika, ova opcija omogućava definisanje luka prema tangenti.

Vrste linija
Kao što i u ručnom crtanju postoje mnoge vrste linija (puna, isprekidana, crta-tačka-crta i 
dr.) koje imaju svoju svrhu i značenje na crtežu, tako se i u ArchiCAD-u može podešavati 
izgled linija. Podešavanje svojstava linija dostupno je u meniju Options > Element Attri-
butes > Line Types (slika 2.12). 
Sa lijeve strane dijaloškog okvira koji se otvara prikazani su svi unaprijed definisani tipovi 
linija sa spiskom naziva i načinom grafičkog prikaza. S desne strane u panelu Edit Selected 
Type nalaze se informacije o dimenzijama linija i djelova između njih (za isprekidanu liniju).

Slika 2.12. Dijaloški okvir za podešavanje naziva i vrste linije

Osim unaprijed definisanih linija, moguće je kreirati i novu liniju. Klikom na ikonicu New 
(označeno crvenom bojom na slici 2.12) otvara se novi dijaloški okvir u kojem treba definisati 
naziv i vrstu linije (slika 2.13). Ponuđene su tri vrste linija:

Slika 2.13. Dijaloški okvir za podešavanje atributa linije
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Isprekidana (Dashed): U polje Dash unosi se dužina crtice, dok se u polje Gap unosi dužina 
razmaka između crtica. Klikom na ikonicu OK biće sačuvana nova vrsta linije (slika 2.14).

Slika 2.14. Dijaloški okvir za podešavanje isprekidane linije

Symbol: Bilo koji elementi prethodno nacrtani uz pomoć linija i kružnica mogu biti definisani 
kao novi tip linije. Skup elemenata čini simbol za liniju. Da bi se skup elemenata sačuvao 
kao simbol, potrebno ih je kopirati u prozor za podešavanje linije – klikom na ikonicu Paste 
into pattern (slika 2.15). Nakon prenosa može se definisati veličina simbola i razmak između 
njih, kao kod isprekidane linije. Kada je linija kreirana, čuva se klikom na ikonicu OK.

Slika 2.15. Postupak postavljanja simbola kao djelova isprekidane linije

Kopija (Duplicate): Pravljenjem kopije postojeće linije mogu se izmijeniti pojedinačni grafički 
parametri uz zadržavanje osnovnog oblika linije.

PROVJERI SVOJE ZNANJE

1.	 Koristeći alat Linija napravi isprekidanu liniju naziva Isprekidana linija, crne boje, 
debljine 0,35 mm, sa dimenzijama segmenata kao na slici 2.16. Nakon što je napraviš, 
selektuj je u vrsti linije i nacrtaj dužine 30 cm.

Slika 2.16. Primjer isprekidane linije
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2.	 Nacrtaj punu liniju (boja linije 48) dužine 60 cm. Na sredini linije dodaj novu tačku 
i pomjeri je ka gore za 25 cm. 

3.	 Nacrtaj isprekidanu liniju Dashed (boja linije 46) dužine 100 cm. Zakrivi je koristeći 
Pet Palette, radijus 45 cm.

4.	 Na slici 2.17. dat je linijski sto sa dimenzijama. Nacrtaj ga poštujući vrstu linija (puna, 
isprekidana). Boja linije broj 1. Sačuvaj crtež pod nazivom Linijski sto.

Slika 2.17. Linijski sto

2.2. Crtanje polilinija i lančanih linija 

Crtanje polilinije ima isti proces kao 
i crtanje lančane linije, samo što ima 
drugačiji krajnji rezultat. Kada se kori-
sti alat Polyline, dobijaju se pojedinačni 
elementi, dok su kod alata Chained Line 
linije grupisane (slika 2.18).
Alat Polyline nalazi se u ToolBox-u u 
odjeljku Documentation, sa lijeve strane 
radne površine. Sa izabranim alatom 
Polyline u InfoBox-u pojavljuju se isti 
parametri za podešavanje kao kod crta-
nja linije.

Slika 2.18. Razlika između polilinije (gore)  
i lančane linije (dolje)
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NASTAVAK POLILINIJE (slika 2.19)
	y Korak 1: Izaberi poliliniju
	y Korak 2: Izaberi jednu od krajnjih tačaka polilinije
	y Korak 3: Klikni ikonicu Continue Polyline iz Pet Palette koja se pojavljuje 

(slika 2.19)
	y Korak 4: Docrtaj dodatne segmente
	y Korak 5: Dvostrukim klikom na lijevi taster miša završi crtanje

Slika 2.19. Ikonica Continue Polyline 

Prilikom promjene polilinije može se promijeniti ugao posljednjeg segmenta odabirom 
opcije Go Back, ali se ne mogu izbrisati segmenti polilinije (slika 2.20).

Slika 2.20. Ikonica Go Back u Pet Palette

Crtanje krivih polilinija
ArchiCAD koristi algoritme za proračunavanje i crtanje krivih polilinija (Spline) kako bi omo-
gućio kreiranje glatkih i kontinuiranih krivulja. Alat Spline koristi se za kreiranje složenih 
geometrijskih oblika koji nijesu definisani samo linearnim ili kružnim segmentima. Ovaj 
alat nudi niz prednosti u odnosu na ručno crtanje krivulja na papiru. Tačke na krivuljama 
mogu se lako uklanjati ili pomicati kako bi se prilagodile željenom obliku, što nije moguće 
na isti način uraditi kod ručnog crtanja.
Alat Spline nalazi se u ToolBox-u u odjeljku Documentation s lijeve strane radne površine. 
Sa izabranim alatom Spline u InfoBox-u pojavljuju se isti parametri za podešavanje kao kod 
crtanja linije. Ponuđena su tri načina crtanja (slika 2.21).
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Slika 2.21. Metode crtanja polilinije u InfoBox-u

Prvi način je postavljanje tačaka proizvoljno na radnu površinu (Natural), a softver ih 
automatski povezuje, stvarajući prilagođenu krivu. Svaka sljedeća definisana tačka utiče na 
ugao tangente i oblik krive polilinije koji se njime generiše. Crtanje se završava dvostrukim 
klikom na zadnju tačku (slika 2.22).

 
Slika 2.22. Spline prema prvom načinu konstrukcije (Natural)

Drugi način je pomoću Bezijerovih krivih (slika 2.23). To su matematički definisane krive 
koje se koriste u grafici i dizajnu za stvaranje glatkih i zakrivljenih linija. One se formiraju 
korišćenjem kontrolnih tačaka koje određuju oblik i zakrivljenost krive, kao i ručki koje 
kontrolišu zakrivljenost i smjer krive na svakoj tački. One se mogu koristiti za stvaranje 
raznih oblika, od jednostavnih linija do složenih krivih i površina. Često se koriste u grafič-
kim programima za crtanje i modelovanje, kao i u industriji animacije za stvaranje glatkog 
kretanja objekata.

Slika 2.23. Bezijerova metoda konstruisanja krive polilinije

Matematički, Bezijerova kriva definiše se pomoću polinoma, a njen oblik zavisi od položaja 
i uticaja kontrolnih tačaka. Što su kontrolne tačke bliže jedna drugoj, kriva je oštrija, dok 
udaljenije tačke rezultiraju blažim zakrivljenjem.

Bezijerove krive nazvane su po francuskom inženjeru Pjeru Bezijeru (Pierre 
Bézier), koji ih je opisao 1962. godine, dok je radio u kompaniji Renault na 
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razvoju automobilskog dizajna. Od tada su postale ključni alat u područjima poput 
dizajna, računarske grafike, inženjerstva i animacije.

Ovako nacrtana kriva polilinija može se modifikovati odabirom opcije Move Tangente 
Handle iz Pet Palette (slika 2.24).

Slika 2.24. Prikaz opcije Move Tangente Handle

PROVJERI SVOJE ZNANJE

1.	 Koja je razlika između lančane linije i polilinije?
2.	 Nacrtaj uzorak kao na slici 2.25. 
3.	 Na nacrtanom uzorku modifikuj spoljašnje stranice unoseći vrijednost radijusa ugla 

10 cm da bi se dobio rezultat kao na primjeru. Vježbu zapamti pod nazivom Uzorak.

Slika 2.25. Linije (Uzorak)
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2.3. Crtanje kružnice i luka 

Kružnice su geometrijski oblici definisani kao skup tačaka u ravni koje su podjednako 
udaljene od centra, dok su lukovi djelovi kružnica.
Kružnice i lukovi su geometrijski oblici koji imaju široku primjenu u inženjerskoj praksi. 
Precizno definisanje i opis oblika, prostornih relacija i putanja od ključnog je značaja u 
dizajniranju puteva, mostova i drugih objekata.
U arhitekturi i građevinarstvu, krugovi i lukovi se koriste za projektovanje i izgradnju 
kupola, svodova i ostalih arhitektonskih elemenata koji zahtijevaju precizne geometrijske 
oblike. Krivine puteva i željezničkih pruga takođe se definišu korišćenjem krugova i lukova 
radi obezbjeđivanja sigurnosti i optimalnog protoka saobraćaja.
U ArchiCAD-u se ovi oblici ne koriste samo za crtanje 2D elemenata, već mogu biti od pomoći 
kod stvaranja kompleksnih trodimenzionalnih oblika.
Alat Arc/Circle nalazi se u ToolBox-u u odjeljku Docu-
mentation s lijeve strane radne površine. Sa izabranim 
alatom u InfoBox-u pojavljuju se parametri za podeša-
vanje geometrije. Ponuđena su dva oblika: kružnica i 
elipsa. Oba oblika moguće je nacrtati djelimično, tako 
da se dobije luk. 
Kružnicu je moguće nacrtati zadavanjem parametara 
na tri načina (slika 2.26): 

1.	 definisanje preko centra i poluprečnika (Centerpoint and radijus)
2.	 kružnica iz tri tačke (obim) (Circumference)
3.	 definisanje tangenti kružnice (Tangential).

Ove metode identične su za crtanje zakrivljenih zidova. 

1. DEFINISANJE KRUŽNICE PREKO CENTRA I POLUPREČNIKA (slika 2.27)
Korak 1: Klikni na lijevi taster miša na radnoj površini da zadaš centar kružnice.

Korak 2: Pomjeri kursor u bilo kom pravcu da zadaš poluprečnik (Radius/Distance).
Klikom na dugme Tab na tastaturi aktivira se traker preko kojeg možeš unijeti nume-
ričku vrijednost poluprečnika, kao i kod crtanja linije.
Korak 3: Klikni na dugme Enter na tastaturi da zadaš poluprečnik.
Korak 4: Pomjeri kursor da nacrtaš željeni luk.

Da nacrtate pun krug, kliknite dva puta dugme Enter na tastaturi nakon unosa 
poluprečnika.

Slika 2.26. Prikaz ikonica za 
metode geometrije kružnice
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Slika 2.27. Definisanje kružnice preko centra i poluprečnika

2. KRUŽNICU IZ TRI TAČKE (slika 2.28) 
Korak 1: Prvim klikom na lijevi taster miša definiši početnu tačku luka.
Korak 2: Drugim i trećim klikom definišeš stranice trougla unutar kružnice (obim).
Dužine stranica mogu se unijeti i numerički, koristeći traker.
Korak 3: Četvrtim klikom lijevog tastera miša definišeš dužinu luka.

Slika 2.28. Kružnica iz tri tačke

3. �DEFINISANJE TANGENTI 
KRUŽNICE

Pomoću prethodne dvije metode 
moguće je nacrtati kružnicu ili dio nje 
(luk), dok se metoda definisanja tangenti 
koristi isključivo za crtanje kružnice. 
Zadavanjem tri tangencijalne tačke 
dobija se gotova kružnica (slika 2.29). 

Uz pomoć komandi iz Pet Palette, osim osnovnog uređiva-
nja (koje smo objasnili u poglavlju 3.1. Osnovno uređivanje) 
kružnicama se može promijeniti geometrija. 
1. Izduživanje elipse
2. Promjena dužine luka
3. Promjena poluprečnika

Slika 2.29. Prikaz odabira tangencijalnih tačaka  
za formiranje kružnice

Slika 2.30. Prikaz ikonica za 
uređivanje kružnice u Pet 

Palette
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Slika 2.31. Promjene geometrije kružnice iz Pet Palette

Podešavanja za crtanje i izmjene na kružnicama i lukovima važe i za zakrivljene zidove i grede.
Komande za izmjene luka u Pet Palette nešto su drugačije. Postoji više mogućih opcija 
izmjene luka: 

Slika 2.32. Izgled Pet Palette  
za izmjene na kružnici

1.	 izravnanje luka postavljanjem 
nove tačke 

2.	 zaobljenje luka iz zadate tačke
3.	 izmjena luka iz tangente
4.	 dodavanje nove tačke za 

izmjenu na luku.

Slika 2.33. 1. Izravnanje luka postavljanjem nove tačke; 2. Zaobljenje luka iz zadate tačke;  
3. Izmjena luka iz tangente; 4. Dodavanje nove tačke za izmjenu na luku
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PROVJERI SVOJE ZNANJE

1.	 Koje su tri osnovne metode crtanja kružnice?
2.	 Koja je razlika između Angular Stretch i Radial Stretch?
3.	 Nacrtaj uzorak kao na slici 2.34 primjenjujući dosad stečeno znanje. Poluprečnik crne 

kružnice je 20 cm, dok je poluprečnik crvene kružnice 10 cm. Centar za opisivanje 
djelova zelene kružnice označen je plavom bojom. Vježbu zapamti pod nazivom Cvijet.

Slika 2.34. Zadatak: Cvijet

4.	 Pomoću linija i kružnica grafički predstavi drvo kao na slici 2.35. Istražuj podešavanja 
elemenata. Vježbu zapamti pod nazivom Drvo.

Slika 2.35. Zadatak: Drvo
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2.4. Crtanje elipsi i eliptičnih lukova

Za crtanje elipsi i eliptičnih lukova u ArchiCAD-u potrebno je prvo razumjeti njene osnovne 
principe geometrije i estetike u dizajnu. Elipsa kao geometrijski oblik ima svoju matema-
tičku definiciju. To je skup svih tačaka u ravni čiji je zbir udaljenosti od dvije tačke, koje 
nazivamo fokusne tačke, konstantan. Elipsa ima dvije osnovne dimenzije: veliku osu (dija-
gonalu) i malu osu (poludijagonalu). Velika osa je najduže rastojanje između dvije tačke 
elipse, dok je mala osa najkraće. 
U arhitekturi se elipsa često koristi u različitim kontekstima. Na primjer, eliptični lukovi 
mogu se koristiti kao dekorativni elementi na fasadama zgrada ili u enterijerima. Takođe, 
elipsa se može koristiti kao osnova za oblikovanje prostora kao što su amfiteatri, gdje njena 
karakteristična forma doprinosi akustičkim i estetskim svojstvima prostora.

U ArchiCAD-u je crtanje elipsi i eliptičnih 
lukova omogućeno kroz različite alate i teh-
nike. Korišćenjem eliptičnih oblika u inženjer-
stvu omogućava se stvaranje dinamičkih oblika 
koji istovremeno zadovoljavaju funkcionalne 
zahtjeve i estetske standarde.
Za crtanje elipse koristi se alat Arc/Circle, a u 
InfoBox-u se za geometriju bira Elipse (slika 
2.36). Kao i kod crtanja kružnice, moguće je 
nacrtati dio elipse tako da se dobije eliptični luk.

Postoje tri načina konstruisanja:
1.	 Metodom definisanja dužine velike ose (dijagonale) zadaje se dijagonala zamišlje-

nog pravougaonika u koji je upisana elipsa (slika 2.37).

Slika 2.37. Postupak definisanja elipse preko dijagonale

2.	 Metodom definisanja centra i male ose (poludijagonale) zadaje se centar elipse i 
njegova poludijagonala (slika 2.38).

Slika 2.38. Postupak definisanja elipse preko poludijagonale

Slika 2.36. Prikaz ikonica za metode 
geometrije crtanja elipse
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3.	 Metodom definisanja poluprečnika elipse zadaje se dužina poluprečnika a nakon 
toga dužina male ose (slika 2.39).

Slika 2.39. Postupak definisanja elipse preko poluprečnika

2.5. Ispune/šrafure (Fills)

Ispune su elementi u tehničkom crtanju koji se koriste za popunjavanje površina unutar 
kontura ili oblika. Ovi elementi omogućavaju vizuelno odvajanje različitih cjelina na crtežu. 
Takođe, koriste se za davanje informacija o materijalu ili teksturi neke površine. U okviru 
softvera postoji unaprijed definisan skup vrsta ispuna koje se mogu primjenjivati prilikom 
crtanja. Kao što smo već pomenuli u poglavlju 1.5.4. Konfiguracija svojstava elementa (Ele-
ment Attributes), svojstva ispuna definišu se preko komande Options ˃ Element Attributes 
˃ Fills. U dijaloškom okviru podešavanja (slika 2.40) mogu se definisati, uređivati, kopirati, 
preimenovati ili izbrisati sve ispune.

Slika 2.40. Dijaloški okvir podešavanja ispuna
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1.	 Spisak svih vrsta ispuna koje su grupisane po materijalima koje predstavljaju. 
2.	 Ikonice za izradu nove ispune, kopiranje postojeće (radi manjih izmjena), formiranje 

novog foldera, preimenovanje postojećih i brisanje ispuna.
3.	 Naziv izabrane ispune
4.	 Dostupnost ispune. Za postojeće ispune već je definisano da li se ona može izabrati 

kao grafički prikaz za šrafure, za vertikalni ili horizontalni presjek nekog elementa 
(npr. zidova, ploča, greda i dr.).

5.	 Podešavanja za izabranu ispunu. U podešavanjima se definiše uzorak šrafure (njegova 
dužina i širina). Izgled šrafure utiče na efekte koji se žele postići, prilagođavajući ih 
razmjeri u kojoj se radi crtež. Informacija o trenutnoj razmjeri posljednja je na listi. 
Razmjera uzorka može se podesiti prema modelu objekta (Model Size) ili prema veli-
čini papira koja se podešava prilikom štampe projekta (Paper Size). Nakon što su 
unesene sve željene promjene, klikom na ikonicu OK čuvaju se izmjene.

Za crtanje ispuna koristi se alat Fills koji se 
nalazi u ToolBox-u u dijelu Documentation, 
s lijeve strane radne površine. Dvostrukim 
klikom lijevog tastera miša na ikonicu Fills 
otvara se dijaloški okvir podešavanja para-
metara ispune (Fill Default Settings) (slika 
2.41). Na slici je crvenom bojom označeno 
podešavanje linijskog okvira ispune. Okvir 
se može definisati kao bilo koja vrsta linije 
koja se nalazi u softveru (podrazumijevajući 
i linije koje ste sami napravili, a o kojima je 
bilo riječi u poglavlju Crtanje linija). Ova 
opcija može se isključiti, tako da okvir ispune 
nije vidljiv.
Sljedeća ikonica koristi se za definisanje 
kategorije ispune i boja kojima će biti pri-
kazana (slika 2.42).
Drafting Fill – Ova kategorija ispuna koristi 
se za označavanje površina na crtežu koje su 
namijenjene samo vizuelnoj prezentaciji i ne 
predstavljaju stvarne materijale ili slojeve 
u modelu. Na primjer, može se koristiti za 
parterno uređenje18 oko objekta, ali ne pred-
stavljaju stvarno popločanje ili zelenilo, već 
su jednostavni 2D elementi crteža.
Cut Fill – Kategorija ispuna koja opisuje 
izgled elemenata na mjestu kroz koje je 
postavljen vertikalni presjek. Ova vrsta 
ispune definisana je u podešavanjima eleme-
nata kada se crtaju (u zavisnosti od materi-
jala). Detaljnije o ulozi Cut Fills izučavaćemo 

18	 �Uređenje parcele oko objekta; podrazumijeva planiranje rasporeda staza, travnjaka, zelenila, 
fontana i dr.

Slika 2.41. Dijaloški okvir podešavanja 
parametara ispune

Slika 2.42. Podešavanje kategorije ispune
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kroz poglavlje 4. Elementi virtuelne zgrade, gdje se detaljno opisuje način prikazivanja 
ispuna za elemente.
Cover Fill – Kategorija ispuna kojom se prikazuje izgled elemenata na osnovama etaže. 
Kao i Cut Fills, i ova kategorija definiše se u podešavanjima elemenata prilikom crtanja.
Building Material (Cut Fill) – Kategorija ispuna materijalizacije. Za razliku od Drafting 
Fill i Cut Fill, koji predstavljaju proizvoljne 2D šrafure, ova kategorija podrazumijeva i 
informaciju o materijalizaciji i pravilnom načinu grafičkog prikaza određenih slojeva 
konstrukcije.
Surface (Cover Fill) – Kategorija ispuna materijalizacije završne obrade površina. 
Nakon podešavanja svih prethodnih parametara, klikom na ikonicu OK zatvara se dijaloški 
okvir. Ispune se crtaju na isti način kao i poligoni. Metoda geometrije može biti proizvoljna 
ili pravougaona. (Prisjetite se poglavlja 2.1. Crtanje linija, gdje smo detaljnije govorili o 
načinu konstruisanja zatvorenih linijskih oblika.) 

PROVJERI SVOJE ZNANJE

1.	 Otvori vježbu Linijski sto. Napravi izmjene koristeći alat za ispune onako kako je 
prikazano na slici 2.43. Zapamti vježbu kao Sto ispuna.

Slika 2.44. Zadatak 2: Cvijet ispunaSlika 2.43. Zadatak 1: Sto ispuna

2.	 Otvori vježbu pod nazivom Uzorak. Popuni prostore kao na slici 2.44, s tipom ispune 
Concrete Block, boje broj 1. Vježbu zapamti pod nazivom Cvijet ispuna. 

3.	 Otvori vježbu pod nazivom Drvo. Po svojoj želji ispuni sve djelove drveta. Zapamti 
vježbu kao Drvo ispuna.
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2.6. Postavljanje fotografija 

Figure Tool u ArchiCAD-u alat je koji omogućava postavljanje i uređivanje fotografija u bilo 
kom formatu (slike, ikonice, simboli, dijagrami i drugi grafički elementi). Format fotografije 
može se postaviti u bilo koji od prozora (osnova etaže, presjeci, fasade, detalji, radni listovi). 
Postavljanje slika u neki od prozora može biti značajno za unapređenje finalne grafičke 
prezentacije projekta. Takođe, veoma je koristan pri izradi konceptne table, kako bi se uz 
nacrtanu osnovu prikazao skup ideja za određeni prostor, zatim kao pozadinska slika za 
prezentaciju projekta i sl.
Za postavljanje fotografija koristi se alat Figure koji se nalazi u ToolBox-u u odjeljku Docu-
mentation, s lijeve strane radne površine. Dvostrukim klikom lijevog tastera miša na ikonicu 
Figure otvara se dijaloški okvir podešavanja fotografije (Figure Default Settings) (slika 2.45).

Slika 2.45. Dijaloški okvir za podešavanje parametara fotografije

1.	 Prvi korak je odabir fotografije za umetanje. Klikom na dugme Open otvara se novi 
prozor, koji upućuje na pronalazak željene fotografije iz računara. Izabrana fotografija 
biće prikazana u manjem formatu u prozoru za podešavanja.

2.	 Nakon odabira fotografije, potrebno je definisati njenu veličinu i rezoluciju. 

Rezolucija predstavlja količinu detalja fotografije kada je odštampana ili pri-
kazana na ekranu. Fotografija se može objasniti kao skup tačaka (piksela) koje 

se koriste za njen prikaz. Broj tačaka po jednom inču označava se sa DPI (dots per 
inch). Što je broj tačaka po inču (ili centrimetru) veći, slika će biti s većom rezolucijom 
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(tj. imaće više detalja). Takva slika zauzimaće više prostora na računaru i sporije će 
se učitavati ili štampati. 

Slika 2.46. Razlika u broju detalja (tačaka po inču/cm) na fotografiji.  
Prva slika je sa 10 dpi, druga sa 20 dpi a treća sa 70

Odabirom neke od tačaka na uglovima fotografije otvara se Pet Palette sa standardnim 
mogućnostima za izmjenu koje smo objasnili kroz prethodna poglavlja u okviru alata za 
crtanje. 
Promjena dimenzija fotografije vrši se pomoću komande Stretch iz Pet Palette.

�Ukoliko je potrebno zadržati proporcije originalne fotografije, prilikom pomjeranja 
kursora u proizvoljnom pravcu mora se držati pritisnuto dugme Shift na tastaturi. U 
suprotnom, fotografija će promijeniti oblik.

Slika 2.47. Promjena veličine fotografije uz korišćenje Shift-a

Slika 2.48. Promjena veličine fotografije bez korišćenja Shift-a.
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SAŽETAK POGLAVLJA

	f U poglavlju „Alati za 2D crtanje“ objasnili smo različite funkcije i alate koji omogućavaju 
kreiranje preciznih i detaljnih crteža u ArchiCAD-u.

	f Primjena linija proteže se kroz sve faze arhitektonskog procesa. Počinje s konceptualnim 
skicama i nastavlja se kroz različite faze dizajna, detalja i dokumentacije. Crtanje linija 
u ArchiCAD-u omogućava prenošenje ideje s papira na ekran. Osim unaprijed definisa-
nih izgleda linija, u ArchiCAD-u je, kao i u stvarnosti, moguće kreirati novu liniju, kojoj 
parametre grafičkog prikaza definišete kroz podešavanja. 

	f Skup linija koje čine jednu cjelinu naziva se polilinija. Crtanje i podešavanje parametara 
polilinije isto je kao i za liniju. 

	f Alat Spline koristi matematičke formule i algoritme za proračunavanje krivulja. Osim 
toga, postoji mogućnost jednostavnog uređivanja i izmjene oblika krivulja. Konstruisanje 
krivulja je težak i dugotrajan posao ako se radi ručno na papiru, a naročito ukoliko je 
potrebno napraviti izmjene na njima. Crtanje ovakvih oblika na računaru u velikoj mjeri 
štedi vrijeme i povećava produktivnost, posebno u složenijim crtežima ili projektima.

	f Princip crtanja kružnica i lukova na računaru isti je kao i kod ručnog crtanja, samo što 
se za konstruisanje i crtanje koriste miš i tastatura.

	f U ovom softveru, crtanje elipsi i eliptičnih lukova omogućeno je kroz različite alate i 
tehnike. Korišćenjem eliptičnih oblika u inženjerstvu omogućava se stvaranje dinamič-
kih oblika koji istovremeno zadovoljavaju funkcionalne zahtjeve i estetske standarde.

	f Alat za postavljanje fotografija omogućava postavljanje i uređivanje bilo kog formata 
(slike, ikonice, simboli, dijagrami i drugi grafički elementi). Važno je uzeti u obzir rezo-
luciju fotografije koja treba da bude dio grafičke dokumentacije.

	f Ovo poglavlje pruža sveobuhvatni pregled alata i tehnika za 2D crtanje, što je od suštin-
skog značaja za efikasno i precizno projektovanje.
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Komande za  
uređivanje objekata 3

U prethodnom poglavlju savladali ste osnove crtanja 2D elemenata. Nakon toga slijedi 
još jedan ključni korak u procesu rada na projektnom zadatku u okviru kompjuterskog 
crtanja – uređivanje objekata. U toku rada na projektu pojaviće se potreba za određenim 
izmjenama na objektima, kako za 2D elemente tako i za modelovanje u 3D. U ovom poglav-
lju naučićete čemu služe i kako se koriste komande i tehnike uređivanja objekata koje se 
nalaze u okviru softvera ArchiCAD. 
U ovom poglavlju saznaćete:

	y Vezu između komandi u ArchiCAD-u i geometrijskih transformacija
	y Praktičnu primjenu geometrijskih transformacija i transformacija boje i teksture 

objekata prilikom crtanja projekta
	y Način korišćenja ArchiCAD alata za transformaciju objekata.

3.1. Osnovno uređivanje

Osnovno uređivanje predstavlja proces manipulacije elemenata u okviru projekta radi 
poboljšanja ili prilagođavanja. Ovaj proces obuhvata dodavanje, brisanje, kopiranje, 
rezanje ili premještanje elemenata unutar projekta. Pojmovi, tj. naredbe Copy, Paste i Cut 
već su vam poznate iz programa za obradu teksta, slike ili podataka koje ste izučavali iz 
predmeta Informatika. Ove naredbe imaju istu ulogu i u svakom drugom programu, bilo 
da se radi o specijalizovanim softverima bilo da su u pitanju programi za obradu slike. 
Njihova je funkcija da nam olakšaju umnožavanje elemenata istih karakteristika i na taj 
način ubrzaju rad.
Odabir se može izvršiti pomoću strelice (Arrow Tool), alata Marquee ili Shift + lijevi taster 
miša. Nakon što je izabran i kopiran dio crteža, sadržaj se postavlja naredbom Edit > Paste.

Da napravite kopiju nekog dijela projekta, koristićete naredbu Edit > Copy ili 
prečicu na tastaturi Ctrl + C.

Ako se izreže/kopira, a zatim postavi neki sadržaj s prikaza osnove prizemlja na prikaz 
sprata, željeni elementi biće postavljeni na istim koordinatama na kojima su prikazani u 
prizemlju. Ako postoji nekoliko mogućih opcija za postavljanje, pojavljuje se dijaloški okvir 
Paste options (slika 3.1).
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Slika 3.1. Prikaz dijaloškog okvira kopiranja 

�Kada se postavljaju kopirani elementi u prikazima presjeka, izgleda i layout-a, elementi 
se postavljaju kao primitivi za crtanje (tačke, linije i ispune) a ne kao 3D modeli. Jedini 
je izuzetak ako se koristi naredba „Prevuci kopiju“ (Drag a copy).

Slika 3.2. Postupak rezanja segmenta 

Odabir elemenata koje je potrebno privremeno ukloniti izvršava se na isti način kao i za 
kopiranje (slika 3.2). Naredba Edit > Cut privremeno uklanja odabrane elemente iz projekta 
i čuva ih za buduću upotrebu putem naredbe Paste. Ako se izreže konstruktivni element iz 
prikaza presjeka ili fasada, on se takođe uklanja iz prikaza osnove. 
Naredba Edit > Delete uklanja odabrani sadržaj iz projekta, i on se ne čuva u memoriji za 
kopiranje (clipboard). Brisanje elemenata konstrukcije (osnova, presjek, fasada ili 3D) u 
bilo kojem prozoru modela (Model View) takođe će obrisati te elemente iz svih ostalih pri-
kaza. Vezu između pogleda objekta objasnili smo u poglavlju 1.5. Navigacija (Project Map: 
Korišćenje prozora za 2D i 3D navigaciju).
U toku crtanja može se dogoditi da se napravi greška ili da se prethodno rješenje učini 
boljim. Korišćenjem naredbi Undo/Redo (poništi i ponovi) omogućava se povratak na 
prethodni korak i ponovno izvođenje velikog broja koraka. Ove naredbe dostupne su i u 
paleti alata (slika 3.3).
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Slika 3.3. Ikonice Undo/Redo na standardnoj paleti alata

�Broj koraka koji se mogu poništiti i ponoviti postavlja se pomoću padajućeg menija 
Options > Work environment > Data safety and integrity (ograničenje poništavanja / 
Undo Limit).

Kada želite da prekinete neku od započetih naredbi, koristi se dugme ESC ili Backspace na 
tastaturi.

Transformacije objekata (Move)
Translacija, simetrija i rotacija – primjeri su izometrijskih transformacija koje ste naučili 
u osnovnoj školi. 
U ovom poglavlju savladaćete izvršavanje transformacija na objektima u toku i nakon 
crtanja objekta u ArchiCAD-u.
Komanda Move predstavlja preslikavanje objekata u zadate tačke na drugu lokaciju u 
projektu, a da se pri tome ne mijenjaju njegove postojeće dimenzije. Cilj transformacija 
jeste prilagođavanje pojedinačnih objekata ili grupe objekata za postizanje željenih funk-
cionalnih ili estetskih rješenja.
Koristeći komandu Move objekti se mogu pomjerati (Drag), rotirati (Rotate), preslikati duž 
ose (Mirror) ili im se može izvršiti elevacija, odnosno promjena vrijednosti njihove visin-
ske kote. Nakon odabira elemenata kojima je potrebno izvršiti transformaciju, koristi se 
komanda iz menija Edit > Move (sa bilo kojim aktivnim alatom u ToolBox-u) (slika 3.4).

Slika 3.4. Padajući meni opcije Move u osnovnom meniju Edit
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Pomjeranje elemenata (Drag)
Odabrani elementi mogu se pomjeriti u osnovi ili u 3D prozoru.

PRECIZNO POMJERANJE ELEMENATA

Korak 1: Odaberi željeni element, a zatim uradi jedno od sljedećeg:
a)	 Odaberi ikonicu Drag iz Pet Palette (slika 3.5). 
b)	 Koristi osnovni meni: Edit > Move > Drag. 
c)	 Koristi prečicu naredbe za pomjeranje (Ctrl + D).

Slika 3.5. Odabir elementa

Korak 2: Izmjesti odabrane elemente 
na novu lokaciju tako što ćeš:

a)	 pomjeriti kursor u bilo kom pra
vcu ili

b)	 zadati tačnu udaljenost od tre-
nutne lokacije pomoću slova 
na tastaturi – D (distance) za 
distancu i/ili A (angle) za ugao i 
unijeti željene vrijednosti (slika 
3.6).

�Vrijednost se unosi u jedinicama mjere koje su prethodno definisane. Prisjetite se 
poglavlja 1.4 (Project Preferences).

Kada se prilikom pomjeranja kursora drži pritisnut taster Shift, element će se kretati ortogo-
nalno (pod pravim uglom) u odnosu na trenutnu poziciju.

Korak 3: Završi naredbu klikom na lijevi taster miša ili Enter na tastaturi ukoliko su 
unošene numeričke vrijednosti udaljenosti i ugla.

Slika 3.6. Pomjeranje elemenata pomoću Trakera
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Nacrtaj kvadrat stranica a = 50 cm. Prateći uputstva za pomjeranje elemenata, 
premjesti nacrtani pravougaonik u pravcu y = –40 cm.

Na isti način izvršavaju se i komande Drag a Copy (prevuci kopiju) i Drag Multiple Copies 
(prevuci više kopija).

Rotacija elemenata (Rotate)
Rotacija je oblik izometrijske transformacije kojom objekat mijenja svoju lokaciju oko zadate 
ose. U ArchiCAD-u za bilo koju izmjenu na objektu prvo morate izabrati objekat na kom je 
želite izvršiti. Rotaciju takođe možete izvršiti u 3D prikazu, ali samo oko horizontalne ose.

ROTACIJA OBJEKTA
Korak 1: Izaberi objekat na jedan od sljedećih načina:

a)	 Klikni na ikonicu Rotate iz Pet Palette (slika 3.7)
b)	 Koristi osnovni meni: Edit > Move > Rotate

c)	 Koristi prečicu naredbe za pomjeranje (Ctrl + E).

Slika 3.7. Ikonica za rotaciju u Pet Palette

Na slici 3.8 prikazani su 
naredni koraci.
Korak 2: Pritisni lijevi 
taster miša da definišeš 
centar rotacije odabranih 
elemenata.
Korak 3: Pritisni lijevi 
taster miša da definišeš 
početnu tačku luka rota-
cije i njegov poluprečnik.
Korak 4: Pomjeri kursor i 
pritisni lijevi taster miša 
da završiš rotaciju. 

Slika 3.8. Postupak rotacije elementa
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Nacrtaj pravougaonik dimenzija 100 cm x 50 cm. Prateći uputstva za rotaciju 
elemenata, rotiraj nacrtani pravougaonik za 45 stepeni iz gornje lijeve tačke.

Na isti način izvršavaju se komande Rotate a Copy (prevucite kopiju) i Rotate Multiple Copies 
(prevucite više kopija).

Osno-simetrično preslikavanje (Mirroring Elements)
Osno preslikavanje predstavlja preslikavanje ravni 
pri kojem se svaka tačka te ravni preslikava u drugu 
simetričnu tačku u odnosu na zadatu osu presli-
kavanja. Upotrebom naredbe Edit > Mirror, u 
ArchiCAD-u se mogu preslikavati kako 2D elementi 
tako i 3D modeli. Na primjeru dnevnog boravka 
objasnićemo korake kojima se vrši osno preslika-
vanje (slika 3.9).

OSNO-SIMETRIČNO PRESLIKAVANJE 
Korak 1: Iz osnovnog menija izaberi Edit > Move > Mirror ili koristi ikonicu 

u Pet Palette (slika 3.10).

Slika 3.10. Izgled ikonice Mirror u InfoBox-u

Korak 2: Definiši osu preslikavanja početnom i krajnjom tačkom ose, kao kada crtaš 
liniju (slika 3.11).

Slika 3.11. Postupak osnog preslikavanja elementa

Preslikani elementi biće postavljeni nakon drugog pritiska lijevog tastera miša.

Slika 3.9. Dnevni boravak
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PRESLIKAVANJE KRUŽNICE POMOĆU KOMANDE MIRROR (Prisjeti se 
korišćenja korisničkog koordinatnog početka u poglavlju 1.4 (User Origin).)

Korak 1: Nacrtaj kružnicu poluprečnika 100.
Korak 2: Postavi korisnički koordinatni početak u centar kružnice.

Slika 3.12. Odabir elementa za osno preslikavanje

Korak 3: Izaberi kružnicu i iz menija Edit > Mirror ili pritiskom desnog tastera miša 
izaberi iz padajućeg menija Mirror (slika 3.12).
Korak 4: Definiši osu preslikavanja tako što ćeš odrediti koordinate x i y u odnosu na 
postavljeni koordinatni početak. Apsolutna vrijednost x-ose biće 200 a y-ose 0 (slika 
3.13).

Slika 3.13. Postupak osnog preslikavanja elementa

PROVJERI SVOJE ZNANJE

1.	 Na koji način podešavaš broj koraka koji se može vratiti unazad?
2.	 Nabroj komande za osnovno uređivanje objekata.
3.	 Opiši načine premještanja elemenata na crtežu.
4.	 Objasni postupak kopiranja elemenata crteža s jednog sprata na drugi.
5.	 Na koji se način vrši rotacija elemenata na crtežu? 
6.	 Šta predstavlja osno preslikavanje?
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7.	 Nacrtaj linije proizvoljnih dimenzija da dobiješ figuru prikazanu na slikama 3.14. i 
3.15. Isijeci naznačeni dio koristeći naredbu Cut.

Slika 3.14. Vježba komande Cut (a) Slika 3.15. Vježba komande Cut (b)

a) b)

3.2. Poravnanje elemenata (Align)

Kada projektujemo objekat u ArchiCAD-u, uvijek krećemo od crtanja elemenata u osnovi. 
Jedna od faza je, na primjer, crtanje prozora. Nakon što se izmodeluje objekat i pogleda se 
u trodimenzionalnom prikazu ili u pogledu fasade, može se dogoditi da ti prozori nijesu 
u pravilnom odnosu jedan prema drugom, da su im parapeti različiti ili da se ipak mogu 
postaviti na jednakim razmacima kako bi fasada imala bolji estetski prikaz. U ovom slučaju 
koristi se komanda za poravnanje (Align) (slika 3.16). U ArchiCAD-u se koristi kada odabrane 
objekte treba poravnati, npr. po istoj horizontalnoj ili vertikalnoj osi. Takođe, objekti se 
mogu poravnati po njihovom centru po definisanoj osi.
Svi objekti mogu se poravnati po unaprijed definisanim kriterijumima, koji su vam već 
poznati i iz programa za obradu teksta (poravnanje elemenata desno ili lijevo; na vrh ili 
dno; ili centriranje elemenata horizontalno ili vertikalno).

Slika 3.16. Padajući meni Align iz osnovnog menija Edit

�Komande za poravnanje aktivne su samo ako su odabrana najmanje dva elementa. 



753.3. Raspodjela elemenata (Distribute)

Kada se koristi komanda „Poravnaj“ (Align), izraz „desno“ (Right) odnosi se na krajnji desni 
element na x-osi u prozoru koji gledate (npr. osnova, presjek, 3D). Izraz „lijevo“ (Left) odnosi 
se na smjer lijevo na x-osi. Slično, „vrh“ (Top) znači element s najvišom y-koordinatom u 
trenutnom prozoru, a „dno“ (Bottom) element je s najnižom y-koordinatom.
ArchiCAD identifikuje desnu/lijevu/gornju/donju/srednju tačku elementa prema (nevidlji-
vom) graničnom okviru oko elementa.

1. Odaberi objekte koje želiš porav-
nati.

2. Idi na osnovni meni Edit > Align i izaberi 
Horizontal Center (slika 3.17).

3.3. Raspodjela elemenata (Distribute)

Slika 3.18. Padajući meni Distribute iz osnovnog menija Edit 

Komanda Distribute koristi se kada treba ravnomjerno rasporediti odabrane elemente 
koristeći različite kriterijume.

�Komande distribucije aktivne su samo ako su odabrana najmanje dva elementa.  

Na primjer, pretpostavimo da želite rasporediti elemente u okviru objekta.
Pretpostavimo da postoje četiri prozora ravnomjerno raspoređena duž zida (slika 3.19).

Slika 3.19. Raspored otvora na zidu

Slika 3.17. Horizontalno centralno 
poravnanje 
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Kao rezultat promjene dizajna, zid se produžava i dodaju se još dva prozora (slika 3.20).

Slika 3.20. Promjena rasporeda otvora pri promjeni dizajna

Kako bi svi bili ravnomjerno raspoređeni, odaberu se svi prozori i koristi se komanda Edit 
> Distribute > Along X (za ravnomjerno raspoređivanje razmaka duž x-ose) (slika 3.21).

Slika 3.21. Komanda Distribute Along X

3.4. Izmjena veličina elemenata (Modify element size)

Različiti tipovi elemenata imaju različite karakteristične dimenzije: dužinu, širinu, visinu, 
debljinu, ugao otvaranja itd. Neke od njih najlakše je numerički modifikovati, odabirom 
datog elementa, otvaranjem dijaloškog okvira njegovih postavki i podešavanjem relevan-
tnih vrijednosti.
Neke se dimenzije, međutim, ne mogu numerički modifikovati (npr. dužina linearnih ele-
menata ili ivica), dok se neke druge moraju tačno uklopiti s drugim elementima (npr. zidovi 
do krovova), što može učiniti numeričko podešavanje zamornim proračunskim zadatkom.
U takvim slučajevima ArchiCAD ima mogućnost modifikacije veličine elemenata uz pomoć 
razdvajanja (splitting), izduživanja (stretching) i odsijecanja (trimming).
Većina operacija može se izvesti na tri načina:

	y koristeći naredbu Edit iz osnovnog menija
	y prečicama na tastaturi
	y komandama iz Pet Palette.

Izduživanje je dostupno za većinu tipova odabranih elemenata i u osnovi i u 3D prozoru. 
Samo elementi 2D crteža mogu se izdužiti u presjeku, izgledu ili 3D dokumentu i radnim 
listovima.
Premještanje ivice poligona vrši se klikom lijevog tastera miša na ivicu/čvor uz odabir 
ikonice „Premjesti čvor“ (Move hotspot) u Pet Palette (slika 3.22). Dvije susjedne ivice pratiće 
kretanje istezanja, i oblik poligona će se u skladu s tim promijeniti.
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Slika 3.22. Pomjeranje ivice objekta

DODAVANJE NOVOG POLIGONA POSTOJEĆEM 

Korak 1: Odaberi poligon ili njegove ivice iz kojih treba dodati poligon (pri-
tisni lijevi taster miša na ivicu/čvor).
Korak 2: Iz Pet Palette odaberi ikonicu sa znakom „+“ (Dodaj u poligon) (slika 3.23).
Korak 3: Nacrtaj novi oblik poligona. Novi poligon mora se ukrštati s prvobitnim, ili
barem treba da imaju zajedničku ivicu.
Korak 4: Klikni na lijevi taster miša da završiš crtanje novog oblika. 

Slika 3.23. Postupak dodavanja poligona

Proces je isti za oduzimanje oblika od poligona, 
uz odabir ikonice „–“.
U prozorima 3D, presjek i izgled može se gra-
fički modifikovati visina elemenata pomoću 
komande „Rastegni visinu“ na Pet Palette (slika 
3.24). Ivica elementa odabere se klikom lijevog 
tastera miša na nju, a zatim se klikne ikonica 
vertikalnog rastezanja u Pet Palette. Kontura 
elementa prati pomjeranje kursora. Još jednim 
klikom lijevog tastera miša postavlja se nova 
visina elementa.

Slika 3.24. Izmjena visine zida 
korišćenjem Pet Palette
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Komanda iz osnovnog menija Edit > Modify > Fillet/Chamfer koristi se za zaobljenje ili 
iskošenje uglova dviju pravih linija, poligonalnog elementa ili međusobno povezanih zidova 
(slika 3.25).

Slika 3.25. Izgled oborenih i zaobljenih ivica poligona

Opciji Fillet/Chamfer pristupa se na nekoliko načina. Uz odabrane dvije linije ili poligon:
	y komada Edit > Modify > Fillet/Chamfer ili
	y ako je odabrani element poligon, ikonica Fillet/Chamfer iz Pet Palette.

Fillet spaja dvije ravne krajnje tačke segmenata u luk (zaobljenje).
Chamfer spaja krajnje tačke dva ravna segmenta odsijecajući prave uglove (zakošenje).

	y Potrebno je unijeti numeričku vrijednost za ugao/zakošenja. (Zakošenje nema 
poluprečnik, ali će biti nacrtano kao tetiva lukova navedenog radijusa.)

	y Klikom na dugme OK izvršava se izmjena (slika 3.25).

Odsijecanje (Trim)
Pored osnovnih transformacija koje smo do sada pomenuli i koje ste savladali, na objektima 
u okviru projekta mogu se vršiti i druge izmjene. Komanda Trim koristi se za uklanjanje 
dijela elementa koji se proteže izvan njegove tačke ukrštanja s drugim elementom ili za 
rezanje dijela elementa između dvije tačke ukrštanja.

Odsijeci djelove grede koji prelaze zid.

Odaberi komandu Edit > Reshape > Trim ili pritisni taster Ctrl na tastaturi.
Pojavljuje se kursor u obliku makaza. Pređi mišem preko dijela koji želiš rezati i 
pritisni lijevi taster miša (slika 3.26).
Dio elementa koji je izabran između dvije najbliže presječne tačke biće obrisan. Na 
slici 3.26 odrezaćeš dio grede koji se nalazi između dva zida s lijeve strane.
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Slika 3.26. Postupak korišćenja naredbe Trim

Umnožavanje (Multiply) 
Često ćete u procesu izrade projekta doći u situaciju da je potrebno napraviti velik broj 
kopija jednog elemenata ili grupe elemenata. Na primjer, prilikom uređivanja pejzaža oko 
objekta treba postaviti drveće ili cvijeće u jednakim razmacima. Takođe, kod projektovanja 
restorana ili kafića, kada se definiše raspored jednog stola, proces ručnog pravljenja kopija 
može oduzeti puno vremena za crtanje. Metoda umnožavanja (Multiply) kreira bilo koji 
broj kopija odabranih elemenata, prema uzorku i definisanom pravilu. 
Komandi se pristupa preko opcije Move > Multiply iz Pet Palette ili Edit > Move > Multiply.

Slika 3.27. Dijaloški okvir Multiply
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1.	 Opcije koje su ponuđene za umnožavanje (slika 3.27):
	y Prevlačenje (Drag) množi kopije duž nacrtane ravne putanje ili izabrane polilinije.
	y Rotiranje (Rotate) umnožava kopije duž zakrivljene putanje.
	y Izdizanje (Elevate) premješta kopije s vertikalnim pomakom. 
	y Matrix (Matrica) postavlja kopije u pravougaonu matricu definisanu s dvije nor-

malne referentne linije.

2.	 �Graphical Input Methods odnosi se na metode za raspoređivanje umnoženih kopija 
u okviru projekta. Postoje četiri metode rasporeda, i to:

Postepeno dodavanje i ravnomjerno raspoređivanje kopija elemenata  
(Increment and Spread)
Ova metoda omogućava postavljanje razmaka između elemenata tako da se taj razmak 
ponavlja prilikom dodavanja novog elementa.
Na slici 3.28 prikazana je kružnica koja je kopirana korišćenjem opcije Increment and Spread. 
Zadat je razmak između centara kopiranih kružnica od 6000 mm, i prilikom pomjeranja 
miša u bilo kom pravcu softver će automatski dodavati nove kružnice s definisanim raz-
makom između njihovih centara.

POSTEPENO DODAVANJE I RAVNOMJERNO RASPOREĐIVANJE KOPIJA 
ELEMENATA 

Korak 1: Odaberi opciju Increment and spread iz komande Multiply; a zatim odaberi 
komande OK kako bi se aktivirala opcija.
Korak 2: Klikni na lijevi taster miša da definišeš početnu tačku.
Korak 3: Sljedećim klikom lijevog tastera miša definiši razmak između svake umno-
žene kopije.

Slika 3.28. Korak 4

Korak 4: Povlači kursor u bilo kom smjeru da kreiraš neograničen broj kopija sa istim 
razmakom.

Slika 3.29. Korak 5

Korak 5: Klikom na lijevi taster miša završavaš komandu.
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Postepeno dodavanje kopija elemenata (Increment)
Ovom metodom unaprijed se definiše broj kopija, ali se grafički definiše njihov razmak.

POSTEPENO DODAVANJE KOPIJA ELEMENATA 

Korak 1: Odaberi opciju Increment, zatim unesi broj kopija koji želiš napra-
viti. Klikom na ikonicu OK zatvaraš dijaloški okvir (slika 3.30).

Slika 3.30. Odabir naredbe Increment

Korak 2: Prvim klikom lijevog tastera miša definišeš početnu tačku.

Slika 3.31. Definisanje početne tačke za naredbu Increment

Korak 3: Prevuci kursor u bilo kom pravcu da definišeš širenje i pravac – Distance za 
udaljenost, Angle za ugao – postavljenog broja kopija.

Slika 3.32. Korak 3

Korak 4: Klikni za postavljanje umnožene kopije.
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Ravnomjerno raspoređivanje kopija elemenata (Spread)
Korišćenjem ove opcije definiše se razmak između kopija a njihov broj je neograničen. 
Postavljaju se prateći iste korake kao i za prve dvije opcije.

Otvori dijaloški okvir Multiply. Istražuj opcije Rotate, Elevate i Matrix i zabi-
lježi svoja zapažanja.

Prenos parametara (PickUp and Inject parameters)
Pick Up and Inject parameters funkcija je koja omogućava dodjeljivanje karakteristika jed-
nog elementa drugom elementu iste vrste. 

PRENOS PARAMETARA OBJEKTA (TROKRILNOG PROZORA) 
Korak 1: Koristi prečicu za preuzimanje parametara (Alt + klik lijevog tastera 

miša na trokrilni prozor) (slika 3.33).

Slika 3.33. Postupak preuzimanja parametara 

Korak 2: Koristi prečicu (Ctrl + Alt + klik lijevog tastera miša) za aktivaciju prenosa para-
metara na jednokrilni prozor ili odabir ikonice u standardnoj paleti alata (slika 3.34). 

Slika 3.34. Izgled ikonice Inject Parameters u standardnoj paleti alata

Korak 3: Prelaskom kursora na jednokrilni prozor i klikom na lijevi taster miša, pre-
nijećeš parametre (slika 3.35).
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Slika 3.35. Postupak dodavanja parametara Slika 3.36. Konačan izgled otvora

Ukrštanje elemenata (Intersect)
Dva razdvojena elementa mogu se spojiti u najbližoj tački presjeka korišćenjem komande 
Intersect iz standardne palete alata. Ova komanda može se primijeniti na linijama, luko-
vima, zidovima i gredama.

UKRŠTANJE ELEMENATA
Korak 1: Izaberi dva elementa (slika 3.37).

Slika 3.37. Prikaz odabranih 
elemenata

Slika 3.38. Izgled ikonice Intersect  
u InfoBox-u

Korak 2: Aktiviraj naredbu Edit > Modify > Intersect ili klikni na ikonicu u Standard 
Toolbar-u (slika 3.38).

Slika 3.39. Konačan izgled spojenih elemenata
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PROVJERI SVOJE ZNANJE

1.	 Opiši načine poravnanja objekata.
2.	 Čemu služi komanda Distribute?
3.	 Na koji način možeš izvršiti izmjenu veličine na objektima?
4.	 Koja je razlika između Filet i Chamfer komandi za izmjene na objektima?
5.	 Navedi opcije koje ti nudi komanda Multiply.
6.	 Koje komande koristiš da preneseš parametre s jednog na drugi objekat?
7.	 Nacrtaj kvadrat stranice 350 i napravi četiri njegove kopije s razmakom od 200.
8.	 Nacrtaj jednu kružnicu poluprečnika 200 plavom bojom i drugu kružnicu polupreč-

nika 300 crvenom bojom. Proizvoljno izvrši prenošenje parametara s jedne na drugu. 
Zabilježi svoja zapažanja.

9.	 Nacrtaj pravougaonik proizvoljnih dimenzija crvenom bojom i liniju proizvoljne 
dužine zelenom bojom. Prenesi parametre s jednog elementa na drugi. Zabilježi 
svoja zapažanja.

ZADATAK 1:  
Isijeci djelove objekta tako da dobiješ zadatu figuru (kao na slici 3.40).

Slika 3.40. Početni i krajnji izgled figure

Uključi Tracker iz palete alata. 
Pomoću alata Line nacrtaj pravougaonik dimenzija 100 x 450.

Slika 3.41. Postupak rotacije elementa



853.4. Izmjena veličina elemenata (Modify element size)

Uključi Guide Lines i Snap Guides. 
Rotiraj njegovu kopiju za 90° (slika 3.41).
Da ih centriraš, selektuj oba pravougaonika i idi na osnovni meni: Edit > Align > Horizontal 
Center i Edit > Align > Vertical Center.
Napravi Guide Line Segment tako što ćeš kliknuti strelicu pored ikonice za Guide Lines i 
povući liniju vodilju kroz sredinu figure (slika 3.42).

Slika 3.42. Postupak postavljanja linija vodilja

Izaberi alat Arc/Circle i nacrtaj kruž-
nicu sa centrom u sredini presjeka dva 
pravougaonika s radijusom od 150. 
(Da završiš kružnicu, nakon unosa 
radijusa klikni lijevi taster miša.)
Koristeći komandu Cut isijeci djelove 
figure tako da dobiješ konačan oblik 
kao na slici 3.43.

ZADATAK 2: 
Nacrtaj raspored stolova u restoranu.

Slika 3.44. Konačan izgled zadatka

Slika 3.43. Konačan izgled figure
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Nacrtaj sto zadatih dimenzija i jednu stolicu koristeći alat Line.
Koristeći naredbu Move > Drag a copy napravi kopiju stolice udaljenu za 15 cm (u Trakeru 
ćeš unijeti vrijednost širine stolice + udaljenost, što iznosi 60 cm).

Slika 3.45. Postupak crtanja stola, korak 2

Uključi Guide Lines i Snap Guides iz standardne palete alata i preslikaj kopiju ove dvije 
stolice po osi sredine stola.

Slika 3.46. Postupak crtanja stola, korak 3



873.4. Izmjena veličina elemenata (Modify element size)

Koristeći komandu Multiply > Increment and spread napravi četiri kopije stolova sa 
zadatom međusobnom udaljenošću.

Slika 3.47. Postupak crtanja stola, korak 4

Lijevim klikom miša završi crtanje.

Kada se u ArchiCAD-u crtaju stolovi i stolice, uvijek se koristi alat Objects iz ToolBox-a jer 
na taj način ArchiCAD automatski postavlja 2D prikaz zadatog objekta (u ovom slučaju 

stolice i stolova) prema zadatim postavkama. Naravno, sve izmjene koje smo do sada pomenuli 
važe za sve vrste objekata. Međutim, kako tek u sljedećem poglavlju objašnjavamo kako se crtaju 
modeli objekata u ArchiCAD-u, ovi zadaci bazirani su na linijskom iscrtavanju.
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	f Način upotrebe komandi za osnovno uređivanje (Copy, Paste, Cut) poznat vam je odra-
nije. Osim njih, u ArchiCAD-u postoji i niz drugih komandi za izvršavanje mnoštva 
operacija koje omogućavaju da se na jednostavan način uređuje 3D model objekta i 
elementi za 2D crtanje.

	f Odabir elemenata koje treba privremeno ukloniti izvršava se na isti način kao i za kopi-
ranje. Naredba Edit > Cut privremeno uklanja odabrane elemente iz projekta i čuva ih 
za buduću upotrebu putem naredbe Paste. Važno je naglasiti da su crtanje elemenata 
3D modela i njegove izmjene povezani u svakom prikazu objekta (osnove, fasade, pre-
sjeci, izgledi enterijera) i da će sve izmjene, izvedene u bilo kom od ovih prikaza, biti 
izmijenjene na svakom prikazu. Ukoliko se ukloni konstruktivni element iz prikaza 
presjeka ili fasada, element se takođe uklanja iz prikaza osnove. 

	f Osnovne transformacije pomjeranja (Drag), rotacije (Rotate) i osno preslikavanje (Mirror) 
mogu se izvršiti za pojedinačne elemente ili za grupu elemenata. Dodatno, mogu se 
pomjeriti ili rotirati jednu ili više kopija istovremeno. 

	f Pored ovih, u ArchiCAD-u postoje i relativne metode konstrukcije koje takođe kontrolišu 
i pomažu prilikom pomjeranja ili crtanja elemenata pod određenim uglom.

	f Različiti tipovi elemenata imaju različite karakteristične dimenzije: dužinu, širinu, 
visinu, debljinu, ugao otvaranja itd. Na nekima od njih lako se može izmijeniti nume-
rička vrijednost i dobiti željeni rezultat. Ipak, za druge vrste izmjena, numerički 
unos može biti otežan zbog vrste proračuna koje treba ručno uraditi da se dođe do 
željenog rezultata. Za takve operacije u okviru ArchiCAD-a postoji Pet Palette, koja 
se pojavljuje kada je izabran bilo koji element i nudi mnoštvo opcija za izmjene na 
izabranom objektu.
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Elementi  
virtuelne zgrade 4

U ovom poglavlju započinjemo istraživanje virtuelne zgrade korišćenjem računara. Cilj 
ovog poglavlja jeste upoznavanje s osnovama kreiranja konstruktivnih elemenata i dizajna 
enterijera u ArchiCAD-u. Prije izrade modela objekta na računaru osvrnućemo se na ključne 
definicije koje ste već naučili u modulu Elementi objekata I. 
Konstruktivni elementi objekta su: temelj, konstruktivni zid, stub, vertikalni i horizon-
talni serklaž, greda, međuspratna konstrukcija, stepenice, krovna konstrukcija, nadvratnik 
i natprozornik. 
Nekonstruktivni elementi objekta su: pregradni zid, parapet, krovni pokrivač, vrata, pro-
zor, dimnjak, ventilacioni kanal, trotoar, pod, plafon, zidna obloga, izolacije, instalacije i dr. 
Ista pravila i podjele važe i kada je u pitanju crtanje ovih elemenata u ArchiCAD-u, uz pri-
mjenu svih standarda i pravila koji se koriste u arhitekturi i građevinarstvu.
Osim konstruktivnih i nekonstruktivnih elemenata objekta, važno je razumjeti kako se 
oblikuje unutrašnji prostor. To uključuje raspored namještaja, osvjetljenje i druge elemente 
koji prostor čine funkcionalnim i estetski prijatnim. Kroz ovo poglavlje naučićete i kako da 
koristite ArchiCAD za dizajniranje i grafički prikaz elemenata enterijera.
U ovom poglavlju saznaćete:

	y Koji su parametri za podešavanje značajni kod crtanja konstruktivnih elemenata 
objekta

	y Kako se pravilno crtaju zidovi koristeći različite načine geometrije
	y Koji su postupci za postavljanje greda i stubova u projektu
	y Na koji se način postavljaju ploče i kako se vrše izmjene oblika 
	y Koje se vrste krovova mogu nacrtati u ArchiCAD-u 
	y Šta su stepenice i koje su vrste konstrukcije i geometrije koje se mogu nacrtati
	y Na koji se način crtaju otvori u projektu
	y Kako se crtaju elementi namještaja i koji su parametri važni kod podešavanja 

njihovog izgleda. 

4.1. Konstruktivni elementi

U procesu arhitektonskog projektovanja potrebno je prvenstveno razumjeti ulogu kon-
struktivnih elemenata objekta. Oni čine osnovnu strukturu svakog objekta i obezbjeđuju 
stabilnost i nosivost. Kroz njihovo precizno postavljanje i dimenzionisanje takođe se oblikuje 
prostor onako kako odgovara potrebama korisnika i zahtjevima projekta.
Specijalizovani softveri olakšavaju vizualizaciju, modelovanje i analizu konstruktivnih ele-
menata, i na taj način doprinose preciznoj izradi projekata. Funkcija ArchiCAD-a upravo je 
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virtuelno stvaranje svih elemenata objekta, od temelja do krova, uz mogućnost istraživanja 
različitih konfiguracija i materijala u realnom vremenu. Ovakav pristup projektovanju pruža 
bolje razumijevanje kompleksnosti konstrukcije kao i lakše uočavanje mogućih problema 
prije nego što krene izgradnja.
U narednim djelovima poglavlja istraživaćete na koji se način u ArchiCAD-u modeluju 
i prilagođavaju konstruktivni elementi i kako se vrši odabir odgovarajućih materijala i 
dimenzija u zavisnosti od projekta.

4.1.1. Zidovi

Zidovi su vertikalni površinski konstruktivni elementi. Njihova je uloga da obezbijede 
nosivost, stabilnost i sigurnost objekta kao i da definišu unutrašnje i spoljašnje granice 
prostora. Zidovi mogu biti izrađeni od različitih materijala (beton, opeka, drvo ili kamen 
i dr.). Oni mogu imati različite debljine i visine u zavisnosti od svoje namjene i položaja u 
objektu. Razumijevanje njihove uloge i pravilno projektovanje značajni su koraci u stva-
ranju kvalitetnih rješenja na računaru.

Jedna od glavnih uloga zidova kroz istoriju bila je odbrana. Takve strukture 
građene su prvenstveno radi zaštite stanovnika naselja, dok su u helenističko 

doba dobijale i estetsku dimenziju koja je doprinosila prestižu grčkih polisa. O monu-
mentalnosti ovih fortifikacija svjedoči i podatak da je jedan dio zidina Troje (iz perioda 
između 1800. i 1300. p. n. e.) u osnovi imao debljinu od 4,5 metra, dok je njihova visina 
prelazila 5 metara. 

Slika 4.1. Odbrambeni zid, izvor Freepik.com

U ArchiCAD-u se mogu crtati pravolinijski, zakrivljeni, trapezoidni ili poligonalni zidovi. 
Zidna konstrukcija može biti osnovna (sastavljena iz jednog sloja) ili kompozitna (iz više 
slojeva). Mogu se kreirati i složeni zidovi (kompleksni) bilo kojeg prilagođenog oblika. U 
ovom poglavlju objasnićemo način crtanja osnovnog zida (Basic), dok vam je za kompo-
zitne i kompleksne zidove potrebno dodatno vrijeme i praksa kako bi ih primjenjivali na 
pravilan način.
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Slika 4.2. Prikaz dijaloškog okvira za podešavanje parametara zida

Alat za crtanje zida (Wall) nalazi se s lijeve strane radne površine u ToolBox-u, u odjeljku 
Design. Dvostrukim klikom na ikonicu zida otvara se dijaloški okvir s podešavanjima para-
metara zida (Wall Default Settings) (slika 4.2). 
Prvi padajući meni jeste podešavanje geometrije i pozicije zida (Geometry and Positioning). 

Slika 4.3. Prikaz menija za podešavanje geometrije i pozicije zida

1. U prvom dijelu određuje se visina zida i udaljenost krajnjih ivica od etaže na kojoj se 
nalazi zid. Top Link predstavlja gornju ivicu zida za koju je vezan, a Home Story donju ivicu, 
odnosno početak zida po vertikali. Kada je zid povezan s etažama na ovaj način, visina mu 
se ne može mijenjati s obzirom na to da je ona definisana visinom etaže koju ste zadali 
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(podešavanja etaže objasnili smo u poglavlju 1.5.5. Konfiguracija etaže). Kao što je prikazano 
na slici 4.2, polje za zadavanje visine zida je zasjenčeno. Polje „to Project Zero“ označava 
nivo na kom se zid nalazi u odnosu na kotu tla. Ovo polje uvijek će se automatski ažurirati 
kada se postavljaju zidovi na nekoj od viših etaža.
Ukoliko ipak želite da postavite proizvoljnu visinu zida koja nije vezana za gornju etažu, 
u polju Top Link iz padajućeg menija izabraćete opciju Not Linked. Kada je ona izabrana, 
polje za upisivanje visine zida postaje aktivno i može se unijeti numerička vrijednost u 
prethodno definisanim jedinicama mjere. 
Pored definisanja visine, mogu se unijeti i vrijednosti udaljenosti donje ili gornje ivice zida 
od nivoa etaže na kojoj se nalazi zid. Ova podešavanja ne utiču na prikaz zidova u osnovi. 
Međutim, ukoliko su zadate vrijednosti veće od 0 u ovim poljima, na trodimenzionalnom 
modelu i na prikazima presjeka doći će do promjene u poziciji zida u odnosu na etažu. 
Na primjeru sa slike 4.4 prikazana su dva zida, od kojih je na jednom parametar udaljenosti 
od donje/gornje ivice promijenjen na 100 cm. 

Slika 4.4. Razlika u vrijednosti parametra elevacije zida

Ove razlike u udaljenosti od etaže mijenjaju se ukoliko se u osnovi nalaze djelovi koji su na 
istoj etaži, ali ne počinju od nulte kote. Na primjer, ukoliko je dnevni boravak od ostatka stana 
izdignut za nekoliko stepenika, onda će ti zidovi biti izdignuti od prizemlja za visinu stepenika. 
2. U ovom dijelu određuje se struktura zida. Kao što smo već pomenuli, zid po svojoj strukturi 
u ArchiCAD-u može biti osnovni (Basic), kompozitni (Composite) ili složeni (Complex). Nakon 
odabira strukture zida, u ovom dijelu padajućeg menija potrebno je definisati materijaliza-
ciju zida. U početnim postavkama ArchiCAD-a, zid koji se crta je generički19 konstruktivni 
zid, što znači da njegova metrijalizacija nije definisana (slika 4.5).

19	 Univerzalan.
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Slika 4.5. Spisak materijala za izradu zida

Odabir materijalizacije zida utiče na njegov grafički 
prikaz u osnovi i u 3D prikazu. Na slici 4.6 prikazan je 
zid s materijalizacijom Brick-Structural koji u osnovi 
ima šrafuru, a u 3D prikazu je zid od opeke.
3. U trećem dijelu menija određuje se pozicija referentne 
linije. Ona predstavlja osu po kojoj se crta zid u osnovi, 
i prikazana je debljom linijom u odnosu na ostale linije 
zida. Referentna linija za crtanje zida može biti postav-
ljena ka spolja (Outside face), ka unutra (Inside face) ili 
na sredini zida (Center) (slika 4.7). 

Slika 4.7. Prikaz pozicije referentne linije

Ako se crtaju zidovi po rasterima,20 bira se referentna linija po sredini. 

20	 Linije na crtežu koje označavaju osovinski razmak konstruktivnih elemenata objekta.

Slika 4.6. Brick Structural zid
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4. U četvrtom dijelu određuje se geometrija zida. U ArchiCAD-u se mogu nacrtati pravoli-
nijski, trapezoidni ili poligonalni zid. U ovom meniju takođe se određuje debljina zida, kao 
i ugao nagiba ukoliko je kosi zid. 

Pravolinijski zid crta se na isti način kao i linija (način crtanja linije objasnili smo u 
poglavlju 2.1. Crtanje linija).

Trapezoidni zid crta se tako što mu se zadaju početna i krajnja debljina zida, tako da u 
osnovi ima izgled trapeza. Nezavisno od dužine nacrtanog zida, ova dva parametra biće 
konstantna (slika 4.8).

Slika 4.8. Trapezoidni zid u osnovi

Poligonalni zid u ArchiCAD-u se koristi za kreiranje zidova sa nepravilnim ili složenim 
oblicima, što omogućava veću fleksibilnost u dizajnu. Ova vrsta zidova crta se kao polilinija 
koja se mora zatvoriti tako što se zadnja tačka polilinije spaja s prvom. 

Slika 4.9. Prikaz poligonalnog zida u osnovi i u 3D

Kosi zid se koristi u situacijama kada je potrebno kreirati nagibe i kose elemete. Najčešće 
se primjenjuje za formiranje potkrovlja, a ima primjenu i u pejzažnoj arhiteturi (kada može 
formirati terasaste strukture). Naravno, može se primjenjivati i kod uređenja enterijera za 
formiranje dinamičnih prostora. 
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Slika 4.10. Pojmovi kosog zida u osnovi

Kao što vam je već poznato, osnova nekog objekta je horizontalni presjek na visini 110 cm 
(to je visina u osnovnim postavkama ArchiCAD-a). Kosi zid takođe se presijeca na toj visini 
i vidljiv je samo dio koji je ispod linije presjeka. Ono što je iznad nije vidljivo, pa je zato 
grafički prikaz tog zida kraći (slika 4.11).

Slika 4.12. Prikaz izmjene dužine 
zida pod kosinom u osnovi

Slika 4.11. Prikaz zida pod kosinom 

Ukoliko treba vidjeti zid u punoj veličini u osnovi, potrebno je aktivirati opciju Projected 
with Overhead iz dijaloškog okvira podešavanja izgleda zida prikazanog na slici 4.15: 

Wall Default Settings > Floor Plan and Section > Floor Plan Display > Projected with Overhead. 
Kada je opcija aktivna, nacrtani zid biće prikazan u osnovi, tako što je dio iznad linije presjeka 
prikazan isprekidanom linijom (slika 4.12).

Slika 4.13. Prikaz kosog zida u 3D i u presjeku

Zid sa zakošenjem u oba pravca (Double Slanted) element je koji ima nagib u dva smjera, stva-
rajući složeni oblik. Takav dizajn može imati estetsku, konstruktivnu ili funkcionalnu svrhu.
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Na primjer, poboljšanje stabilnosti ili određeni vizuelni efekti na objektu mogu se izvesti 
uz pomoć ovakvog oblika zida.
Dvostruko zakošeni zidovi često se koriste u modernoj arhitekturi radi stvaranja dinamič-
nih i zanimljivih oblika. 
Za crtanje ovog tipa zida potrebno je podesiti parametre za oba ugla koja zid zaklapa s 
horizontalnom ravni, kao što je u primjeru datom na slici 4.14. Gornji ugao je nagib ka 
spolja, dok je donji ugao nagib ka unutra. 

Slika 4.14. Presjek dvostruko zakošenog zida s parametrima zakošenja

Drugi padajući meni jeste podešavanje grafičkog prikaza zida u osnovama i presjecima 

(Floor Plan and Section).

Slika 4.15. Meni podešavanja parametara prikaza zida u osnovi i presjecima
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1. Floor plan display – način prikazivanja zidova u osnovi. U dijelu Show on stories podešava 
se vidljivost elemenata na etažama. Floor Plan Display, koji smo pomenuli ranije, predstav-
lja podešavanja grafičkog prikaza elemenata u osnovi. Prikaz može biti: Projected (u tom 
slučaju prikazuju se samo linije ispod presjeka), Projected with Overhead (isprekidanom 
linijom prikazuju se i djelovi objekta koji su iznad linije presjeka) i Cut Only (kada su svi 
djelovi objekta prikazani punom linijom).
2. Cut Surfaces – meni za odabir boja i debljina linija za grafički prikaz zidova.
3. Outlines – meni za podešavanje načina grafičkog prikaza djelova koji su iznad linije 
presjeka i djelova objekta koji nijesu dio presjeka. Na slici 4.15 prikazana je veza svih ovih 
podešavanja s prikazom zida u osnovi.

Nacrtaj proizvoljni zid i istražuj opcije iz ovog padajućeg menija. Bilježi svoja 
zapažanja u odnosu na to kako izmjene utiču na prikaz zida.

Treći padajući meni jeste podešavanje materijalizacije zida u trodimenzionalnom prikazu 
(Model).

Slika 4.16. Padajući meni podešavanja materijalizacije zida

Materijalizacija zida može se podesiti prije crtanja ili na već nacrtanom zidu.
Override Surfaces je opcija koja se u ArchiCAD-u koristi za promjenu obloge zida bez 
obzira na njegova osnovna ili podrazumijevana svojstva. Kada kažemo osnovna svojstva, 
misli se na materijalizaciju koja je već zadata zidu, a koju smo objasnili kroz prvi padajući 
meni Geometry and Positioning, stav 2. Da bi se aktivirala ova opcija, potrebno je kliknuti 
na ikonice na kojima je slikovito prikazano na kojoj se strani zida mijenja materijalizacija. 
Klikom na polje pored otvara se širok spektar materijala koji se mogu primijeniti (slika 4.16).
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Slika 4.17. Prikaz materijalizacije zida s aktivnom opcijom Override Surface

U nastavku podešavanja su dvije opcije (End Surfaces i Align Texture to Wall Edges). One 
se koriste kako bi se kontrolisalo kako će se prikazivati završne obrade zidova i slagati u 
trodimenzionalnom prikazu.

Slika 4.18. Prikaz materijalizacije zidova u zavisnosti  
od aktivne opcije End Surfaces i Align Texture to Wall Edges
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Nakon podešavanja parametara u dijaloškom 
okviru, započinje se crtanje zidova. Zidovi se 
mogu postaviti u osnovi ili u trodimenzionalnim 
prikazima objekta. Metode geometrije i način 
postavljanja zidova identični su kao i za alat 
linije i kružnice koje smo objasnili kroz poglavlje 
2. Alati za 2D crtanje. 
Sa izabranim alatom Wall zid se postavlja klikom lijevog tastera miša na radnu površinu, 
i na taj način definiše se početna tačka zida. Povlačenjem kursora u bilo kom smjeru ili 
zadavanjem veličine u Trakeru definiše se njegova dužina. Sljedećim klikom lijevog tastera 
miša na radnu površinu završava se crtanje zida.

�Ukoliko se klikne i zadrži klik na jednu od prve dvije metode geometrije (Straight i Cur-
ved), otvara se polje s dodatnim mogućnostima crtanja pravih i zakrivljenih zidova. Sve 
metode iste su kao za liniju, poliliniju i kružnicu.

Nakon što je zid nacrtan, mogu se modifikovati sva njegova podešavanja. Osim nabrojenih 
podešavanja, mogu se koristiti komande za izmjene na zidovima iz Pet Palette. Ove komande 
razlikuju se u zavisnosti od tipa nacrtanog zida i čvora na zidu koji se izabere. Sve izmjene 
i načini odabira čvorova već su vam poznati iz prethodnih poglavlja.
Osim pomenutih izmjena, kod zida se jav-
lja mogućnost izdizanja početnog nivoa 
zida – Elevate. Odabirom ikonice Elevate 
iz Pet Palette otvara se novi prozor u koji 
treba unijeti numeričku vrijednost izdi-
zanja (slika 4.20).
Kada se izabere referentna linija zida, 
ponuđene su još dvije mogućnosti za 
izmjenu zida. Prva je opcija da se od rav-
nog zida napravi trapezoidni (slika 4.21).

Slika 4.21. Postupak formiranja trapezoidnog zida od ravnog 

Slika 4.19. Metode geometrije zida

Slika 4.20. Opcija Elevate



100 Elementi virtuelne zgrade

Da bi se od ravnog zida napravio trapezoidni, potrebno je aktivirati naznačenu ikonicu i 
dodati novu tačku bilo gdje na radnoj površini. Može se koristiti Tracker za unos udaljenosti 
ivice zida ili ručno razvući ugao trapeza. 
Druga opcija jeste dodavanje nove tačke za formiranje trapezoidnog zida. Treba napraviti 
razliku između opcija Insert new node gdje čitav zid prati novu tačku zadržavajući svoju 
debljinu, dok se dodavanjem tačke uz pomoć Insert new point pomjera samo jedna ivica 
zida formirajući poligonalni zid (slika 4.22).

Slika 4.22. Razlika između opcija Insert new node i Insert new point u osnovi

PROVJERI SVOJE ZNANJE

1.	 Koje se vrste zidova mogu kreirati u ArchiCAD-u?
2.	 Šta je Geometry Method (metoda geometrije)? Izaberi jednu i objasni njenu ulogu.
3.	 Objasni funkcije Linked i Not Linked kod crtanja zidova i navedi primjer u kojima 

se koriste.
4.	 Koje parametre definišemo opcijom Override Surface?
5.	 Nacrtaj poligonalni zid sa četiri segmenta. Svaki segment neka bude različite dužine 

(5 m, 3 m, 4 m i 2 m).
6.	 Nacrtaj osnovu kao na slici 4.23 i sačuvaj zadatak pod nazivom Osnova poslovnog 

prostora.

Slika 4.23. Osnova poslovnog prostora
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Otvori dokument Projektni zadatak_Stambeni objekat i nacrtaj zidove na 
osnovi prizemlja i sprata kao na primjeru koji se nalazi na kraju udžbenika, 
nakon poglavlja 8. Parametri su sljedeći:

	f Noseći zidovi – debljina: 25 cm; Building Material: Masonry Block Filler; Model: 
Override Surfaces: Stucco White Fine

	f Pregradni zidovi – debljina: 15 cm; Building Material: Gypsum Plasterboard; 
Model: Override.

4.1.2. Stubovi

Stubovi su vertikalni linijski konstruktivni elementi koji 
osim u konstruktivnom smislu imaju i značajnu estetsku 
ulogu. Takođe se mogu koristiti kao vizuelne barijere u 
prostoru. Kroz istoriju su stubovi bili nosioci arhitektonskog 
stila – od egipatske civilizacije, stilskih redova kao što su 
dorski, jonski i korintski u grčkoj arhitekturi, do savreme-
nog doba gdje stubovi u konstruktivnom smislu utiču na 
projektovanje objekata, oslobađajući osnove od zidova kao 
pregrada prostora i stvarajući jednoličan slobodan prostor 
koji je lakši za uređivanje.

�Trajanov stub u Rimu, iz II vijeka, mermerni je stub, visok 38 metara, a na stubu 
se nalazi reljef od 155 scena koje pripovijedaju o ratnim pohodima protiv 
Dačana.

Kod crtanja stubova važe ista pravila kao za crtanje zidova. Za početak je potrebno podesiti 
sve parametre u već poznatom dijaloškom okviru. Alat za crtanje stubova nalazi se u paleti 
alata ToolBox u dijelu Design. Dvostrukim klikom na ikonicu stuba otvara se dijaloški okvir 
za podešavanje parametara Column Default Settings. 

�Za sve alate iz ToolBox-a dijaloški okvir za podešavanja parametara ima iste padajuće 
menije. Oni se razlikuju u pojedinačnim slučajevima u odnosu na element koji se crta, 
ali su njihove cjeline podijeljene istim logičkim slijedom.

Dijaloški okvir podešavanja parametara stuba s lijeve strane sadrži spisak parametara, 
dok su sa desne strane prikazani padajući meniji koji pripadaju izabranim parametrima.
Prvi ponuđeni parametar sa spiska jeste „Stub“ (Column), koji sadrži informacije o dimen-
zijama stuba. Dimenzije poprečnog presjeka stuba mogu da budu povezane aktiviranjem 
zaokružene ikonice (slika 4.25) tako da se promjena jednog polja prenosi na drugo, kako 
bi stub uvijek imao kvadratni poprečni presjek. Ukoliko ova ikonica nije aktivna, onda 
svaki parametar može imati svoju vrijednost (može se napraviti pravougaoni poprečni 
presjek). 

Slika 4.24. Trajanov stub
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Slika 4.25. Ikonica za povezivanje dimenzija stuba

Sljedeći padajući meni u okviru parametra Column jeste pozicioniranje stuba (Positioning) 
koji ima istu ulogu kao i kod zidova. Posljednji iz ove grupe jeste meni za podešavanje ugla 
završetka stuba ukoliko je kosi stub i referentne tačke – End cuts and Reference Axis (slika 
4.26) u kojem se s lijeve strane podešava ugao završetka stuba na donjoj ili gornjoj ivici, 
dok se sa desne strane podešava referentna tačka stuba. Kod zidova smo objasnili ulogu 
referentne linije, a ista pravila važe i za tačku kod stuba. 

Slika 4.26. Podešavanje završetka stuba

Na listi parametara, drugi na spisku jeste Segment, u kom se definiše oblik stuba u osnovi 
i materijal od kog je izgrađen. Sva ostala podešavanja ista su kao što je objašnjeno kroz 
poglavlje 4.1.1. Zidovi.

Slika 4.27. Podešavanja parametra Segment 
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Nakon podešavanja izgleda i materijaliza-
cije na spisku je Floor Plan and Section, 
čija su podešavanja takođe ista kao kod 
zidova.
Ostale dvije opcije (Structural Analyti-
cal Parameters i Classification and 
Properties) tiču se naprednog poznavanja 
primjene BIM tehnologije i implementa-
cije u okviru ArchiCAD-a, pa ih za sada 
nećemo detaljnije objašnjavati.
Nakon podešavanja parametara u dijaloš-
kom okviru, započinje se crtanje stubova. 
Stubovi se, kao i zidovi, mogu postaviti u 
osnovi ili u trodimenzionalnom prikazu. 
Kao i u svim prethodnim poglavljima, uvi-
jek će se prvo podesiti metoda geometrije 
stuba iz InfoBox-a.
Prva metoda geometrije jeste postavljanje stuba kao tačkastog elementa. U zavisnosti od 
toga gdje je postavljena referentna tačka, tako će se pri postavljanju na radnu površinu 
prikazati nacrtani stub.
Druga metoda geometrije jeste stub pod uglom. 

POZICIONIRANJE STUBA POD UGLOM (slika 4.30)
Korak 1: U InfoBox-u za Geometry Method izaberi Two Clicks.

Korak 2: Prvim klikom lijevog tastera miša na radnu površinu zadaješ početnu tačku 
stuba.
Korak 3: Pomjeranjem kursora u željenom pravcu definišeš dužinu koju taj stub zau-
zima i ugao pod kojim je nagnut (Slant Angle). Ove parametre unosiš preko Trakera.

Slika 4.30. Zadavanje tačaka udaljenosti početka i kraja stuba

Korak 4: Klikom na lijevi taster miša završavaš crtanje stuba. Ovakav stub se, isto 
kao i kosi zid, ne vidi u osnovi u cjelini, osim u slučaju da je to podešeno u meniju 
Floor Plan Display.

Slika 4.31. Prikaz stuba s aktivnim opcijama prikaza na ekranu

Slika 4.28. Metoda geometrije  
stuba u InfoBox-u

Slika 4.29. Izgled stuba u osnovi
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Treća metoda geometrije jeste postavljanje zarotiranog stuba u osnovi. Rotacija se postiže tako 
što se referentna tačka stuba prvo postavi klikom lijevog tastera miša na radnu površinu, a 
zatim se kursor pomjera u željenom pravcu kako bi se odredio ugao pod kojim se stub u osnovi 
rotira. Kada je to određeno, crtanje stuba završava se još jednim klikom na lijevi taster miša. 
Ukoliko se izabere već nacrtani stub, a zatim klikne na neki od njegovih čvorova, aktivira se 
Pet Palette koja sadrži iste mogućnosti izmjene koje su pomenute u prethodnim poglavljima 
(pomjeranje, rotacija, osno preslikavanje, elevacija stuba i dr.). Pored ovih, pojavljuju se i 
neke nove mogućnosti izmjene u zavisnosti od vrste stuba koji se modifikuje. 
Stub kao tačkasti element pri aktivaciji Pet Palette može se modifikovati na sljedeće načine: 

1.	 rotacija u odnosu na referentnu tačku
2.	 simetrična promjena dužine stuba u odnosu na referentnu tačku
3.	 promjena dužine stuba u jednom pravcu u odnosu na referentnu tačku
4.	 simetrična promjena širine stuba u odnosu na referentnu tačku
5.	 promjena širine stuba u jednom pravcu u odnosu na referentnu tačku. 

Slika 4.32. Komande za izmjene stuba iz Pet Palette

PROVJERI SVOJE ZNANJE

1.	 Kada se koristi metoda geometrije stuba iz dvije tačke?
2.	 Kako se može promijeniti prikaz stubova u osnovi i u presjecima koristeći postavke 

Floor Plan and Section Display?
3.	 Koje su mogućnosti dostupne za podešavanje završetka stuba i referentne ose koristeći 

opcije End Cuts and Reference Axis?
4.	 Navedi metode geometrije koji se mogu koristiti prilikom crtanja stubova u Archi-

CAD-u. Kako se primjenjuju?
5.	 Koje su opcije dostupne u Pet Palette kada se modifikuju stubovi?
6.	 Izaberi jednu od mogućnosti izmjene na stubovima iz Pet Palette i opiši je.
7.	 Nacrtaj mrežu rastera koristeći stečeno znanje iz poglavlja 2.1. Crtanje linija, a zatim 

na presjeku rastera nacrtaj stubove dimenzije 30 cm x 30 cm tako da referentna tačka 
bude u sredini stuba, kao na primjeru. Vježbu sačuvaj pod nazivom Stubovi.
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Slika 4.33. Primjer prikaza stubova u osnovi 

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta, na osnovama postavi stubove. Njihova pozicija naznačena 

ti je u projektnom zadatku. Parametri su sljedeći:
	f dimenzije 25 cm x 25 cm 
	f Building Material: Concrete

	f Model: Override Surfaces: Stucco White Fine

	f Floor Plan Symbol Type: X.

4.1.3. Grede

Grede su horizontalni linijski konstruktivni elementi koji imaju značajnu ulogu u strukturi, 
odnosno nosivosti i stabilnosti objekta. Njihova je osnovna funkcija prenošenje opterećenja 
s gornjih djelova konstrukcije na stubove ili zidove ispod greda, odnosno na grede drugog 
pravca. Osim toga, grede pružaju potporu podovima, krovovima, terasama i drugim kon-
struktivnim i nekonstruktivnim elementima. 

Arhitravni sistem (dva stuba s 
ravnom gredom) konstruktivni 

je sistem koji se javlja još u praistoriji. 
Ovaj sistem uočen je na praistorijskim 
kultnim objektima (triliti21) ali i grob-
nicama (dolmeni22).
U azijskoj arhitekturi drveni arhi-
travni sistem korišćen je tamo gdje 
je postojala potreba da se pod izdigne 
od tla radi zaštite pirinča od štetočina. 

21	 �Kultna obilježja sastavljena od dva vertikalna i jednog horizontalno postavljenog kamena, koji je za 
vertikalne učvršćen klinovima.

22	� Velike grobnice, površine do 70 metara kvadratnih, koje se sastoje od pristupnog hodnika i grobnog 
prostora.

Slika 4.34. Arhitravni sistem
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Takođe, veza između grede i stuba minimalistički je dekorativni izraz u skladu sa 
zen budizmom.
Civilizacija starog Egipta nije bila bogata drvetom, pa je arhitektura u kamenu doži-
vjela procvat. Kasnije Grci od Egipćana preuzimaju vještinu građenja u kamenu, pa 
se javlja i arhitrav – greda kod grčkih stilskih redova.
Uz tehnološke inovacije i nove materijale, greda je u savremenom dobu dobila jednu 
od glavnih uloga u konstruktivnom sistemu, premošćavajući velike raspone uz ogro-
mnu nosivost.

Podešavanja parametara i način crtanja greda i stubova skoro su identični. Postoje neke 
opcije koje se razlikuju, pa ćemo u ovom poglavlju objasniti samo njih.

Slika 4.35. Dijaloški okvir podešavanja parametara grede

Alat za crtanje greda (Beam) nalazi se u ToolBox-u s lijeve strane radne površine u dijelu 
Design. Dvostrukim klikom na ikonicu grede otvara se već poznati dijaloški okvir, u ovom 
slučaju Beam Default Settings. 
Ono što se u ovom dijaloškom okviru razlikuje u odnosu na stubove jeste kolona Hole. Ona 
služi za umetanje šupljine u poprečni presjek grede koja može biti kvadratnog, pravouga-
onog ili kružnog oblika. Ova opcija može da se koristi kod crtanja čeličnih profila.

Slika 4.36. Definisanje šupljine u poprečnom presjeku grede
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Kada su svi parametri podešeni, može se krenuti u crtanje grede. U InfoBox-u meni Geometry 
Method nudi iste opcije s kojima ste već upoznati kroz prethodna poglavlja.

Slika 4.37. Metode geometrije grede

Postupci postavljanja grede na radnu površinu identični su kao i za crtanje pravolinijskog 
zida. Prvim klikom lijevog tastera miša definiše se početna tačka grede na radnoj površini, 
a drugim se završava. Kada se nacrta greda, ona je prikazana isprekidanim linijama. Kao 
što smo pomenuli kod zidova i stubova, sve što se nalazi iznad linije presjeka prikazano 
je isprekidanim linijama. Samim tim i grede, s obzirom na to da se one nalaze iznad linije 
presjeka.

Slika 4.38. Prikaz grede u osnovi

PROVJERI SVOJE ZNANJE

1.	 Šta su grede, i koja je njihova osnovna funkcija u konstrukciji?
2.	 Koje su osnovne opcije za crtanje greda koje se razlikuju od crtanja stubova?
3.	 Šta predstavlja kolona Hole u dijaloškom okviru Beam Default Settings?
4.	 Zašto su nacrtane grede prikazane isprekidanim linijama?
5.	 Otvori zadatak Stubovi koji ste radili u prethodnom poglavlju i na već postojećoj 

mreži docrtaj grede kvadratnog poprečnog presjeka, dimenzija 25 cm x 25 cm.

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta, na osnovama postavi grede. Njihova pozicija naznačena 

ti je u projektnom zadatku. Parametri su sljedeći:
	f dimenzije su 25 cm x 25 cm 
	f Building Material: Concrete

	f Model: Override Surfaces: Stucco White Fine.
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4.1.4. Ploče

Ploče su horizontalni površinski 
konstruktivni elementi koji prenose 
opterećenje na stubove, zidove i 
grede, obezbjeđujući nosivost i sta-
bilnost konstrukcije objekta. One 
mogu doprinijeti estetici prostora 
kroz izbor materijala konačne 
obloge. Ploča je element s dvostru-
kom funkcijom: jedna njena povr-
šina ima ulogu poda, dok druga ima 
ulogu plafona. Ploče su značajne i 
kod formiranju krovova i potkrovlja, 
između ostalog kao zvučni i termički 
izolator od spoljašnjih uticaja.
Alat za crtanje ploča (Slab) nalazi 
se u ToolBox-u s lijeve strane radne 
površine u dijelu Design. Dvostrukim 
klikom na ikonicu ploče otvara se 
već poznat dijaloški okvir, u ovom 
slučaju Slab Default Settings (slika 
4.39). Podešavanja su ista kao i 
kod ostalih elemenata osim što se 
umjesto visine elemenata podešava 
debljina ploče. 

�Ploču treba uvijek vezati za 
donju kotu etaže na kojoj se 
crta. 

Kao i kod zidova, postoji mogućnost crtanja osnovne (Basic) i kompozitne ploče (Composite).

Sva ostala podešavanja ista su kao što smo ih do sada objašnjavali. Istraži ih 
i zabilježi svoja zapažanja.

Kod crtanja ploče u Geometry Method u InfoBox-u date su mogućnosti crtanja ploče preko 
poligona ili pravougaonika. O načinu crtanja poligona bilo je riječi u poglavlju 2.1. Crtanje 
linija i 2.2. Crtanje polilinija i lančanih linija. 
Komande za uređivanje ploče u Pet Palette isti su kao i kod svih elemenata koje smo do sada 
pominjali. U poglavlju 3.4. Izmjena veličina elemenata (Modify element size) na primjeru 
ploče objasnili smo funkciju i način korišćenja svih komandi za izmjene na elementima.

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta, na osnovama prizemlja i sprata dodaj ploče debljine 15 

cm. Materijalizaciju ploča prilagodi njihovoj poziciji u objektu.

Slika 4.39. Dijaloški okvir za podešavanja  
parametara ploče
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4.1.5. Krov

Osnovna funkcija krova jeste da pruži zaštitu od padavina, vjetra, sunca i drugih vre-
menskih uticaja. Krovovi se sastoje od krovne konstrukcije i krovnog pokrivača. Krovna 
konstrukcija prima i prenosi opterećenja od krovnog pokrivača, sopstvene težine, snijega, 
vjetra i drugih padavina na donje konstruktivne elemente objekta. Oblik krova definiše se 
u zavisnosti od podneblja za koje se objekat projektuje. Njihova uloga takođe je značajna 
kod ventilacije i toplotne izolacije. U vrijeme energetske efikasnosti, krovovi su postali 
nosači solarnih panela integrisanih u krovni pokrivač. Pravilno održavanje krova diktira 
dugoročnost nekog objekta.

Slika 4.40. Dijaloški okvir za podešavanje parametara krova

Alat za crtanje krova (Roof) nalazi se u ToolBox-u s lijeve strane radne površine u dijelu 
Design. Dvostrukim klikom na ikonicu krova otvara se već poznat dijaloški okvir, u ovom 
slučaju Roof Default Settings koji sadrži padajuće menije za podešavanje parametara (slika 
4.40). U prvom padajućem meniju podešavaju se geometrija i pozicija krova (kao i kod 
zidova), i sadrži sljedeće cjeline:

1.	 Definisanje visine na kojoj se krovna ravan spaja sa zidom etaže ispod
2.	 Podešavanje konstrukcije krovne ploče i njene debljine
3.	 Podešavanje geometrije krova (Može biti jednovodni, dvovodni ili viševodni krov. U 

ovom dijelu se podešava i nagib krova.). 
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Podjela krovova prema broju krovnih ravni:
Jednovodni krovovi imaju samo jednu krovnu ravan, koja omogućava da 

voda otiče s krova u jednom smjeru. Ti krovovi su jednostavni za izgradnju i često se 
koriste na manjim objektima. Međutim, na prostorima gdje nema velikih padavina 
ova vrsta krova takođe se često primjenjuje na većim objektima.
Dvovodni krovovi imaju dvije krovne ravni, koje omogućavaju vodi da otiče s krova u 
dva smjera. Ti krovovi su česti u tradicionalnoj arhitekturi i mogu se naći na kućama, 
stambenim zgradama i mnogim drugim vrstama objekata.
Viševodni (složeni) krovovi imaju tri ili više krovnih ravni. Ti krovovi su često 
složeniji u dizajnu i zahtijevaju pažljivo planiranje i konstrukciju. Oni se koriste kod 
objekata koji zahtijevaju visok nivo estetike, kao što su dvorci ili neke luksuzne vile.

Ako se u podešavanjima izabere složeni krov, otvara se i padajući meni Multi-plane Geo-
metry (slika 4.41).

Slika 4.41. Podešavanja složenog krova

1.	 Podešavanje nagiba krova i visine u odnosu na nultu kotu etaže na kojoj se crta
2.	 Definisanje dužine nastrešnice
3.	 Parametar kojim se podešava stepen detaljnosti izvođenja zakrivljenih površina (Što 

je broj veći, zakrivljeni djelovi krova biće detaljniji i glatki. Ako je krivulja glatka, to 
znači da nema oštrih uglova ili prekida u njenom obliku.). 

U ArchiCAD-u postoje tri metode konstrukcije krova (Construction Method):

Slika 4.42. Ikonice metode konstrukcije složenog krova

1. Složeni krov 
Crta se kao poligon, prateći linije postojeće osnove. ArchiCAD automatski rješava komplek-
sne krovove, tj. položaj krovnih ravni.
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Slika 4.43. Prikaz složenog krova u 3D prikazu i osnovi

2. Pravougaoni krov

Slika 4.44. Ikonice metode konstrukcije pravougaonog krova

Kod ove metode konstruisanja krova ponuđene su dvije vrste krova: dvovodni i četvoro-
vodni. Odabiru jedne od ovih opcija pristupa se pritiskom na ikonicu naznačenu na slici 4.44.

Slika 4.45. Osnova četvorovodnog i dvovodnog krova

3. Pravougaoni krov pod uglom 
Identičan je s prethodnim krovom, osim što, kao i kod crtanja pravougaonika, ima moguć-
nost postavljanja pod određenim uglom u osnovi.

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta nacrtaj krov sa sljedećim parametrima:

	f dvovodni krov
	f Basic Structure

	f Building Material: Timer Roof

	f ugao kosine krova 12°, prepust 100 cm.
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4.2. Stepenište 

Uloga stepenica u objektu je višestruka, obuhvatajući funkcionalne, sigurnosne i estet-
ske aspekte koji su ključni za doživljaj prostora i udobnosti korisnika. Primarna svrha 
stepenica jeste da obezbijedi jednostavan i lak način kretanja između nivoa. Crtanje 
stepenica u ArchiCAD-u ima sličnosti i razlike u odnosu na crtanje na papiru. Međutim, 
u oba slučaja mora se prvo znati način na koji se vrši proračun i kako utiče na konačan 
izgled i funkcionalnost.

�Da jasnije razumijete crtanje stepenica u ArchiCAD-u, prvo se upoznajte sa 
osnovnim pojmovima – djelovima stepenica i načinom na koji se konstruišu 
(slika 4.46).

Slika 4.46. Djelovi stepenica, pojmovi

Proračun stepenica
Obrazac za proračun dimenzija stepenica: 2h + b = 61 − 65 cm

Primjer za spratnu visinu H = 300 cm 
optimalna visina stepenika = 17 cm

Da bi se dobio optimalan broj stepenika za premošćavanje visine:

proračun 1:  
spratna visina

visine stepenika
 = 

300
17

 = 17,64, 	   usvaja se 18 stepenika

Da bi se dobila optimalna visina stepenika:

proračun 2:  
spratna visina

usvojeni broj stepenika
 = 

306
18

 = 16,67,	   usvaja se visina 16,67 cm

Obrazac za proračun dimenzija stepenica: 
2 × 17 + b = 63;	 b = 63 – 34;	 b = 29 		   	  usvaja se b = 29 cm

dužina kraka dvokrakih stepenica: 9 × 16,67 / 29
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Alat za crtanje stepenica u ArchiCAD-u nalazi se u paleti alata Design s lijeve strane radne 
površine (slika 4.47).

Slika 4.47. Izgled dijaloškog okvira za podešavanje stepenica

Postavke stepenica: geometrija i pozicioniranje

Slika 4.48. Podešavanja povezanosti stepenica sa spratom

Sa lijeve strane dijaloškog okvira nalaze se informacije o povezanosti stepenica s prizemljem 
(Home Story) i spratom (Top Link) (slika 4.48).
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Ako se kasnije izmijeni spratna visina u projektu, visine svih povezanih stepe-
nica automatski će se izmijeniti ukoliko promjena i dalje dozvoljava stepenicama 

da slijede pravila i standarde. Ako postoji greška, ona će se pojaviti na ekranu kao 
upozorenje da je potrebno promijeniti parametre stepenica, kako bi one mogle biti 
nacrtane (slika 4.49).

Slika 4.49. Prijava greške usljed promjena na projektu

Opcija Top Link-Not Linked (Nije povezano sa spratom) koristi se kada treba napraviti 
stepenice koje ne zavise od spratne visine. Kao na primjer, ukoliko je kuća izdignuta za 
90 cm od tla, za ulazak treba predvidjeti par stepenika koji nijesu vezani za etažu.

Slika 4.50. Podešavanje djelova stepenica

Postavke gazišta/visine stepenika zavise od parametara postavljenih u Pravilima i standar-
dima (Rules and Standards) (slika 4.50).
1. Stair Width – unos vrijednost za širinu kraka. 
2. Broj stepenika – dostupan broj stepenika zavisi od raspona koji su postavljeni u panelu 
Pravila i standardi i od definisane visine stepenika.
3. Visina stepenika – dostupne vrijednosti zavise od raspona koji su postavljeni u panelu 
Pravila i standardi i od definisane širine gazišta.
4. Gazište (Going) može biti podešeno kao fleksibilno (ArchiCAD će automatski definisati 
vrijednost na osnovu unosa geometrije i raspona u panelu Pravila i standardi) ili fiksno 
(unos fiksne vrijednost za širinu gazišta koja se neće promijeniti ali će svi ostali parametri 
biti definisani iz tog pravila).
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Jedna od opcija podešavanja jeste i odabir početka odnosno završetka kraka. Ono može 
biti izabrano da bude kao gazište ili visina stepenika. Na slikama 4.51 i 4.52 prikazana je 
razlika u odabiru ovih dviju opcija u trodimenzionalnom prikazu.

Slika 4.51. Izgled stepenica ako je izabrana opcija započinjanja sa gazištem 

Slika 4.52. Izgled stepenica ako je izabrana opcija započinjanja s visinom

Preko Stair Baseline definiše se linija hoda i istovremeno način na koji se crtaju stepenice 
(slika 4.53).

Slika 4.53. Odabir pozicije hodne linije
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Konstrukcija stepenica:
Stepenice se mogu konstruisati na različite načine u zavisnosti od oblika osnove stepeniš- 
nog prostora i mogućnosti formiranja nosećih elemenata. Razlikujemo četiri osnovna tipa 
stepenica prema vrsti glavnih nosećih elemenata (slika 4.54):

Slika 4.54. Podešavanja konstrukcije stepenica

Kroz folder Structure podešava se konstrukcija stepenica i to posebno za krak stepenica a 
posebno za odmorište.
1. Monolithic: Monolitne stepenice/masivne, izrađene iz jednog komada 
2. Beam: Stepenice koje se oslanjaju na jednu ili više greda
3. Cantilevered: Konzolne stepenice koje imaju oslonac u zidu. Svaki stepenik je na jednom 
kraju vezan za konstrukciju a drugi je slobodan.
4. Stringers Only: Stepenice sa bočnim nosačima

Slika 4.55. Izgled stepenica u zavisnosti od odabira konstrukcije
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Završne obrade gazišta i visina
U postavkama stepenica u folderu Finish (završna obrada), selektovanjem ček-boksa Finish 
zadaje se završna obrada za gazište i visinu stepenika (slika 4.56). U slučaju da ovo polje 
nije označeno, stepenice neće imati završnu obradu. 

Slika 4.56. Podešavanje materijalizacije završne obrade stepenika

CRTANJE STEPENICA BEZ GORNJE VEZE (Top link-Not Linked)

Otvori dijaloški okvir Stair settings i pregledaj postavke geometrije i pozi-
cioniranja.
Stepenice nijesu povezane s gornjim spratom i imaju fiksni broj – 7 stepenika. To će 
biti jednokrake stepenice, tako da tip podesta (Structure-Landing) nije relevantan.

Slika 4.57. Dijaloški okvir podešavanja stepenica koje nemaju vezu s gornjim spratom
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U osnovi ili 3D prozoru:
Korak 1: Postavi kursor na željenu poziciju u projektu i pritisni lijevi taster miša na 
radnu površinu da započneš unos stepenica (slika 4.58).

Slika 4.58. Izgled stepenica u toku crtanja

Korak 2: Obrati pažnju na povratnu informaciju: Pošto je broj stepenika fiksan, tokom 
unosa dužina stepenica prikazana je kao obris.
Korak 3: Dvaput klikni da završiš stepenice.

CRTANJE STEPENICA SA GORNJOM VEZOM (Top link-1. Story)

Na ovaj način stvaraš unutrašnje stepenice do sljedećeg sprata.
Podesi postavke stepenica kao što je prikazano. Vrh stepenica povezan je sa spra-
tom iznad i ima fiksni broj – 18 stepenika. Ove stepenice imaće podest, a tip podesta 
postavljen je na automatsko.

Slika 4.59. Postavke stepenica prema vježbi
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U osnovi ili 3D prozoru:
Korak 1: Klikni na radnu površinu da započneš unos stepenica duž zidova, kao kod 
crtanja polilinije.
Korak 2: Klikni na svaki od dva ugla zida, a zatim dvaput klikni da završiš stepenice 
(slika 4.60). 

Slika 4.60. Postupak crtanja trokrakih stepenica u osnovi

Slika 4.61. Konačan izgled modela stepenica

Djelovi stepenica mogu se prilikom crtanja definisati kao krak, podest ili jedan od dva tipa 
međupodesta. Na samom početku crtanja stepenica, podrazumijevani dio koji se crta uvijek 
je Flight (krak). Tip segmenta može se promijeniti u toku crtanja korišćenjem opcije iz Pet 
Palette. Svakom narednom segmentu možete promijeniti tip. 

CRTANJE DVOKRAKIH STEPENICA (slika 4.62) 
Korak 1: Klikni za početak postavljanja prvog segmenta stepenica: Pet Palette 

pokazuje da je trenutni tip segmenta postavljen na crtanje kraka (Flight).
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Korak 2: Klikni još jednom da završiš segment kraka.
Korak 3: Dok prevlačiš kursor za unos sljedećeg segmenta, odaberi međupodest 
(Landing) iz Pet Palette.
Korak 4: Klikni da završiš segment za međupodest.
Korak 5: Dok prevlačiš kursor za unos sljedećeg i posljednjeg segmenta stepenica, 
odaberi opet crtanje kraka (Flight) iz Pet Palette.
Korak 6: Još jednim klikom završavaš crtanje stepenica.

Slika 4.62. Postupak crtanja dvokrakih stepenica u osnovi

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta nacrtaj stepenice prema zadatim parametrima.

4.3. Podešavanja svojstava otvora u zidovima

Kao što su i u stvarnosti prozori i vrata ugrađeni u otvore u zidu, tako se ni u ArchiCAD-u 
ne može nacrtati otvor a da se prethodno ne definiše zid na kom će se oni nalaziti. Postoje 
dva načina za pristupanje podešavanjima otvora:

	y selektovanjem ikonice vrata ili prozora iz palete Design ili
	y ukoliko već postoji nacrtan otvor kojem treba izmijeniti neke parametre: lijevim 

tasterom miša izabere se željeni otvor a zatim desnim tasterom miša otvori meni 
s opcijama i izabere se Window Selection Settings (slika 4.63). 



1214.3. Podešavanja svojstava otvora u zidovima

Slika 4.63. Način aktiviranja dijaloškog okvira podešavanja otvora 

Nakon odabira alata, prvim pritiskom lijevog tastera miša za postavljanje vrata ili prozora 
određuju se sidro (Anchor Point) i referenca spoljašnjosti u odnosu na otvor (poziciju sunca). 

Kod crtanja vrata, postoji i korak u kom se sljedećim pritiskom lijevog tastera miša 
definiše orijentacija otvaranja.

Slika 4.64. Ikonice u InfoBox-u kojima se određuje pozicija sidra

Sidra (slika 4.64) pomažu u odre-
đivanju pozicije otvora. Centralno 
sidro postavlja se ukoliko se prozor 
nalazi npr. na sredini između dva 
zida, i značajno je da se postavi na 
tačnu lokaciju. Sidro na uglovima 
postavlja se kada se prozor ili vrata 
nalaze blizu ukrštanja zida (slika 
4.65).

Slika 4.65. Postupak postavljanja prozora u odnosu 
na poziciju sidra
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Slika 4.66. Dijaloški okvir za podešavanje otvora s objašnjenjima pojmova

Aktiviraj alat za crtanje prozora. Istražuj biblioteku (tipove prozora) i bilježi 
svoja zapažanja. 

1) Padajući meni: Pregled i način pozicioniranja (Preview and positioning)

Slika 4.67. Dijaloški okvir Prewiev and Positioning s pojašnjenjem pojmova
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2) Padajući meni: Osnovna podešavanja (Basic Window settings)

�Aktiviraj alat za crtanje prozora, izaberi jedan od ponuđenih oblika s liste. 
U podešavanjima klikni padajući meni Basic Window Settings. Istražuj sve 
mogućnosti i zabilježi svoja zapažanja.

Slika 4.68. Dijalog za podešavanje parametara otvora

3) Padajući meni: Način predstavljanja u osnovi i presjeku (Floor plan and section)

U ovom segmentu definiše se tip linije i boje kojima će biti predstavljen prozor u osnovi i 
na presjeku (slika 4.69).

Slika 4.69. Podešavanje načina prikaza otvora u osnovi
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4 i 5) Padajući meni: Tip, boja i veličina kote i font i boja kotnog teksta (Dimension 
marker i Market text style)

U ova dva segmenta definiše se boja, veličina i font oznake/kote za prozor ili vrata (slika 
4.70). O važnosti i načinu kotiranja više će riječi biti u poglavlju 6.1.2 Način kotiranja, pa će 
vam i ova podešavanja parametara biti jasnija nakon savladavanja tog poglavlja.

Slika 4.70. Podešavanje izgleda kote otvora u osnovi

6) Padajući meni: Izgled i pozicija kote (Marker symbol and text)

U ovom dijaloškom okviru definiše se izgled, pozicija, orijentacija i način upisivanja dimen-
zija i podataka oznake za otvor (slika 4.71).

Slika 4.71. Podešavanje izgleda kote otvora u osnovi

�Kada je o podešavanjima za vrata riječ, proces je vrlo sličan i sadrži iste parametre i 
svojstva, pa ukoliko ste savladali crtanje i pozicioniranje prozora, vrata možete na isti 
način sami nacrtati i definisati.
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PROVJERI SVOJE ZNANJE

1.	 Objasni na koji način pozicioniranje sidra utiče na crtanje u osnovi.
2.	 Otvori dijaloški okvir za podešavanje otvora i opiši njegov sadržaj.
3.	 Na koji način postavljaš kote otvora u osnovi?
4.	 Otvori novi dokument i nacrtaj zid kvadratnog oblika dimenzija 6 m x 6 m. Koristeći 

se alatom Set User Origin nacrtaj dvokrilni prozor udaljen 2 m od unutrašnjosti zida s 
parapetom od 90 cm. Na istom zidu, s udaljenošću 4 m od spoljašnje ivice zida, nacrtaj 
vrata proizvoljnih dimenzija.

5.	 Otvori zadatak Osnova poslovnog prostora i na njemu docrtaj vrata i prozore s 
dimenzijama i pozicijama kao na slici 4.72.

Slika 4.72. Zadatak 5: Prozori i vrata

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta nacrtaj vrata i prozore kao što je dato na crtežu osnove. 

Na osnovi je zadata širina prozora; vrstu, visinu, parapet i materijalizaciju definiši 
proizvoljno.

4.4. Postavljanje objekata 

Objekti (Libraries/Smart Objects) u ArchiCAD-u koriste se za širok spektar namjena, uklju-
čujući 3D konstruktivne komponente, opremu, namještaj, okruženje i pejzažno uređenje. 
Oni takođe mogu biti samo 2D elementi i koristiti se za obilježavanje djelova projekta. 
Svaka verzija ArchiCAD-a u sebi sadrži standardnu biblioteku s velikim brojem unaprijed 
konfigurisanih objekata. Dijaloški okvir za podešavanja objekta podijeljen je na sekcije: 
na lijevoj strani su alati za pretraživanje i odabir djelova biblioteka, na desnoj strani su 
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postavke za odabrani objekat. Većina osnovnih parametara za postavljanje podešava se 
na isti način. U ovom poglavlju objasnićemo kako se postavlja jedan objekat, a na vama je 
da dalje istražujete bezbroj mogućnosti koje nudi ova paleta. 
Kada se započinje novi projekat, ArchiCAD će učitati biblioteku sadržanu u postavkama 
radnog okruženja koji se koristi za novi projekat (Embeded Library).
Svi objekti su parametarski. To znači da im možete konfigurisati sve parametre, koristeći 
dijaloški okvir Object Settings.

POSTAVLJANJE OBJEKATA

Korak 1: Selektuj ikonicu za biblioteke Objects u ToolBox-u i otvori dijaloški 
okvir njegovih postavki.
Korak 2: Potraži odgovarajući element u dostupnim folderima biblioteka.
Korak 3: Podesi parametre objekta tako da odgovaraju konkretnom projektu.
Korak 4: Klikni na željenu lokaciju na projektu i postavi prilagođeni objekat.

Objekti se mogu postaviti u prozoru presjeka/izgleda, ali tada predstavljaju samo 2D 
elemente (ne generiše se odgovarajući 3D model).

Svaki objekat će imati nešto drugačije postavke, ali će one uvijek biti grupisane na isti način 
i imati logički slijed (slika 4.73):

	y Preview and Positioning 
(Pregled i pozicioniranje) – 
ukupne dimenzije, lokacija 
i orijentacija

	y Settings (Postavke) 
– detaljne opcije 
konfiguracije, koje se 
često postavljaju pomoću 
grafičkih vodiča i iskačućih 
menija

	y Floor plan and Section 
(Izgled objekta u osnovi 
i presjeku) – postavke za 
simboličko predstavljanje i 
vidljivost

	y Model (Materijalizacija) 
– odabir materijalizacije 
pojedinačnih djelova 
izabranog objekta 
biblioteke

	y Clasification and 
Properties (Klasifikacija 
i svojstva) – informacije 
značajne za izvođenje i 
rekonstrukciju

Slika 4.73. Izgled dijaloškog okvira za podešavanje  
objekata – djelova biblioteke
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Parametri objekta (slika 4.74)

Slika 4.74. Osnovni parametri objekata

1.	 Podešavanje dimenzija

U ovom dijelu podešava se visinska kota objekta i njegove dimenzije. Za određene 
objekte može se podesiti visina, a za neke (kao što je prikazano zasjenčeno sivom 
bojom na slici 4.74) visina je definisana podešavanjima ArchiCAD-a i nije izmjenjiva.

2.	 Placement Anchor

Primarna tačka (sidro za postavljanje objekta na crtež) može se definisati u dijaloškom 
okviru za pregled i pozicioniranje u postavkama objekata. Prije postavljanja objekta 
treba provjeriti da li odabrana tačka odgovara kao sidro. 

Podešavanja objekta: 2D i 3D prikaz (slika 4.75)

Slika 4.75. Podešavanja načina prikazivanja objekta u osnovi

Podrazumijevano, objekti koriste postavke nivoa detalja definisane u opcijama prikaza 
modela (By MVO – Model View Options). Za određeni objekat, ako je kontrola dostupna, 
nivo detalja može se podesiti u postavkama elementa (slika 4.76).
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Slika 4.76. Razlika u načinu prikaza u osnovi u zavisnosti od odabira detalja

3D nivo detalja
Tamo gdje je dostupna, ova kontrola omogućava da umjesto postavki zasnovanih na MVO, 
za objekt postavite nivo detalja: šematski, pojednostavljeno ili potpuno.
Ako se izabere „Isključeno“ (Off), objekat se neće prikazati u 3D. 

Slika 4.77. Razlika u načinu prikaza u 3D u zavisnosti od odabira detalja

Osim načina prikaza u 2D i 3D prozoru, podešava se i materijalizacija objekata. Spisak 
mogućih izmjena materijala mijenja se u zavisnosti od tipa objekta i elemenata od kojih 
je on sačinjen.

PROVJERI SVOJE ZNANJE

1.	 Koje su glavne namjene objekata (Libraries/Smart Objects) u ArchiCAD-u?
2.	 Objasni organizaciju dijaloškog okvira za podešavanje parametara objekata.
3.	 Opiši razliku u prikazivanju objekata u osnovi u zavisnosti od nivoa detalja koji je 

definisan.
4.	 Na koji način možeš promijeniti boju prikazivanja objekata u osnovi?
5.	 Šta je Placement Anchor, i kako se koristi prilikom postavljanja objekta?
6.	 Otvori novi dokument i nacrtaj dnevni boravak dimenzija 5 m × 5 m. Istraži biblio-

teku objekata i po svom izboru opremi prostoriju (ugaona garnitura / TDF, klub-sto, 
TV komoda...).

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta nacrtaj djelove biblioteka onako kako ti je zadato. Povedi 

računa o materijalizaciji svih elemenata s obzirom na to da ćeš objekat prikazivati 
i u 3D.
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SAŽETAK POGLAVLJA

	f Poglavlje „Elementi virtuelne zgrade“ detaljno objašnjava ulogu i značaj konstruktivnih 
elemenata u procesu projektovanja. Ovo poglavlje obuhvata sve elemente objekta. 

	f Zidovi su vertikalni površinski konstruktivni elementi. U poglavlju su objašnjeni različiti 
parametri za podešavanje zidova. Pojašnjen je način podešavanja dimenzije zida prema 
projektantskim zahtjevima, kao i različite metode crtanja (pravolinijski, zakrivljeni i 
poligonalni zidovi).

	f Stubovi su vertikalni linijski konstruktivni elementi koji prenose opterećenje s greda i 
ploča na temelje. Detaljno su objašnjeni sljedeći parametri: podešavanje visine i širine 
stubova, izbor materijala za stubove i precizno postavljanje stubova unutar strukture 
objekta.

	f Grede su horizontalni linijski konstruktivni elementi koji prenose opterećenje s ploča na 
stubove. Parametri podešavanja greda uključuju: odabir oblika i veličine profila greda, 
definisanje materijala za grede i metode postavljanja greda u odnosu na zidove i stubove.

	f Ploče su horizontalni površinski konstruktivni elementi koji formiraju podove i plafone. 
Parametri podešavanja ploča obuhvataju definisanje debljine ploča i metode crtanja 
ploča koje su iste kao i kod linija i polilinija.

	f Kod krovova je važno naglasiti da podešavanje parametara zavisi od sredine u kojoj 
se objekat projektuje (od količine padavina i drugih vremenskih uslova zastupljenih 
na tom prostoru).

	f Stepenice omogućavaju vertikalnu komunikaciju unutar objekta. Za stepenice je potrebno 
definisati niz parametara kako bi one mogle biti pravilno konstruisane. Potrebno je 
podesiti osnovne dimenzije stepenika. Kroz poglavlje su objašnjeni svi tipovi stepenica 
i načini konstruisanja (jednokrako, dvokrako, kružno stepenište).

	f Za crtanje otvora u zidovima u ArchiCAD-u potrebno je podesiti visinu i širinu vrata i 
prozora, izabrati materijale i stilove koji se uklapaju u estetski koncept objekta i preci-
zno ih postaviti na osnovi.

	f Postavljanje namještaja u virtuelni objekat podrazumijeva: prilagođavanje dimenzija 
prostoriji u kojoj se postavlja, modifikaciju dimenzija i materijala namještaja prema 
potrebama korisnika. 

	f Kroz poglavlje se nalaze sveobuhvatna uputstva za korišćenje ArchiCAD-a u projekto-
vanju virtuelne zgrade, pružajući mogućnost preciznog definisanja i prilagođavanja 
svih ključnih elemenata objekta, čime se osigurava visoka preciznost i efikasnost u 
procesu projektovanja.
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Grafička dokumentacija je od suštinskog značaja u inženjerstvu jer omogućava vizuali-
zaciju i komunikaciju između članova tima koji učestvuju u izradi, kao i u fazi realizacije 
projekta. Ovu vrstu dokumentacije čine crteži, planovi, dijagrami i drugi vizuelni elementi 
koji predstavljaju detalje i informacije o nekom projektu. Koristi se za planiranje, analizu 
i procjenu svih faza u projektovanju, uključujući dimenzionisanje, materijalizaciju, kon-
strukciju i estetiku.  
U ovom poglavlju saznaćete:

	y Kako izmijeniti elemente na etažama
	y Na koji način se podešavaju parametri za crtanje linije presjeka u osnovi
	y Kako nacrtati liniju presjeka i na koji način pristupiti pogledu presjeka
	y Kako postaviti liniju pogleda fasade u osnovi.

5.1. Osnove 

Osnova etaže predstavlja horizontalni presjek objekta. Na osnovi se nalaze informacije o 
rasporedu prostorija, poziciji zidova, vrata, prozora, namještaja, dimenzije. Takođe, tu se 
nalaze još i oznake i simboli koji sadrže informacije poput obrade podova, tipovi vrata i 
prozora i sl.
Kroz poglavlje 1.5.5. Konfiguracija etaže (Story Settings) objasnili smo podešavanja 
karakteristika etaža koje je potrebno definisati prije početka crtanja bilo kog projekta u 
ArchiCAD-u. 

Uređivanje elemenata na etaži
Opcija Edit Elements by Stories omogućava brzo kopiranje elemenata s postojeće etaže na 
drugu ili brisanje zadatih elemenata sa izabrane etaže. Pristupanje ovoj opciji vrši se preko 
komandi:

	y Design > Edit Elements by Stories

	y Edit > Move > Edit Elements by Stories

	y klikom na desni taster miša na folder Stories u Navigatoru. 

Sa lijeve strane dijaloškog okvira nalazi se lista elemenata na kojima treba uraditi izmjene 
(Select Element Type).
Sa desne strane ponuđene su tri komande za izmjenu (Copy, Cut i Delete). Treba odabrati s 
koje će se etaže (From Story) i na koju etažu (To Story) elementi kopirati. 
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Slika 5.1. Dijaloški okvir za izmjene elemenata po etažama

Kada je u podešavanjima izabrana komanda Delete, to znači da je softver u režimu 
brisanja elemenata, a ne u režimu premještanja (Copy ili Cut). U ovom režimu softver 

očekuje informaciju o tome koji će elementi biti izbrisani, a ne premješteni na drugu etažu. 
Stoga opcija To Story nije dostupna u ovom režimu jer bi bila nesaglasna s trenutnom komandom 
za brisanje elemenata.

5.2. Presjeci

Vertikalni presjeci predstavljaju vizuelni prikaz objekta duž određenih vertikalnih linija 
ili ravni. Omogućavaju detaljnu analizu vertikalne strukture objekta, uključujući zidove, 
stubove, djelove konstrukcije i druge elemente. Oni takođe pružaju jasan uvid u raspored 
prostorija i funkcionalnu organizaciju objekta duž vertikalne ose. Presjeci se mogu koristiti 
u svim fazama projektovanja, od početnih skica i ideja kojima se predstavlja koncept diza-
jna pa sve do izgradnje objekta, kada predstavljaju tehničku dokumentaciju za izvođenje 
radova. Na presjecima su prikazane visinske kote, slojevi koji čine konstrukciju (od osnovnih 
nosivih elemenata do završnih površinskih slojeva), kao i veza između njih.
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Da bi se dobio jasan prikaz konstrukcije objekta, veoma je važan položaj presjeka. Za 
postavljanje presjeka na osnovi koristi se alat Section koji se nalazi u ToolBox-u u odjeljku 
Viewpoint s lijeve strane radne površine.
Dvostrukim klikom lijevog tastera miša na ikonicu Section otvara se dijaloški okvir pode-
šavanja presjeka (Section Default Settings). Dijaloški okvir podijeljen je u strukturne cjeline 
kojima se definišu svojstva presjeka (od grafičkog prikaza na osnovi do načina prikazivanja 
u prozoru presjeka).

Slika 5.2. Dijaloški okvir za podešavanja parametara presjeka

1. General: U ovom meniju podešavaju se osnovni podaci o presjeku (naziv, tekstualni 
prikaz na osnovi i dr.).

Slika 5.3. Padajući meni za podešavanje osnovnih podataka o presjeku

Reference ID – naziv koji se pojavljuje u paleti Navigator u odjeljku Sections kao i na osnovi 
etaže.
Name – naziv koji se pojavljuje pored ID u Navigatoru. 
Show on Stories – podešavanje opsega vertikalnog presjeka (kroz koje će etaže proći presjek). 
Horizontal Range – podešavanje horizontalnog raspona koji će biti obuhvaćen u presjeku. 
Odabirom opcije Infinite u presjeku će se vidjeti svi elementi objekta ka kojima je okrenut 
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presjek. Opcija Limited ograničava pogled (na primjer, ukoliko presjek gleda ka dnevnom 
boravku i kuhinji, Limited opcijom može se ograničiti opseg presjeka samo na dnevni bora-
vak, tako da se kuhinja ne vidi u pogledu). Zero Depth znači da se u pogledu presjeka vidi 
samo pozicija na kojoj se nalazi presjek.
Vertical Range – takođe ograničava presjek, ali po visini objekta. Opcijom Infinite prikazuje 
se čitav objekat po vertikali, a opcijom Limited visina do koje će se vidjeti objekat. 

Istraži ostala podešavanja iz menija General i grafičkog prikaza u prozoru 
(Model Appearance) i zabilježi svoja zapažanja.

2. Model Appearance: U ovom meniju podešavaju se boje, teksture i šrafure koje se koriste 
za prikazivanje materijala u presjeku. Takođe, omogućava podešavanje transparentnosti, 
osvjetljenja, kao i prisustvo sjenki u presjeku.
3. Marker: U ovom meniju podešava se grafički prikaz linije presjeka na osnovi etaže (vrsta, 
boja i debljina linije, veličina i boja oznake presjeka, kao i pozicija oznaka presjeka) (slika 5.4). 

Slika 5.4. Padajući meni za podešavanje izgleda markera

4. Marker text style: U ovom meniju podešava se font, boja, veličina i pozicija teksta koji 
ide uz oznaku presjeka, koji će biti prikazan na osnovi etaže (slika 5.5).

Slika 5.5. Padajući meni za podešavanje teksta presjeka

5. Marker symbol and text: U ovom meniju podešava se izgled oznake presjeka na osnovi 
etaže. Osim toga podešava se i izgled ispune, kao i pozicija teksta u odnosu na oznaku (slika 
5.6).
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Slika 5.6. Prikaz parametara za oznaku presjeka u osnovi

Otvori novi ArchiCAD fajl, izaberi alat za crtanje presjeka i prateći uputstva 
postavi dva presjeka tako da jedan bude definisan sljedećim parametrima:

1. tip linije Dashed, boja 46
2. veličina markera 4 mm i boja 46
3. font markera Arial, veličine 4 mm, boja 46
4. stil markera Circle 1

5. Nacrtaj liniju presjeka proizvoljne dužine na prikazu osnove.
Drugi presjek definiši po svom izboru.

6. Story Levels: Podešavanje grafičkog prikaza linije koja razdvaja etaže u prozoru prikaza 
presjeka (vrstu, boju i debljinu linije), veličine i boje oznake presjeka, koji će biti vidljivi 
na presjecima.

Slika 5.7. Padajući meni za podešavanje grafičkog prikaza linije presjeka u izgledu
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7. Story Levels text style: Podešavanja fonta, boje, veličine i pozicije teksta koji ide uz 
oznaku u prozoru prikaza presjeka.

Slika 5.8. Padajući meni za podešavanje teksta presjeka u izgledu

Istraži ostala podešavanja iz dijaloškog okvira Section Default Settings i 
zabilježi svoja zapažanja.

Kao što je već u prethodnim poglavljima pomenuto, opcija 
Geometry Method u InfoBox-u značajan je alat prilikom crtanja 
i postavljanja bilo kojih elemenata crteža, i uvijek je potrebno 
osvrnuti se na ovo polje kako bi se na pravilan način defini-
sala podešavanja.
U osnovi se mogu postaviti dvije vrste presjeka:
A) ravan presjek (Single) – predstavlja metodu postavljanja 
presjeka tako da su svi prikazani elementi u istoj ravni u 
pogledu.
B) izlomljeni presjek (Staggered) – predstavlja metodu postav-
ljanja presjeka tako da se presjeci prekidaju ili pomjeraju na 
određenim mjestima na objektu duž horizontalne ose (slika 
5.9).
Nakon što je linija presjeka nacrtana u osnovi, kursor miša 
mijenja se u ikonicu oka koja označava pravac gledanja 
presjeka (slika 5.10). Klikom na lijevi taster miša završava 
se postavljanje linije presjeka. Softver automatski generiše vertikalni presjek i postav-
lja ga u Navigatoru u folderu Sections, čijim se odabirom može vidjeti izgled presjeka.
Primjer izgleda presjeka u zavisnosti od geometrije linije u osnovi (A – ravni presjek, B 
– izlomljeni)

Slika 5.11. Linije presjeka u osnovi

Slika 5.12. Presjek A u izgledu

Slika 5.13. Presjek B u izgledu

Slika 5.9. Izgled ikonica  
za metodu geometrije u 

InfoBox-u

Slika 5.10. Izgled linije 
presjeka prilikom 

postavljanja na osnovi
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�U prozoru presjeka mogu se vršiti izmjene na već postavljenim elementima, ali se ne 
mogu kreirati novi konstruktivni elementi. Takođe, objekti postavljeni u prozoru pre-
sjeka, predstavljaju 2D simbole i ne generiše se odgovarajući 3D model.

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta dodaj dvije linije presjeka: podužnu (koja prolazi kroz jedan 

od stepenišnih kraka) i poprečnu (koju možeš pozicionirati po želji). 

5.3. Fasade (Elevations)

Fasada je spoljašnji izgled objekta kojim se vizualizuju zidovi, prozori, vrata i druge karak-
teristike doživljaja objekta iz ugla okoline. Elementi fasade mogu biti i različiti materijali, 
teksture, boje i oblici, a njihovo usklađivanje stvara prepoznatljiv identitet objekta. 
Presjeci i fasade koriste se za prikazivanje vertikalnih pogleda na objekat, ali imaju različitu 
svrhu i funkciju. Glavna razlika između alata Section i Elevation u ovom softveru je u tome 
što se alat za postavljanje presjeka koristi za prikazivanje unutrašnjih detalja i konstruk-
tivnih djelova objekta, dok se alat za postavljanje fasada koristi za prikazivanje spoljašnjih 
elemenata s udaljene tačke. 
Za postavljanje izgleda na osnovi koristi se alat Elevation koji se nalazi u ToolBox-u u 
odjeljku Document.
Sva podešavanja koja smo objasnili u prethodnom poglavlju (5.2. Presjeci) mogu se primi-
jeniti i kod podešavanja parametara za postavljanje linije prikaza fasade na osnovama. 
Razlika je u poziciji linije. U slučaju fasade, linija će biti postavljena van objekta, tako da 
zahvata cijelu dužinu zida i gleda ka njemu (slika 5.14). 

Slika 5.14. Postavljanje linije fasade na osnovi

Na isti način kao i kod postavljanja presjeka, nakon definisanja pozicije fasade, softver 
će automatski generisati fasadu i postaviti je u Navigatoru u folderu Elevations, čijim se 
odabirom može vidjeti njen izgled (slika 5.15).
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Slika 5.15. Izgled Fasade 1

PROVJERI SVOJE ZNANJE

1.	 Da li se opcijom Edit Elements by Stories mogu kopirati svi zidovi s prizemlja na sprat?
2.	 Koje se vrste presjeka u ArchiCAD-u mogu postaviti na osnovi? 
3.	 U kom ćeš meniju podešavanja parametara presjeka definisati izgled i boju linije na 

osnovi?
4.	 Da li se prikazi presjeka i fasada mogu prekinuti na određenoj visini?
5.	 Šta je fasada objekta?
6.	 Objasni razliku između presjeka i fasade.

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta:

1. Pozicioniraj poglede sa sve četiri strane objekta tako da dobiješ četiri fasade na 
kojima je zid vidljiv u cjelini.
2. Fasadama daj nazive prema stranama svijeta na kojima se nalaze.
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	f U ovom poglavlju upoznali ste se s djelovima grafičke dokumentacije koji čine jedan 
projekat. Nivo grafičke obrade priloga od velikog je značaja jer se njima prezentuje 
projekat, i zato svi prilozi (crteži) moraju biti pregledni i lako čitljivi.

	f Osnova služi za prikaz raspodjele prostora, njegovih dimenzija, proporcija, kao i plan 
pozicije namještaja i komunikacija kroz objekat.

	f U presjeku se sagledava vertikalna struktura i konstrukcija objekta, uključujući visinske 
kote koje imaju ulogu razumijevanja odnosa visina u objektu. Takođe, u presjeku se 
nalaze i tekstualne informacije o slojevima zidova, ploča, krova i slično.

	f Fasade predstavljaju spoljašnji izgled objekta. Sadrže informacije o materijalizaciji, 
odnosu s okolinom i drugim objektima.

	f Kako bi se osigurala tačnost prikaza objekta, od izuzetne je važnosti omogućiti poveza-
nost u prezentaciji, kao i povezanost u informacijama između osnove, presjeka i fasade.
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Tekstualna dokumentacija u arhitektonskom projektovanju predstavlja detaljan opis ključnih 
aspektata projekta, uključujući njegove ciljeve, funkcionalne zahtjeve, tehnička rješenja i 
kontekstualne informacije. Ona služi kao ključni resurs za razumijevanje dizajna, strukture 
i funkcionalnosti objekta.
Ova vrsta dokumentacije služi kao referentni materijal tokom cijelog procesa – od samog 
planiranja pa sve do izvođenja objekta. To znači da sadrži detaljne opise dizajna, mate-
rijala i sve ostale tehničke informacije koje su potrebne da bi se radovi izveli. Jedan od 
značajnih ciljeva jeste da dokumentacija ispunjava zakonske zahtjeve. To znači da u njoj 
treba da postoje informacije koje su potrebne da bi se dobile dozvole za izgradnju i da bi 
se poštovali propisi i standardi. 
U ovom poglavlju saznaćete:

	y Koje vrste kota postoje u softveru i kako se primjenjuju
	y Kako se kotiraju osnove i presjeci
	y Na koji se način uređuje kotni stil
	y Koji su parametri značajni za postavljanje teksta u projektu
	y Kako se postavlja tekstualni opis u pogledu osnove i virtuelnog lista
	y Na koji se način mogu vršiti izmjene postavljenog teksta.

6.1. Kotiranje 

Kotiranje je u tehničkom crtanju proces označavanja dimenzija elemenata na crtežu. Svi 
elementi jednog crteža mogu se kotirati tako da se na pravilan način predstave njihova 
dužina, širina, visina i ugao. Cilj kotiranja jeste da pruži sveobuhvatne informacije potrebne 
za razumijevanje odnosa veličina djelova projekta. U zavisnosti od vrste priloga i nivoa na 
kom se radi projekat, kote se mogu postaviti u osnovi, presjeku, izgledu ili na konstruktiv-
nim detaljima.
U poglavlju 1.5.3. Konfiguracija postavki projekta (Project Preferences) u dijelu Prikaz dimen-
zija/kotiranje objasnili smo na koji način podešavanja mjernih jedinica za prikaz kotnog 
broja utiče na grafički prikaz na osnovama i presjecima. Prije početka kotiranja potrebno 
je u ovom dijaloškom okviru podesiti sve parametre, pa tek onda početi kotiranje. 
U paleti alata (ToolBox) u dijelu Document nalaze se ikonice za aktiviranje nekoliko vrsta 
kota koje se mogu postaviti u projektu (slika 6.1).
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Slika 6.1. Izgled ikonica za kote u ToolBox-u

Linearne kote prikazuju dužine elemenata.
Visinske kote predstavljaju numeričke oznake koje definišu visinu određenih tačaka u 
prostoru u odnosu na kotu terena (nultu referentnu tačku). Prikazuju se na osnovama, 
presjecima i izgledima kako bi se jasno prikazale visinske razlike elemenata objekta i nji-
hova međusobna povezanost. 
Radijalne kote prikazuju radijus zakrivljenih elemenata.
Ugaone kote prikazuju ugao između dva elementa. 
O kotama ste izučavali ranije, u sklopu modula Tehničko crtanje i Projektovanje. Ista pravila 
kotiranja primjenjuju se i kada je u pitanju kotiranje u ArchiCAD-u i svim specijalizovanim 
softverima za projektovanje. Kote se sastoje od: kotne linije, kotnog broja, kotnog završetka 
i pomoćne kotne linije, i mogu biti prikazane na razne načine. Kao i kod ručnog kotiranja 
projekta, tako se i u ArchiCAD-u mogu podesiti izgledi, boje i veličine svih djelova kote.

6.1.1. Podešavanje kotnog stila

Dvostrukim klikom lijevog tastera miša na ikonicu Dimension otvara se dijaloški okvir pode-
šavanja kotnog stila (Dimension Default Settings). Dijaloški okvir podijeljen je u strukturne 
cjeline kojima se definišu svi elementi kota (slika 6.2).

Slika 6.2. Dijaloški okvir podešavanja kota
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1. Dimension Type (Construction method) meni je u kojem se podešava način formiranja 
kote. U ArchiCAD-u je moguće postaviti kote uz pomoć četiri metode: 
a) Linearnom metodom kotira se udaljenost između dva uzastopno izabrana elementa 
(ili tačke).

Slika 6.3. Izgled ikonice linearne kote u InfoBox-u (lijevo) i prikaz kote u osnovi (desno)

b) Kumulativnom metodom kotira se ukupna udaljenost nekog elementa od prve zadate 
tačke kotiranja. Svaka sljedeća zadata pozicija kote prikazaće ukupnu udaljenost od početka 
do te tačke.

Slika 6.4. Izgled ikonice kumulativne kote u InfoBox-u (lijevo) i prikaz kote u osnovi (desno)

c) Base-line metodom postavljaju se dimenzije udaljenosti u odnosu na zadatu referentnu 
liniju.

Slika 6.5. Izgled ikonice za Baseline metodu u InfoBox-u (lijevo) i prikaz kote u osnovi (desno)

d) Postavljanje visinskih kota: Ova metoda koristi se za prikazivanje visinskih razlika 
između različitih nivoa ili djelova objekta. Ona omogućava jasno prikazivanje vertikalnih 
udaljenosti između etaža, nivoa terena ili razlika u visini na jednoj etaži. Visinske kote 
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postavljaju se i u crtežima presjeka i fasada. Razlika između visinske kote u osnovi i visin-
ske kote u presjeku jeste u njenom izgledu (markeru) koji se podešava u dijaloškom okviru. 
Slična podešavanja za ovu vrstu kote nalaze se u paleti alata Level Dimension u okviru koje 
se brže pristupa postavljanju visinskih kota u osnovi.

Slika 6.6. Prikaz podešavanja za visinske kote

2. Marker Type je meni u kojem se podešava izgled 
kotne strelice i dužina pomoćne kotne linije.
Odabir izgleda kotne strelice je proizvoljan, i zavisi od 
ličnih preferenci i grafičkog stila koji se želi postići u 
projektu. 

Slika 6.8. Izgled pomoćnih kotnih linija u osnovu

3. Witness line je meni u kojem se podešava dužina pomoćne kotne linije u odnosu na 
zadatu tačku kotiranja. Dužina pomoćne kotne linije može biti definisana kao:

a)	 nevidljiva
b)	 srazmjerna kotnoj strelici
c)	 prilagođena (ručno se definiše dužina)
d)	 dinamična (prikazivaće se od tačke kotiranja do kotne linije)

Slika 6.7. Izgledi kotnih strelica
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Slika 6.9. Nevidljiva pomoćna kotna linija

a) b)

Slika 6.10. Pomoćna kotna linija srazmjerna

c) d)

Slika 6.11. Prilagođena pomoćna kotna linija Slika 6.12. Dinamična pomoćna kotna linija

4. Statičke dimenzije 

Slika 6.13. Dio dijaloškog okvira koji prikazuje statičke dimenzije

Kada govorimo o kotama u ArchiCAD-u, podrazumijevamo oznake ili dimenzije koje ozna-
čavaju udaljenost, visinu ili dimenziju elemenata na crtežu. Kotiranje može biti asocijativno 
ili statičko.
Asocijativne kote su one koje se automatski prilagođavaju promjenama u crtežu. Na pri-
mjer, ako promijenite veličinu ili poziciju nekog već kotiranog elementa u crtežu, asocija-
tivne kote će se automatski prilagoditi tako da prikazuju promjene u dimenziji. Promjenom 
širine prozora koji je označen kao referenca za kotiranje, asocijativna vrsta kote će se po 
automatizmu izmijeniti tako da prikaže novu širinu prozora.
Nasuprot asocijativnim kotama, statičke su one koje ostaju nepromijenjene bez obzira na 
promjene dimenzija elemenata u crtežu. To znači da ako promijenite veličinu ili poziciju 
prozora, ukoliko je izabrana statička kota, ona će ostati na toj poziciji i neće se prilagoditi 
izmjenama dimenzija. 
U dijaloškom okviru podešavanja kota (Dimension Default Settings) takođe se prilagođava 
grafički prikaz kotnog broja. Podešavanja veličine kotnog broja, fonta i boje kojom je ispisan 
definišu se u padajućem meniju Text Style.
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Samostalno istraži podešavanja grafičkog prikaza označenog na slici 6.14 i 
bilježi svoja zapažanja.

Slika 6.14. Podešavanja tekstualnog stila

Osim podešavanja grafičkog prikaza kotnog broja u ArchCAD-u je moguće podesiti i sadržaj. 
Kada kažemo sadržaj, misli se na informacije koje će se naći u polju u kom se prikazuje 
kotni broj. Kao zapis se može postaviti izmjerena dužina (Measured Value) ili proizvoljni 
tekst (Custom Text) umjesto kotnog broja (slika 6.15). Ovim podešavanjima pristupa se tako 
što se prvo izabere kotni broj koji se želi izmijeniti. 
U polje Custom unosi se bilo koji tekstualni ili numerički zapis.

Slika 6.15. Dijaloški okvir za podešavanje kotnog teksta
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Slika 6.16. Prikaz Custom kotnog teksta

6.1.2. Način kotiranja

Kotiranje se može izvesti na svim elementima koji su nacrtani u ArchiCAD-u. Tu spadaju 
2D elementi crteža (linije, kružnice, ispune i dr.) i 3D elementi (konstruktivni elementi, 
otvori, namještaj i dr.). U okviru alata Dimension mogu se izabrati dvije metode geometrije 
postavljanja kota (iz prethodnih poglavlja već vam je poznata opcija iz InfoBox-a Geometry 
Method). Kote se mogu postaviti linearnom ili lučnom metodom. Lučna metoda koristi se 
za kotiranje zaobljenih elemenata.

Kako bi se omogućio tačan i nedvosmislen prikaz objekta, kotama se moraju 
označiti sve mjere.

Kote moraju biti postavljene u svim prikazima objekta s obzirom na to da svaki od 
njih prikazuje različite detalje i poglede na objekat.
Kotni brojevi pišu se po sredini kotne linije.

Geometrijska metoda: Linearne dimenzije (x, y only, any direction)

KOTIRANJE OBJEKTA LINEARNOM METODOM

Korak 1: Aktiviraj alat Linearne dimenzije.
Korak 2: Pomjeri kursor na element koji želiš da dimenzionišeš. Kada na njega postaviš 
kursor, element će biti zasjenčen plavom bojom kako bi se naglasio njegov odabir.

Slika 6.17. Korak 2 
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Korak 3: Pritiskom lijevog tastera miša bilo gdje na elementu koji želiš da dimenzio-
nišeš, postavljaju se privremene referentne tačke koji označavaju pozicije pomoćnih 
kotnih linija nakon završetka odabira elemenata koji će se naći na kotnoj liniji.

Slika 6.18. Korak 3

Ponovnim klikom na bilo koju zadatu referentnu tačku moguće ju je opozvati, ukoliko 
za tim postoji potreba.

Slika 6.19. Konačan izgled kote

Korak 4: Dvostrukim klikom lijevog tastera miša nakon postavljanja konačne refe-
rentne tačke (nakon odabira svih željenih elemenata) postavlja se kotna linija. 

Slika 6.20. Korak 5

Korak 5: Kursor miša mijenja svoj oblik u izgled čekića koji označava pozicioniranje 
kotne linije na ekranu. Pomjeranjem kursora biraš lokaciju kotne linije, a pritiskom 
lijevog tastera miša postavljaš kotu.



1476.1. Kotiranje 

Slika 6.21. Korak 6

Geometrijska metoda: Lučne dimenzije (Arc Length) 

KOTIRANJE ZIDA LUČNOM 
METODOM

Korak 1: U InfoBox-u u dijelu Geometry 
Method izaberi ikonicu luka.
Korak 2: Pomjeri kursor na element koji 
želiš da dimenzionišeš. Kada na njega 
postaviš kursor, element će u cjelini biti 
zasjenčen plavom bojom. 
Korak 3: ArchiCAD automatski označava 
krajnje tačke luka koje će biti iskotirane. 
Kao i kod linearne metode, pritiskom 
na lijevi taster miša dodaješ referentne 
tačke elemenata koje želiš da prikažeš 
na koti. 
Završetak odabira elemenata i postupak 
postavljanja kotne linije isti su kao i kod 
linearne metode.

6.1.3. Visinske kote

Postavljanje visinskih kota značajan je dio 
procesa crtanja projekta. Uz pomoć visinskih 
kota precizno se određuju visine različitih 
djelova objekta u odnosu na referentne 
tačke (to može biti kota tla ili kota poda 
prizemlja). Ukoliko one nijesu tačno postav-
ljene, to može dovesti do problema tokom 
izgradnje i pogrešnog proračuna potrebnog 
materijala i stabilnosti konstrukcije.

Slika 6.22. Korak 2

Slika 6.23. Korak 3

Slika 6.24. Konačan izgled  
lučne kote
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Kao što smo već pomenuli kod podešavanja kotnog stila, u ArchiCAD-u postoje dva načina 
postavljanja visinskih kota. Kota nivoa (Level Dimension) alat je koji se koristi za označa-
vanje visinskih razlika u osnovi. Na primjer, kod osnove plafona sa rasvjetom, ukoliko na 
plafonu postoje spušteni djelovi, visinskim kotama ćete u osnovi prikazati tu razliku (slika 
6.25). Za postavljanje visinskih kota u pogledima presjeka i fasada koristi se alat Dimension. 
U podešavanjima kotnog stila treba izabrati Elevation Dimension. 

Slika 6.25. Dijaloški okvir podešavanja visinskih kota

Dodatna podešavanja izgleda markera 
podrazumijevaju: odabir proporcije gra-
fičkog prikaza markera (slika 6.26-1), 
odabir pozicije kote (slika 6.26-2) i da li 
je kota prikazana konturom ili ispunom 
(slika 6.26-3).

Slika 6.27. Izgled visinskih kota u osnovi

Slika 6.26. Podešavanja markera
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6.1.4. Oznake poluprečnika i ugla

Slika 6.28. Prikaz oznaka poluprečnika i ugla u osnovi

Oznake poluprečnika i uglova 
bitni su elementi svakog tehnič-
kog crteža, jer precizno prika-
zuju oblik, dimenziju i proporciju 
objekta.
Na slici 6.28 prikazana je razlika 
između oznake poluprečnika (alat 
Radial Dimension) i oznake ugla 
(alat Angle Dimension). Razlika 
između oznake poluprečnika i 
uglova na osnovi je u načinu pred-
stavljanja potrebnih informacija. 
Oznaka ugla koristi se za posti-
zanje geometrijske preciznosti 
na crtežu, odnosno za pravilno 
pozicioniranje konstruktivnih ele-
menata koji su pod određenim 
uglom.
Kao što smo već pominjali kroz 
poglavlje 2.3. Crtanje kružnica i 
lukova, poluprečnik je mjera udaljenosti od centra kružnice ili elipse do neke tačke na 
kružnici. Oznaka poluprečnika koristi se za obilježavanje zakrivljenih površina kao što 
su lukovi, zaobljeni zidovi ili stubovi. 
Alat za postavljanje oznaka ugla (Angle Dimension) nalazi se u paleti ToolBar u dijelu 
Document. Grafički prikaz oznake i način postavljanja na osnovi isti je kao i kod linear-
nih kota. Razlika je samo u informacijama koje se nalaze u InfoBox-u. Osim već poznatih 
podešavanja veličine, izgleda kotne strelice i drugih parametara, za alat Angle Dimension 
treba podesiti i pravac mjerenja ugla (da li treba iskotirati unutrašnji ili spoljašnji ugao) 
(slika 6.29).

Slika 6.29. Načini kotiranja ugla



150 Tekstualna dokumentacija

OZNAČAVANJE UGLA

Korak 1: Klikom na lijevi taster miša odredi tjeme ugla.
Korak 2: Klikom na lijevi taster miša odredi krake ugla.
Korak 3: Još jednim klikom definiši oznaku ugla.

Slika 6.30. Postupak označavanja ugla

6.1.5. Uređivanje kota

U procesu crtanja projekta u ArchiCAD-u može doći do situacije u kojoj se nakon kotiranja 
na objektu dodao još jedan zid ili neki otvor koji je potrebno unijeti na kotnu liniju. Kod 
ručnog crtanja to bi značilo brisanje kotne linije i crtanje nove, s dodatnim informacijama. 
U ArchiCAD-u postoji naredba koja vam omogućava da bez ponovnog crtanja, u postojeću 
kotnu liniju uvrstite i nov element. 
Da bi se izvršile izmjene na koti, potrebno ju je prvo odabrati. Nakon toga iz Pet Palette 
kliknuti ikonicu za dodavanje (Insert / Merge Dimension Point) (slika 6.31). Na kraju izabrati 
element koji treba dodati na kotnu liniju.

Slika 6.31. Postupak dodavanja elemenata na kotnu liniju

Za brisanje elementa s kotne linije koristi se komanda Cut (sječenje). O komandama za 
osnovno uređivanje detaljno smo govorili u poglavlju 3.1. Osnovno uređivanje.
Osim dodavanja i brisanja dimenzija elemenata s kotne linije, iz Pet Palette može se izmi-
jeniti i izgled kote kao i njena pozicija. 
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PROVJERI SVOJE ZNANJE 

1.	 Navedi šta je kotni stil i objasni njegov značaj.
2.	 Opiši parametre koji se podešavaju za kotni stil.
3.	 Da li se promjenom veličine elementa automatski mijenja i njegova prethodno une-

sena kota?
4.	 Otvori zadatak Osnova poslovnog prostora. Iskotiraj je kao što je prikazano na 

slici 6.32.

Slika 6.32. Zadatak 4: Kotiranje osnove

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta iskotiraj na osnovi prizemlja i sprata, kao i na presjecima, 

sve potrebne elemente.
Parametri podešavanja kota:

	f Tip: Linear Method

	f Marker Type: Crtica pod uglom od 45°
	f Pomoćna kotna linija: Custom – 3 mm
	f Olovka kotne linije i strelice: 61
	f Kotni broj: Font – Times New Roman, veličina – 2 mm, olovka – 61.
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6.2. Unošenje teksta na crtež

Tehnički crteži uvijek sadrže neke informacije u obliku teksta. Dodavanje teksta na crtež 
važan je korak, jer se njime bliže objašnjava crtež u cjelini ili njegovi djelovi. Crteži naj-
češće sadrže kombinaciju različitih tekstualnih elemenata (slova, brojevi, matematičke 
formule i dr.). U ArchiCAD-u se alat za unošenje tekstualnog sadržaja (Text) nalazi u paleti 
alata Document. Na crtežima se mogu postavljati različiti stilovi teksta (boja, veličina, stil) 
kako bi crtež bio pregledan i jasan za čitanje. Dvostrukim klikom na ikonicu alata otvara 
se dijaloški okvir podešavanja parametara teksta (slika 6.33).

Slika 6.33. Dijaloški okvir za podešavanja parametara teksta

U prvom padajućem meniju Text Style podešavaju se parametri koji su vam sigurno poznati 
iz programa za obradu teksta (Word), i to: 

1.	 Odabir fonta
2.	 Odabir veličine teksta (izražen u milimetrima) i olovke (boje) teksta
3.	 Podešavanje stila teksta (bold, italic, underline, strikethrough)
4.	 Podešavanje poravnanja teksta (justify)
5.	 Prilagođavanje izgleda slova i razmaka između njih u tekstu.

U drugom padajućem meniju Text Block Formating podešava se izgled tekstualnog sadržaja 
(slika 6.34).

Slika 6.34. Dijaloški okvir za podešavanja izgleda teksta
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Polje Opaque u podešavanjima teksta označava pozadinu teksta (da li će ona biti prozirna 
ili u boji). Kada je polje Opaque označeno, to znači da će pozadina teksta biti potpuno pre-
krivena bojom ili nekom ispunom, što će učiniti tekstualni sadržaj neprozirnim, tj. blokirati 
bilo kakvu vidljivost elemenata koji se nalaze ispod teksta. Ako je opcija isključena, to znači 
da će pozadina teksta biti prozirna, što će omogućiti vidljivost elemenata koji se nalaze 
ispod teksta. Ova opcija korisna je kada želite da istaknete tekstualni sadržaj ili ga učinite 
lakšim za čitanje (slika 6.34).
Polje Frame (okvir) definiše postojanje okvira oko tekstualnog sadržaja. Kada je ovo polje 
označeno, tekst će biti uokviren, što može dodatno istaći ili definisati granice teksta. Ovo 
je korisno ako želite da vizuelno razgraničite tekstualni sadržaj. 
Opcije Model Size (veličina modela) i Paper Size (veličina papira) u podešavanjima odnose 
se na veličinu teksta u odnosu na veličinu crteža ili papira na kom će se štampati. Kada se 
koristi Model Size, veličina teksta ostaće proporcionalna u odnosu na razmjeru objekata. S 
druge strane, kada se koristi Paper Size, veličina teksta biće prilagođena veličini papira na 
kojem je crtež štampan ili prikazan.
Sa aktivnim alatom Text moguća su dva načina za unos teksta na crtež:

1.	 Dvostrukim klikom lijevog tastera miša bilo gdje na radnoj površini započinje se 
unos teksta u jednoj liniji.

Slika 6.35. Postupak unošenja na radnu površinu

2.	 Zadavanjem dijagonale 
pravougaonika u kom 
će biti upisan tekst. U 
tom slučaju tekst može 
biti napisan i u nekoliko 
redova, jer će se prela-
mati na mjestima gdje 
se završava zamišljeni 
pravougaonik.

Slika 6.37. Prikaz opcija za formatiranje tekstualnog sadržaja

Slika 6.36. Postupak unošenja teksta u okviru zadatih 
dimenzija tekstualnog kvadrata
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Slika 6.38. Ikonice za unos simbola i stepena

Istraži alat Lable iz palete alata (ToolBox) i bilježi svoja zapažanja.

PROVJERI SVOJE ZNANJE

1.	 Opiši načine unošenja teksta na crtež.
2.	 Predloži neki od fontova koji smatraš najpogodnijim za unos teksta na crtež.
3.	 Nacrtaj pravougaonik kao na slici 6.39 i obilježi njegova tjemena.

Slika 6.39. Zadatak 3: Obilježavanje pravougaonika

4.	 Kako unosiš stepene i simbole u tekst?

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta unesi legendu za osnovu prizemlja i sprata prema datom 

primjeru, koristeći znanje stečeno iz poglavlja Crtanje linije i Unošenje teksta.

Slika 6.40. Izgled legende za projektni zadatak
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SAŽETAK POGLAVLJA

	f Svrha tekstualne dokumentacije jeste da služi kao referentni materijal tokom cijelog 
procesa – od planiranja pa sve do samog izvođenja objekta. To znači da sadrži detaljne 
opise dizajna, materijala i sve ostale tehničke informacije koje su potrebne da bi se radovi 
izveli. Jedan od značajnih ciljeva jeste da dokumentacija ispunjava zakonske zahtjeve. 
To znači da u njoj treba da postoje informacije koje su potrebne da bi se dobile dozvole 
za izgradnju i da bi se poštovali propisi i standardi. 

	f Cilj kotiranja je da pruži sveobuhvatne informacije potrebne za razumijevanje odnosa 
veličina djelova projekta. Podešavanje kotnog stila predstavlja prvi korak u procesu 
kotiranja nekog objekta. Kotiranje u ArchiCAD-u vrši se preko alata Dimension koji 
se nalazi u ToolBox-u u dijelu Document. Osim tog alata, za postavljanje oznaka ugla 
i poluprečnika na crtežu koriste se alati koji se nalaze u istom dijelu ToolBox-a: Angle 
Dimension i Radial Dimension. Kroz ovo poglavlje upoznali ste se s načinom unosa 
dimenzija i teksta na tehnički crtež. Kotiranje ima ključnu ulogu u čitanju projekata jer 
omogućava unos stvarnih dimenzija objekta i njegovih elemenata, čime se obezbjeđuje 
preciznost i tačnost prilikom izvođenja radova. Horizontalne (linearne) kote pomažu u 
razumijevanju veličine prostorija i odnosa između njih. One daju i informacije o dimen-
zijama otvora i njihovoj poziciji na zidovima. Visinske kote koriste se u osnovama i u 
presjecima kako bi se dobila informacija o visini etaža, od temelja do krova. Na taj način 
može se analizirati odnos objekta s okolinom i kako se uklapa u okruženje.

	f Unos teksta je od izuzetne važnosti radi davanja dodatnih informacija o projektu, poput 
opisa, legende, zaglavlja i sl. Stilizovanjem teksta dajemo lični pečat grafičkoj obradi 
projekta.
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7 Vizualizacija

Vizualizacija predstavlja umjetnost pretvaranja apstraktnih podataka ili ideja u privlačne 
i razumljive forme. Osnovna karakteristika softvera ArchiCAD jeste modelovanje arhitek-
tonskih objekata. U prethodnim poglavljima naučili ste na koji se način kreiraju elementi 
objekta i na koji se način oni modeluju. Značajan faktor u kreiranju trodimenzionalne 
vizualizacije predstavljaju fotorealistični prikazi (renderi) objekta. Stvaranje rendera je 
proces izrade digitalnih slika ili animacija koristeći računarski softver.

U svijetu dizajna, arhitekture i sličnih disciplina, vizualizacija je ključna. U procesu izrade 
projekta u bilo kom specijalizovanom softveru biće potrebno ideju predstaviti klijentu ili 
timu s kojim sarađujete. Najbolji način za to jeste prikazivanje rendera, u kojima se mogu 
predstaviti detaljni 3D modela objekta sa svim elementima – od fasade do enterijera. Uz 
pomoć rendera na najbolji način se prezentuje objekat i njegov koncept, tako da je razumljiv 
svim stranama uključenim u izradu.

Vizualizacija se koristi u naučnim istraživanjima, medicini, geografiji i drugim 
oblastima kako bi se kompleksni podaci predstavili na jasan i pristupačan 

način. Na primjer, može se koristiti za prikazivanje geografskih podataka, klimatskih 
promjena ili trendova i šablona kod migracije ptica.

U ovom poglavlju saznaćete:
	y Kako da pristupite podešavanjima za izradu rendera
	y Koji su parametri značajni za kvalitet fotografije kao krajnjeg proizvoda
	y Na koji način materijalizacija i postavljanje rasvjetnih tijela utiče na trodimenzi-

onalni prikaz
	y Kako sačuvati 3D model ArchiCAD-a za dalju doradu u drugim softverima za obradu 

modela i doradu fotografije.
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7.1. Kamere

Kamere pružaju pogled na cjelokupni objekat ili njegov odabrani 
dio u 3D prozoru. Alat kamere nalazi se u ToolBox-u u dijelu 
Viewpoint (slika 7.1). Svaka postavljena kamera definisana je 
gledištem, ciljnom tačkom i uglom otvaranja (viewpoint, target 
point and opening angle).
Moguće je postaviti neograničen broj kamera u osnovi kako bi se 
generisao perspektivni prikaz u formatu fotografija ili animacija 
(fly-through).
Sa aktivnim alatom kamere, prvim klikom na lijevi taster miša 
definiše se pozicija a drugim se bira pravac gledanja (slika 7.2).

Slika 7.2. Izgled kamere u osnovi s putanjama za animaciju

Na osnovi su sve kamere prikazane sa svojim 
ciljnim tačkama i putanjama, kao i linijama 
koje predstavljaju ugao gledanja kojim se može 
manipulisati. Samo jedna kamera može biti 
trenutno aktivna – ona je naznačena suncem i 
markerima ugla gledanja. Dvostrukim klikom 
lijevog tastera miša na alat Camera otvaraju se 
postavke alata.
U dijaloškom okviru podešavanja potrebno je 
podesiti: visinu (z-osu) na kojoj se kamera nalazi 
(Camera Z), visinu pogleda kamere (Target Z), 
udaljenost i ugao kamere od horizonta (Distance 
i Azimuth). Odabirom opcije Path (slika 7.3) 
otvara se novi dijaloški okvir u kom se može 
podešavati način prikazivanja kamere u osnovi 
ili putanju kojom se kamera kreće ukoliko se 
pravi animacija (slika 7.4).

Slika 7.1. Ikonica za  
postavljanje kamere

Slika 7.3. Prozor za podešavanje  
prikaza kamere u osnovi
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Lista svih kreiranih kamera, odnosno prikaza objekta, nalazi 
se u Navigatoru folderu 3D (slika 7.5). Dvostrukim klikom 
lijevog tastera miša na jednu od kamera prikazaće se objekat 
u 3D iz te definisane pozicije.

Slika 7.5. Prikaz kreiranih kamera u Navigatoru

PROVJERI SVOJE ZNANJE

1.	 Koju funkciju imaju perspektivne kamere u ArchiCAD-u?
2.	 Opiši podešavanja koja su ti dostupna u dijaloškom okviru Camera Settings.
3.	 Šta predstavljaju parametri Camera Z i Target Z?
4.	 Koji se elementi prikazuju zajedno s kamerama u osnovi?
5.	 Da li možeš kreirati animaciju koristeći kamere u ArchiCAD-u?
6.	 Otvori fajl pod nazivom Crtanje stepeništa i podesi kameru tako da vidiš uzlazni 

krak, visinu kamere podesi na 2 m a cilj gledanja na 1 m.
7.	 Na zadatku Osnova poslovnog prostora proizvoljno postavi kamere tako da sagledaš 

spoljašnjost objekta.

Slika 7.4. Prozor za 
podešavanje prikaza 

kamere u osnovi
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7.2. Photo render

ArchiCAD-ova funkcija PhotoRendering služi za kreiranje fotorealističnih slika 3D modela. 
Kreiranje kvalitetnog 3D prikaza složena je funkcija, koja zavisi od povezanosti materijala, 
svjetlosnih efekata i postavki rendera. 

Fotorealistične slike (renderi) neće se automatski sačuvati na kompjuteru. Nakon što 
je ArchiCAD izradio render, potrebno ga je ručno sačuvati, i to tako što se na gotovu 

sliku (render) klikne desni taster miša i izabere opcija Save As. Nakon toga, na ekranu će se 
pojaviti dijaloški okvir s opcijama za čuvanje (naziv, format i destinacija).

Paleta postavki rendera dostupna je iz Window > Palettes > PhotoRendering Settings ili 
Documents > Creative Imaging.
Dijaloški okvir postavki rendera (slika 7.6) sadrži sva potrebna podešavanja kako bi se 
kvalitetno izradio trodimenzionalni prikaz. U gornjem dijelu palete postoje dva glavna 
prikaza (označeni na slici 7.6): 

Slika 7.6. Prozor za podešavanje rendera

	y lijeva ikonica predstavlja postavke prikaza objekta
	y desna postavke veličine slike. 
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Dijaloški okvir postavki koristi se za podešavanje para-
metara za izradu rendera; parametri variraju u zavi-
snosti od mehanizma koji se izabere (Engine: Basic 
Renderer, Cineware, Sketch).
Scena za izradu rendera – skup je unaprijed defini-
sanih postavki prilagođenih tipu osvjetljenja koje će 
se koristiti u procesu renderovanja. Za svaki meha-
nizam za renderovanje, ArchiCAD obezbjeđuje jednu 
ili više unaprijed definisanih scena. Oni su navedeni 
u dijaloškom okviru Select and Manage Scenes (slika 
7.7).
Parametrima veličine fotografije pristupa se preko iska-
čućeg menija koji sadrži spisak unaprijed definisanih 
veličina (koje odgovaraju veličini ekrana u pikselima, 
veličini papira ili trenutnoj veličini 3D prozora) (slika 
7.8).

Slika 7.8. Postupak podešavanja veličine fotografije 

Padajući meni Render Settings (slika 7.9)

Slika 7.9. Render Settings opcije

Slika 7.7. Padajući meni za odabir  
scene za izradu rendera
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1.	 �Quality (kvalitet)

a)	 Prva opcija definiše kvalitet rendera. Ponuđeni su niski, srednji, visoki ili konačni 
kvalitet (low, medium, high, final). Kvalitet koji se postavi imaće uticaj na antialia-
sing (slika 7.10) i globalno osvjetljenje koji proizvode bolji kvalitet, ali zahtijevaju 
više vremena za renderovanje.

Svaka digitalna slika sačinjena je od piksela koji su u osnovi kvadrati. Kada 
se renderuju idealno horizontalne ili vertikalne linije, onda antialiasing teh-

nologija nije potrebna. Međutim, kada su u pitanju dijagonalne linije, dobijamo 
efekat stepenica. Ono što antialiasing radi u ovom slučaju jeste popunjavanje pra-
znog prostora između piksela kako bi dijagonalna linija izgledala glatko. Na slici 
7.10 prikazan je način rada antialiasinga na dijagonali. Razlog zašto je antialiasing 
uvijek isključen u osnovnim podešavanjima je zato što ova tehnologija zahtijeva 
više grafičke snage.

Slika 7.10. Primjer rada AntiAliasing-a

b)	 Drugi parametar definiše kvalitet sjenke. Kvalitet sjenke je istih karakteristika kao 
i za render, osim što su za podešavanje sjenki ponuđene još i None (bez sjenki) i 
By Light Settings. To znači da se koristi svjetlosni izvor koji je već definisan prili-
kom postavljanja lampi u projektu iz Lamp Settings Light Parameters.

2.	 �Lights (osvjetljenje) 

U okviru opcije Lights (svjetlost) 
koriste se klizači za podešavanje 
intenziteta tri različite vrste svjetla 
pri renderovanju: intenzitet sunca; 
intenzitet lampe; osvijetljenost 
površina.

3.	 �Efekti 

(Use white model Effect)
Ako se aktivira ova opcija, sve povr-
šine su bijele osim onih koje koriste 
prozirnost. Ovaj tip modela koristi 
se kada je potrebno istražiti osnovne 

Slika 7.11. Izgled White Model-a
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forme i oblike prostora. Takođe se može vidjeti i kako svjetlost utiče na njih, a da boje 
i teksture ne utiču na percepciju (slika 7.11). 

Padajući meni: Environment (okruženje) 

Slika 7.12. Podešavanje fizičkog neba

Koristeći opciju pozadine neba, postavki vremena i lokacije, 3D model se postavlja u odre-
đeno okruženje:

	y Sky Setup (podešavanje neba): U ovom padajućem meniju postoje tri opcije: 
None, Physical Sky i HDRI Sky. Najčešća je postavka Physical Sky. Fizičko nebo 
je čitav skup elemenata (sunce, vrijeme, oblaci, magla, duga, atmosfera). Fizičko 
nebo pruža i pozadinsku sliku i svjetlosne efekte. Svi ovi parametri međusobno 
su povezani.

	y Kada je izabrana opcija Physical Sky, klikom na padajući meni za podešavanje vre-
mena ponuđen je skup vremenskih parametara koji kombinuju nebo. Podešavanje 
vremena za Physical Sky takođe uključuje podatke o lokaciji (slika 7.12). 

	y Opcija Select HDRI (slika 7.13) omogućava odabir slike koja daje pozadinu i izvor 
ambijentalnog svjetla za renderovanje.

High Dynamic Range Image je skup tehnika u fotografiji u obradi slike koji 
omogućavaju prikaz većeg opsega osvjetljenja od klasičnih digitalnih fotografija. 
Svrha HDRI jeste vjerniji prikaz osvjetljenja koje se nalazi u pojedinim 
scenama.

Slika 7.13. Razlika u količini osvijetljenosti sa HDRI
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Iz dijaloškog okvira za podešavanje okruženja selektuj HDRI Sky, istraži 
opcije koje ti nudi i zabilježi svoja zapažanja.

Padajući meni: Background (pozadina)
Ovaj meni identičan je za sve mehanizme za renderovanje. Pozadina je obična 2D slika 
koja se nalazi iza modela objekta. 
Ponuđene opcije (slika 7.14) jesu: None (ne postoji pozadina) i Colors (pruža mogućnost 
podešavanja boje neba i tla klikom na odgovarajuća polja birača boja). Tokom procesa 
renderovanja, ArchiCAD će automatski pozicionirati liniju horizonta kako bi odgovarala 
horizontu slike.

Slika 7.14. Podešavanje pozadine rendera

Image: Ova opcija koristi se kako bi se već postojeća slika postavila kao pozadina. Klikom 
na Browse učitava se slika iz biblioteke.

PhotoRender Projection (kreiranje rendera)
Za kreiranje rendera 3D prikaza objekta, u zavisnosti od postavki veličine renderovanja 
potrebno je:

	y kliknuti na ikonicu za renderovanje (slika 7.15) na dnu palete postavki PhotoRen-
dering-a ili

	y koristiti Document > Creative Imaging > PhotoRender Projection.

Slika 7.15. Ikonica za početak izrade rendera

Vrijeme renderovanja varira u zavisnosti od mnogih faktora, uključujući veličinu i slo-
ženost parametara renderovanja i hardverske mogućnosti kompjutera.
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7.3. Rad na 3D modelu ArchiCAD-a u drugim softverima

ArchiCAD nudi različite opcije za čuvanje modela u brojne formate datoteka koje koriste 
neki drugi profesionalni softveri za renderovanje. Neki od takvih softvera su: 3Ds Max, 
Lumion, Artlantis i dr.
3Ds Max je program za modelovanje, animaciju i renderovanje koji je razvila kompanija 
Autodesk. Koristi se za pravljenje okruženja u video-igricama, pravljenje scena za vizuali-
zaciju, postavljanje virtuelne realnosti kao i arhitektonsku vizualizaciju.
Lumion je program za 3D renderovanje koji je napravljen posebno za arhitekte, projek-
tante i dizajnere. Moguće je uspostavljanje inteligentne veze između modela ArchiCAD-a 
i Lumion fajla u 3D prikazu. Ukoliko se istovremeno radi u ArchiCAD-u i u Lumionu, sve 
dodatne izmjene koje se naprave u projektu ArchiCAD-a (pomjeranje objekata, brisanje 
zidova, dodavanje prozora i dr.) u realnom vremenu biće preslikane i u Lumion projekat.
Artlantis je još jedan od dodatnih softvera za renderovanje koji je razvila kompanija Grap-
hisoft. Može da obrađuje fotografije i animacije izvezene direktno iz ArchiCAD-a odabirom 
odgovarajućeg formata datoteke. Kao i Lumion i Artlantis, ima mogućnost uspostavljanja 
interaktivne veze sa ArchiCAD modelom. 
Takođe, osnova ili 3D prikaz može se sačuvati i prenijeti u razne softvere za obradu slike, 
kao što je npr. Photoshop za fino podešavanje ili dodavanje specijalnih efekata.
Najčešće korišćene komande koje se odnose na tehnike vizualizacije mogu se naći na una-
prijed definisanoj paleti alata 3D vizualizacije. Odabirom Window > Toolbars > 3D Visuali-
zation prikazaće se traka s ovim alatima. 

Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta:

	f Prateći uputstva iz ovog poglavlja pozicioniraj kamere tako da se u trodimenzi-
onalnim prikazima vide sve četiri fasade. Dodaj i dvije kamere koje prikazuju 
djelove enterijera po tvom izboru.

	f Podesi osvjetljenje koristeći alat Lamps i definiši scene za renderovanje (za 
eksterijer će to biti jedna od opcija Outdoor, a za enterijer Indoor).

	f Izradi rendere u dimenziji Screen: 1024 x 768 i sačuvaj ih na svom kompjuteru.
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SAŽETAK POGLAVLJA

	f Vizualizacija u ArchiCAD-u obuhvata sve alate i tehnike koje vam omogućavaju da 
prikažete i predstavite svoj arhitektonski dizajn u 3D.

	f Cijeli projekat ili njegove djelove možete vizualizovati dodavanjem namjenskih kamera 
na osnovi, a zatim pregledanjem objekta s te tačke gledišta. Perspektivne kamere omo-
gućavaju vam da sagledate i vršite izmjene u 3D i da kreirate prikaze koji predstavljaju 
snimak trenutnog stanja projekta.

	f Za izradu fotorealističnih prikaza objekta, u okviru ArchiCAD-a postoji ugrađen Cine-
Render Engine s unaprijed postavljenim scenama i prilagođenim osnovnim postavkama. 
CineRender je optimizovan za rad s odgovarajućim materijalizacijama za elemente. Dija-
loški okvir Render Settings omogućava podešavanje parametara svjetlosti i osvjetljenja, 
način prikaza materijalizacije i okruženja objekta. Dodatno, prije zadavanja neredbe 
za izradu rendera potrebno je definisati veličinu slike i njenu rezoluciju, što se takođe 
radi kroz podešavanja u dijaloškom okviru.

	f ArchiCAD nudi različite opcije za čuvanje modela u brojnim formatima datoteka koje 
koriste neki drugi srodni softveri za renderovanje. Neki od takvih softvera su: 3Ds Max, 
Lumion, Artlantis i dr.
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8 Štampanje

Kroz prethodna poglavlja savladali ste vještine digitalnog predstavljanja projekta na raču-
naru uz sve njegove elemente. Takođe, naučili ste na koji način da izradite trodimenzio-
nalne prikaze objekta koristeći alat PhotoRendering u ArchiCAD-u. Kada je u pitanju proces 
izrade projektne dokumentacije, treba znati da je – osim crtanja na računaru – jako važno i 
štampanje priloga, odnosno njihovo predstavljanje na papiru. Često ćete se naći u situaciji 
da je za lakše razumijevanje i sagledavanje cjelokupnog projekta potrebno da ispred sebe 
imate papir. Na taj način mnogo je efikasnije i uočavanje grešaka ili mogućih izmjena radi 
poboljšanja projekta. 

Dodatno, u fazi izvođenja projekta, prilikom konsultacija sa izvođačima na licu mjesta, 
praktičnost postojanja projekta na papiru nemjerljivo je veća od digitalnih prikaza. Iz tog 
razloga, u ovom poglavlju naučićete koja su to sve podešavanja značajna za pravilnu pri-
premu priloga i njihovo čuvanje za dalju doradu. 

U ovom poglavlju saznaćete:
	y Kako napravit virtuelni list
	y Kako postaviti grafičke priloge na zadati raspored (Layout)
	y Kako nacrtati okvir i pečat na listu
	y Kako podesiti parametre za štampu
	y Kako sačuvati virtuelni list u formatu PDF za štampanje ili dalju doradu.



1678.1. Layout Book

8.1. Layout Book

Na samom početku, važno je razumjeti značenje riječi 
lejaut (Layout) s obzirom na to da se radi o značajnom 
segmentu u procesu izrade projektne dokumentacije 
u digitalnom obliku. U prevodu, to znači raspored. 
Podrazumijeva izgled virtuelnog lista papira, odno-
sno poziciju okvira, pečata, teksta i grafičkih priloga 
na njemu.
Svaki ArchiCAD fajl posjeduje folder Layout Book čiji 
je sadržaj prikazan u Navigatoru (slika 8.1). ArchiCAD 
ima predefinisane rasporede/šablone za svaku veli-
činu papira, a mogu se napraviti i novi, koji odgova-
raju potrebama za informacijama i izgledom papira. 
Zašto je značajan lejaut? Na primjer, potrebno je 
da na svakom listu projekta postoji isti okvir i pečat 
koji sadrži većinu istih informacija. ArchiCAD za 
ovu akciju nudi opciju New Master Layout čijim se 
kreiranjem olakšava tok pripreme priloga za štampu. 
Dodavanjem novog lejauta koji je usklađen sa potre-
bama projekta, svaki prilog automatski će imati 
sve postavljene elemente (okvire, pečate, oznaku 
sjevera i dr.).
Grafičke i tekstualne stavke koje se postave na glavni 
raspored/šablon (Master Layout) pojaviće se na sva-
kom rasporedu (Layout) koji ga koristi kao osnovu.
Master Layouts nalaze se u fascikli Masters u Layout 
Book, i mogu im se dati proizvoljna imena.
Za kreiranje novog Master Layout-a koristi se komanda 
New Master Layout iz kontekstnog menija ili naredba 
Document > Layout Book > New Master Layout (slika 
8.2).

Slika 8.2. Izgled ikonice za pravljenje novog Master Layout-a

U sljedećem koraku otvara se dijaloški okvir s podešavanjima veličine lista i marginama 
(slika 8.3). Osim željene veličine papira, preporuka je da margine sa sve četiri strane budu 
postavljene na 0 mm s obzirom na to da će uvijek na listu postojati okvir koji ima već defi-
nisane dimenzije.

Slika 8.1. Prikaz foldera Layout 
Book u Navigatoru
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Slika 8.3. Prikaz podešavanja margina

Crteži mogu biti sastavljeni od djelova projekta (osnove, presjeci i dr.) ili eksterne datoteke 
(slike i PDF datoteke) i mogu se postavljati na lejaut zasebno ili zbirno, i to:

1.	 Koristeći prečice: Ctr + A > Ctrl + C u prozoru modela a zatim Crtl + V u prozoru 
Layout-a prevuci i postavi prikaz na Layout.

Naredbom Ctrl + A biraju se svi elementi u tre-
nutnom prozoru (npr. presjeka). Ukoliko treba 

prenijeti samo određene djelove prozora, koristi se dugme 
Shift i lijevim klikom miša selektuju se elementi koje 
treba kopirati. Nakon završetka odabira, koristi se već 
poznata naredba Ctrl + C > Ctrl + V. 

2.	 Pomoću alata za crtanje iz ToolBox-a (linija, 
kružnica, ispuna) mogu se postaviti pojedinačni 
elementi crteža, poput okvira, pečata, legende 
i dr.

3.	 Koristeći već definisane poglede (Views) iz fol-
dera u Navigatoru.

Komandi „Sačuvaj prikaz i postavi na Layout“ pristupa 
se tako što se desnim tasterom miša klikne na željenu 
etažu ili izgled (slika 8.4). Novi pogled pojaviće se i u 
View Map i u Layout Book folderu u Navigatoru. 
Odmah nakon izabrane komande Save View and 
place on Layout otvara se prozor izgleda virtuelnog 
papira na koji treba da se postavi sačuvani pogled 
(slika 8.5).

Slika 8.4. Postupak čuvanja 
pogleda
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Slika 8.5. Postavljanje crteža nakon odabira 

Pritiskom na lijevi taster miša, crtež se postavlja na konačnu poziciju na papiru (slika 8.6).

Slika 8.6. Izgled virtuelnog lista papira nakon postavljanja osnove

�Nakon što je izgled postavljen na virtuelni list papira, svi elementi crteža postaju dvo-
dimenzionalni (linije, kružnice i ispune), i izmjene na njima ne odražavaju se na model 
objekta u projektu.  

PROVJERI SVOJE ZNANJE

1.	 Opiši način podešavanja stranice za štampanje.
2.	 Objasni u kakvoj su vezi True Line Weight i štampa crteža.
3.	 Objasni funkciju Layout Book-a.

4.	 Navedi korake koji su potrebni kako bi se postavio tehnički crtež iz modela u stranice 
Layout Book-a.
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Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta:

	f Kreiraj master layout veličine papira A3 sa marginama 0 sa sve četiri strane. 
Layout nazovi Projektni zadatak.

	f Na tom lejautu nacrtaj okvir i pečat koristeći Line Tool i Text Tool. 
	f Sačuvaj novi pogled (View) osnove i prenesi ga na novi Layout.

8.2. Podešavanje parametara za štampu

Nakon što ste kroz prethodna poglavlja naučili da nacrtate projekat, u okviru ArchiCAD-a 
imate mogućnost da štampate projekat na nekoliko načina. Ovaj dijaloški okvir otvara se 
komandom iz osnovnog menija File > Print. 

Dijaloški okvir Print Layout otvara se kada je selektovan folder Layout Book, dok se 
dijaloški okvir Print 2D Document otvara ukoliko je selektovan folder Project Map.

Slika 8.7. Dijaloški okvir za podešavanje stavki za štampu

1.	 �Štampač (Printer) 

Ovo polje prikazuje upravljački program štampača koji je trenutno podešen. Klikom na 
opciju Page Setup (slika 8.7) otvara se dijaloški okvir u kojem se podešava veličina i orijen-
tacija papira i bira se štampač (slika 8.8).
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Slika 8.8. Odabir štampača

2.	 �Područje štampe (Print Area/Source)  

a)	 �Select Layouts in Navigator: U prethodnom poglavlju objasnili smo kako se pravi 
Layout i na koji način pomaže prilikom pripreme crteža za štampu. Kada je svaki 
crtež spreman u Layout Book, onda je i štampa lakša i brža. Odabirom ove opcije 
može se izabrati određeni lejaut i štampati u formatu PDF (slika 8.7).

Ova opcija dostupna je kada je u 
Navigatoru izabran folder Layout 

Book i kada je selektovan jedan od već pri-
premljenih lejauta. 

b)	 �Entire Drawing (cijeli crtež): 
Ukoliko je izabran folder Pro-
ject Map u Navigatoru (slika 8.9), 
prva ponuđena opcija štampanja 
biće Entire drawing. 
Odabirom ove opcije štampa 
se cjelokupni crtež sa svim ele-
mentima koji se nalaze na radnoj 
površini. 

Kod štampe cjelokupnog crteža ne 
mogu se definisati okviri štampe i 

samim tim podesiti razmjera kako bi crtež 
bio smješten na jednom listu, pa se zbog 
toga ovaj način štampe rijetko koristi.

c)	 �Current Zoom (samo trenutno 
zumiranje): Ova opcija koristi 
se za štampanje samo vidljivog 
sadržaja prozora pri zadatom 
Zoom-u. Slika 8.9. Layout Book i štampa
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d)	 �Marquee Area (selekcioni okvir): Kroz poglavlje 1.5.2. objašnjeno je korišćenje 
selekcionog okvira. Koristeći ovu opciju može se definisati i dio projekta koji je 
potrebno odštampati. 

3.	 �Print Range (opseg štampe): Odabirom All zadaje se štampanje svih stranica, a 
izborom Range koje određene crteže treba štampati (slika 8.7).

4.	 �Size/Scale (veličina/razmjera): Ukoliko se projekat štampa iz foldera Project Map, 
prva ponuđena opcija biće Original. Uvijek treba izabrati ovu opciju za štampanje u 
razmjeri u kojoj je crtan projekat (slika 8.7).

�Preporuka je da se uvijek koristi ova opcija kod štampe grafičke dokumentacije projekta. 
Ukoliko se izabere neka od ostalih ponuđenih opcija, razmjera na odštampanom prilogu 
neće odgovarati razmjeri koja je zadata projektnim zadatkom.

Sljedeća ponuđena opcija jeste Fit to page (Uklopi u stranicu); Odabirom ove opcije štampa 
se cjelokupni crtež na zadatu veličinu papira. 

�Ova opcija koristi se samo onda kada projektom nije zadata određena razmjera ili ukoliko 
je, na primjer, potrebno samo odštampati projekat radi analize i lakših korekcija, pa 
razmjera nije od značaja.

Custom (prilagođeno) omogućava manuelno definisanje razmjere crteža.
Operacija pripreme za štampu završava se klikom na dugme Print (slika 8.10).

Slika 8.10. Prikaz dijaloškog okvira za čuvanje 

PROVJERI SVOJE ZNANJE

1.	 Na koji način možeš prilagoditi veličinu i orijentaciju papira za štampu u ArchiCAD-u 
za potrebe projekta?

2.	 Kako se postavljaju parametri za štampu više stranica ili listova u jednom dokumentu?
3.	 Koje su mogućnosti za podešavanje razmjere crteža i elemenata prilikom štampe?
4.	 Aktiviraj opciju Print i opiši opcije 5 i 6 naznačene na slici 8.7.
5.	 Objasni razliku između opcija Source i Print Area.
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Otvori dokument Projektni zadatak_Stambeni objekat.
U okviru projekta:

	f Podesi format papira na A3 (420 x 297) u razmjeri 1 : 50. Pored osnove dodaj 
legendu, oznaku sjevera, okvir i pečat. Pripremi ga za štampu (kao što je to 
prikazano na slici ispod).

	f Odštampaj pripremljenu osnovu u formatu PDF, zatim sačuvaj i zatvori crtež 
– pod istim nazivom.

Slika 8.11. Projektni zadatak: Štampanje 
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	f Svi crteži koji su izrađeni na računaru, koristeći odgovarajući softver, mogu biti odš-
tampani na papiru uz podešavanja štampača.

	f U okviru ArchiCAD-a postoji folder Layout Book čijim se podešavanjem definiše sadržaj 
grafičke dokumentacije i raspored elemenata na crtežu. Lejaut (raspored) omogućava 
da jednom nacrtani elementi crteža (npr. okvir i pečat) budu primijenjeni na svakom 
crtežu koji je potreban u štampanom obliku. ArchiCAD za ovu akciju nudi opciju New 
Master Layout. Za sve dodatne sadržaje crteža Master Layout-a (osim samih grafičkih 
priloga koje ste već izradili) koriste se alati za crtanje koji se nalaze u ToolBar-u u 
segmentu Document. 

	f Layout (raspored) podrazumijeva izgled virtuelnog lista papira. Kada se priprema 
layout, na njemu se mogu koristiti samo alati za 2D crtanje, s obzirom na to da se radi o 
izgledu papira. Ukoliko je potrebno dodati neki konstruktivni element ili objekat bibli-
oteke, to se mora prvo učiniti u samom projektu (Project Map) jer se tu nalazi objekat 
sa svim parametrima konstruktivnih i drugih elemenata koji mu daju treću dimenziju 
(model). Svaka izmjena u Project Map-u (na osnovama, u presjecima i izgledima fasada) 
automatski će se prikazati u lejautu na kom je smještena.



175

PROJEKTNI ZADATAK – STAMBENI OBJEKAT

Prema zadatoj skici nacrtati i iskotirati osnovu prizemlja stambenog objekta. 
Objekat je spratnosti P + 1 pa je potrebno projektovati i nacrtati osnovu sprata. Spratna 
visina je 280 cm. Grafička dokumentacija za izradu (R = 1 : 50):

1.	 Osnova prizemlja s dispozicijom namještaja
2.	 Osnova sprata s dispozicijom namještaja
3.	 Presjek A-A
4.	 Presjek B-B
5.	 Istočna fasada
6.	 Zapadna fasada
7.	 Sjeverna fasada
8.	 Južna fasada

Slika 9.1. Projektni zadatak: Stambeni objekat 

�Kroz sva poglavlja u udžbeniku nalaze se označeni djelovi koji upućuju na izradu pro-
jektnog zadatka u svim fazama (od kreiranja fajla, preko crtanja konstruktivnih elemenata 
i drugih djelova projekta, do postavljanja presjeka i fasada, te štampe projekta).
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RJEČNIK STRUČNIH POJMOVA

dizajnirati  —  oblikovati objekat ili prostor

editovati  —  izmijeniti

ekstenzija  —  dodatak imenu fajla koji određuje njegov tip 

folder  —  organizaciona jedinica u kojoj se nalaze fajlovi

hijerarhija  —  razvrstavanje po strogo definisanoj važnosti

ikonica  —  grafički prikaz fajla ili neke komande na ekranu

kota  —  �brojčana vrijednost koja se koristi za precizno određivanje veličine djelova u tehničkoj 
dokumentaciji

kreirati  —  stvoriti

kursor  —  pokazivač miša na ekranu

meni  —  lista opcija koja omogućava rad u softverima

modifikacija  —  djelimična izmjena karakteristika nekog objekta

opcija  —  mogućnost

osnova  —  horizontalni presjek objekta

padajući meni  —  lista opcija koja je ponuđena kada se izabere određeni segment softvera

paleta alata  —  ikonice grupisane u meniju

parametar  — � veličina koja se sadrži u nekom matematičkom izrazu ili funkciji, i koja utiče na 
vrijednost tog izraza ili funkcije

perspektiva  —  trodimenzionalni prikaz objekta

poligon  —  geometrijska figura ograničena s više duži

projekcija  —  predstavljanje nekog tijela preslikavanjem njegovih tačaka u ravan

razmjera  —  odnos veličina na crtežu i u prirodi

rezolucija  —  broj piksela koji čini sliku, određujući njen nivo detalja i oštrine

rotirati  —  zaokrenuti

segment  —  cjelina koja predstavlja dio nečega

silueta  —  obris geometrijskog oblika

simetrija  —  �uravnotežena raspodjela elemenata unutar prostorne kompozicije u odnosu na centar 
simetrije (osu)

selektovan  —  izabran

softver  —  program s određenom primjenom

šrafiranje  — � tehnika bojenja ili označavanja crteža linijama i bojama kako bi se jasnije prikazale 
različite regije



177

tab bar  — � funkcionalni dio softvera koji omogućava prelazak između različitih djelova programa ili 
aplikacije

transformisati  —  preoblikovati, promijeniti

virtuelan  —  prividan, nestvaran

vizualizovati  —  stvoriti mentalnu sliku objekta
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ENGLESKI IZRAZI U ARCHICAD-u

Actual Size  prava veličina

Add-Ins  dodaci

Adjust  prilagoditi

Align  poravnati, uskladiti

All   sve

All Floors  svi spratovi

Anchor  sidro, referentna tačka

Angle  ugao

Angle Dimension  ugaona kota

Antialiasing  oštrina

Apply  primijeniti

Arc/Circle  luk i krug

Archive  arhiva, arhivirati

Arrow  strelica

Arrowhead  vrh strelice

Attributes  svojstva

Autosave  automatsko snimanje

Azimuth  azimut (horizontalni ugao)

Background  pozadina

Backup  sigurnosna kopija

Below  ispod

Brightness  osvijetljenost

Camera  kamera

Cancel  odustati

Chamfer  obaranje spoja

Choose  izabrati

Chord  tetiva luka

Clean  očistiti, obrisati

Clean Wall Intersection  ukrštanje zidova

Clear  izbrisati

Clipboard  privremeni zapis

Close  zatvoriti

Color  boja

Column  stub

Composite Structure  kompozitna struktura; 
sastoji se iz više slojeva, posebno se odnosi 
na zidove i ploče

Composite Wall   složeni zid

Construction Grid  konstruktivna mreža

Contour  obris

Coordinate Constraints  koordinatno 
ograničenje

Copy  kopirati

Core  jezgro

Create  stvoriti

Criteria  kriterijumi

Curve  kriva, krivina

Curved Wall  zakrivljeni zid

Custom  po želji

Cut  odsijecati

Cutting Plane  ravan presjeka

Dashed  isprekidano, u obliku crtica

Default  unaprijed zadato

Degree  stepen

Delete  izbrisati

Depth  dubina

Descriptors  opisivači
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Details  detalji

Diagonal  dijagonala

Diffuse  razliti

Dimension  kota, dimenzija

Display  prikaz

Display order  redosljed prikaza

Distance  rastojanje

Distribute  rasporediti

Division  podjela

Done  završeno

Door  vrata

Dotted  isprekidano, u obliku tačkica

Double Arrow  dupla strelica

Down  dolje

Drag  prevlačiti, izmjestiti

Drawing Scale  razmjera crteža

Drawing units  jedinice crtanja

Duplicate  duplirati

Each  svaki

East  istok

Edge  ivica

Edit  izmjena (unesi izmjene)

Edit Origin  izmjena koordinatnog početka

Effect  efekat

Elevate  podignuti, izdignuti

Elevation  frontalni izgled, fasada

Elevation Dimension  visinska kota

Empty Opening  otvor u zidu bez stolarije

End  kraj

Enter  unijeti

Equipment  oprema

Erase  obrisati

Export  Iznijeti (odnosi se na prenos 
informacija iz jednog sistema ili softvera u 
drugi)

Extension  proširiti, dodatak, oznaka vrste 
fajla

Exterior Wall  spoljašnji zid 

Figure  tijelo

File  zapis, datoteka, fajl

Fill  šrafura

Fillet  zaobljivanje spojeva

Fit to window  prilagoditi veličini ekrana

Floor  pod

Floor Plan  osnova

Fly-through   prolaziti kroz (objekat)

Frame  okvir

Furniture  namještaj

GDL   programski jezik za ArchiCAD

General Parameters  opšti parametri

Gravity  gravitacija, vezivanje elemenata 
crteža za podlogu

Grid  (modularna) mreža

Grid Display  prikaz modularne mreže

Grid Snap  skok kursora po modularnoj mreži

Ground Floor  prizemlje

Group  grupa, grupisati

Hairline  najmanja moguća debljina linije za 
prikaz na ekranu 

Half  pola

Hatching  šrafura

Height  visina

Hidden Line  metoda prikaza sa skrivenim 
linijama
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Home  početni meni

Horizontal Stretch  horizontalno izduživanje

Hotspot  referentna tačka, čvor za rukovanje 
elementima

ID  identifikacioni broj (oznaka)

Image Size  veličina slike

Increment  korak umanjenja ili uvećanja

Input  unos

Insert  umetnuti

Interface  sistem interakcije

Interior  unutrašnjost, enterijer

Intersect  spoj

Invisible  nevidljiv

Join  spojiti

Label  oznaka

Lamps  lampe, izvori svjetla

Landscape  pejzaž, horizontalna orijentacija 
papira

Layer  sloj

Layout  format za štampanje, raspored

Leaf (door, window)  krilo vrata ili prozora

Level  nivo, poravnanje

Level Dimension  visinska kota

Library  biblioteka elemenata

Library Browser  pretraživač biblioteka/
elemenata

Library Manager  uređivač biblioteke

Library Part  dio biblioteke

Line  linija

Line Weight  debljina/težina linije

Linear Dimension  linearna kota

Link  veza

List  navesti, nabrojati

Lock & Unlock  zaključati/otključati

Luminosity  osvijetljenost

Magic Wand  čarobni štapić

Marker  oznaka

Marquee  selekcioni okvir

Menu  izbor

Menubar  paleta izbora

Middle  sredina

Midpoint  srednja tačka

Mirror  osno-simetrično preslikavanje

Multiply  umnožiti

Navigator  meni za navigaciju kroz crtež

Nearest  najbliži

New  novo

Node  čvor

North  sjever

Number of Copies  broj kopija

Object  objekat

Off  isključeno

Offset  pomak svih ivica

Open  otvoriti

Origin  koordinatni početak

Output  izlazni oblik

Page Setup  postavke stranice

Pan  pomicati pogled na ekranu

Parallel  paralelno

Paste  ubaciti/zalijepiti

Path  putanja

Pen  pero

Pen Number  broj (boja) pera
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Pens & Colors  pera i boje

Perpendicular  normalan, upravan

Photorendering  fotorealistični prikaz

Plain  jednostavan

Plot  štampanje na velikim formatima papira

Point  tačka

Polygon  mnogougao

Polyline  polilinija

Polyroof  složeni krov

Polywall  poligonalni zid

Portrait  vertikalna orijentacija papira

Preferences  karakteristike

Presets  unaprijed definisane postavke

Preview  uzorak prikaza

Printing  štampanje

Project Origin  koordinatni početak projekta

Properties  osobine nekog objekta

Publish  objaviti

Quick Options Bar  prozor za brz pregled

Quit  prekidanje

Radius Dimension  radijalna kota

Range  domet, opseg

Rectangle Wall  zidni pravougaonik

Redo  ponovo uraditi

Reference ID  naziv presjeka koji se pojavljuje 
u osnovi

Reference Lines  referentna linija, linija u zidu 
koja određuje njegov položaj

Remove  ukloniti

Rename  preimenovati

Rendering  vizuelizacija

Resize  ponovo dimenzionisati

Right  desno

Roof  krov

Rotate  rotirati

Save  sačuvati (postojeći crtež)

Save As  sačuvati kao (odabir formata)

Scale  razmjera

Screen  ekran

Search  pretraga

Section View  presjek

Select  odabrati

Set  postaviti

Settings  podešavanja

Shadows  sjenke

Show & Hide  prikazati i sakriti

Show All  prikazati sve

Sill  prag (vrata, prozori)

Single Wall  pojedinačni zid

Site  lokacija

Skylight  krovni prozor

Slab  ploča

Slope  nagib

Snap Grid  kretanje kursora po mreži

Solid  puna forma

South  jug

Spacebar  taster razmaka na tastaturi

Spacing  razmak

Specify  odrediti

Spline  kriva polilinija

Split  podijeliti, razdvojiti

Spread  rasprostraniti, raširiti

Spredasheet  tabela
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Square  kvadrat

Staircase  stepenice

StairMaker  dodatak za kreiranje stepenica

Start  početak

Start Drawing  započeti crtanje

Static Dimension  statičko kotiranje (kod 
nezavisnih elemenata)

Story  sprat, etaža

Stretch  proširiti, produžiti

Style  stil

Surface   površina

Surface Materials  materijali spoljne obrade

Target  cilj

Terrain  teren

Thickness  debljina

Three Point Perspectrive  perspektiva s tri 
nedogleda

Tile  pločica

Tool  alat

Toolbar  paleta s alatima

Transfer  prenijeti

Transform  transformisati

Transparency  providnost

Trim  skratiti, odsjeći

Trim Wall Top to Roof  odsijeci zid do ispod 
krova

Undo  korak unazad

Unit  jedinica mjere

Untitled  neimenovan, bez naslova

Up  gore

User Origin  korisnički koordinatni početak

Vertical Stretch  vertikalno izduživanje

View  pogled

Visible  vidljiv

Wall  zid

Wall intersections  spajanje zidova u presjeku

Weight  težina

West  zapad

Width  širina

Window  prozor

Worsheet  radni list

Zone  zona, alat za proračun površine i 
klasifikaciju prostorija

Zoom In  uvećati, približiti

Zoom Out  umanjiti, udaljiti
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